
I-Suite Administrator’s Guide
This I-Suite Administrator’s Guide explains how to download and install  
I-Suite and use the AdminTool to manage your incident databases. Topics in 
this guide include:

• Getting started
• Getting help
• Installing I-Suite
• Managing security
• Setting up the server and client personal computers
• Managing your incident databases
• Exporting files to the data repository
• Importing ROSS data files.

Getting started
This section outlines the basic system requirements to install and use the I-
Suite application and provides an overview to the I-Suite AdminTool. Topics 
in this section include:

• Understanding the basic I-Suite system requirements
• Using the I-Suite AdminTool.

Understanding the basic I-Suite system requirements
To adequately install and run the I-Suite application, your personal computer 
must have the following minimum system requirements:

• Internet Explorer version 5.5 or higher
• Microsoft Windows 2000 or higher, with administrator privileges.

Using the I-Suite AdminTool
Admintool.exe is a program that allows you to perform a variety of 
administration functions for I-Suite. The types of functions you can perform 
using the AdminTool include:

• changing your AdminTool password
• changing your ITS password
• create, attach, and detach your incident database
• backup and restore your incident database
• convert the incident database to MS Access.

When working in the server/client environment, remember these key points 
when using the AdminTool:

• Use the AdminTool only on the server machine. 
• Disable the hibernate/sleep mode on the server machine so that the client 

machine can access the incident database.
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• If you promote a client machine to a server, you must start the MS SQL 
Server on that machine.

• Ensure that all client machines access the correct server so that they have 
access to the correct incident database.

For specific information about using the AdminTool to set up personal 
computers for an incident, see “Setting up the server and client personal 
computers” and “Managing your incident databases,” later in this chapter.

Getting help
This section explains how to access and locate help information. There are 
three basic ways to obtain help information for I-Suite applications:

• Access the I-Suite website. This site contains a wide array of I-Suite 
information, including software downloads, updates, and user 
documentation.

• Contact the I-Suite Helpdesk. If you are unable to answer your question 
using the I-Suite website, contact the I-Suite Helpdesk at (866) 224-7677.

To locate help information on the I-Suite website
1 Start your Internet browser.

2 In the Address box, type http://isuite.nwcg.gov, and then press ENTER.

3 On the Welcome to I-Suite webpage, click the application icon of your 
choice, and then click to select the topic of your choice.

The following diagram shows the ITS application icon on the Welcome to  
I-Suite webpage.
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The following diagram shows the ITS webpage and a list of available topics.

To display help information within an I-Suite application
• On the menu bar, click Help, and then click Support.

The following diagram shows the ISuite Support dialog box. 

To contact the I-Suite Helpdesk

The I-Suite Helpdesk schedule is based on fire season, Eastern Time: 
November 1st - March 31st 0800-2000 
April 1st - October 31st 0700-2300.

• Call (866) 224-7677, or email inc_help@dms.nwcg.gov.
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To obtain a copy of I-Suite user guides
1 Start your Internet browser.

2 In the Address box, type http://isuite.nwcg.gov, and then press ENTER.

3 On the Welcome to I-Suite webpage, click the application icon of your 
choice, and then click to select appropriate User’s Guide.

Installing I-Suite
This section explains how to download and install the I-Suite application, 
including the I-Suite application and the update patch. The I-Suite application 
is comprised of the following software application:

• Admin Tool
• I-Suite Merge/Split (IMS)
• Incident Resource Status System (IRSS)
• Incident Cost Accounting and Reporting System (ICARS)
• Incident Time System (ITS)
• Incident Action Plan (IAP).
To download and install software on an agency personal computer, you must 
follow that agency’s regulations and requirements. You may also need 
Administrator access granted before starting this process. For more 
information, contact your agency System Administrator.

To download the I-Suite application from the I-Suite website
1 Start your Internet browser.

2 In the Address bar, type http://isuite.nwcg.gov and then press ENTER.

3 Click the download link that corresponds to downloading  
I-Suite2004.exe.

4 On the File Download dialog box, click Save this program to disk, and 
then click OK.

5 On the Save As dialog box, save isuite2004.exe to a location of your 
choice, and then click Save.
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The following diagram shows the File Download dialog box.

The following diagram shows the Save As dialog box, In this example, 
ISuite2004.exe is being saved to the desktop.

This process takes several minutes. Please be patient!

To install I-Suite2004 on your personal computer

Be sure to exit all software applications before starting the installation 
process. Once ISuite2004 installs, your personal computer automatically 
restarts.

1 On your desktop, double-click isuite2004.exe.

This process takes several minutes. Please be patient!

2 On the ISUITE2004 - InstallShield Wizard dialog box, click Next.
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3 Once the installation is complete, click Finish on the ISUITE2004 - 
InstallShield Wizard dialog box.

Once your personal computer restarts, you can delete the ISuite2004.exe file.

The following diagram shows the ISUITE2004-InstallShield Wizard dialog 
box.

Managing security
This section identifies some security measures and precautions available in 
the AdminTool. Topics in this section include:

• Maintaining passwords
• Clearing out Social Security Numbers.

Maintaining passwords
Your AdminTool and I-Suite passwords are to be kept confidential. You must 
abide by the following rules when determining and changing your passwords:

• Change your passwords every 90 days.
• Specify a combination of at least six but no more than 30 letters and 

numbers.
• Use both upper and lower case characters.
• Do not share your passwords with anyone.

For example, while “mi1kDUD” is a valid password, “milkdud” is not!
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To change your AdminTool password

Changing your password is performed using the Administrative Tool that is 
located on your personal computer.

1 On your desktop, double-click the AdminTool icon.

2 On the Login dialog box, click the Server drop-down arrow, and then 
click to select the Server name of your choice.

The Server name consists of your personal computers Full computer 
name and the folder name \ISUITE. For example, PC9778\ISUITE is a 
valid Server name.

To locate the Full computer name for your personal computer, on your 
Desktop, right-click My Computer, click Properties, and then click the 
Network Identification tab.

3 In the Password box, type the current Password, and then click OK.

4 On the I-Suite Administration Tool screen on the Security menu, click 
Change AdminTool Password.

5 On the Change Password dialog box in the Old Password box, type the 
current Password.

6 In the New Password box, type the New Password.

7 In the Confirm New Password box, type the New Password, and then 
click OK.

The following diagram shows the Login dialog box.
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The following diagram shows the Change Password dialog box and the I-
Suite Administration Tool screen.

To set or change your ITS password

Changing your password is performed using the Administrative Tool that is 
located on your personal computer.

1 On your desktop, double-click the AdminTool icon.

2 On the Login dialog box, click the Server drop-down arrow, and then 
click to select the Server name of your choice.

3 In the Password box, type the current Password, and then click OK.

4 On the I-Suite Administration Tool screen on the Security menu, click 
Set ITS Password.

5 On the Set ITS Password dialog box in the Old Password box, type the 
current Password.

6 In the New Password box, type the New Password.

7 In the Confirm New Password box, type the New Password, and then 
click OK.

The following diagram shows the Login dialog box.
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The following diagram shows the Set ITS Password dialog box.

The following diagram shows the Set ITS Password dialog box that displays 
when a previous password did not exist.

To clear your ITS password
1 On the ITS menubar, click Exit ITS, or click Exit on the File menu.

2 Start Windows explorer, and then locate C:\isuite\program files\admin.

3 Double-click Admintool.exe.

4 Click the Server drop-down arrow, and then click to select the Server 
name of your choice.

5 In the Password box, type the current Password, and then click OK.

6 On the I-Suite Administration Tool screen on the Security menu, click 
Clear ITS Password.

Clearing out Social Security Numbers
I-Suite data contains private and personal information including Social 
Security Numbers (SSN) and IRS Federal Employer Tax ID Numbers (EIN). 
Before publishing any report that might jeopardize this private data, you must 
remove this sensitive information from the I-Suite database.
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To clear SSNs and EINs from the I-Suite database
1 On the I-Suite Administration Tool screen on the Security menu, click 

Clear SSN/EIN.

2 On the first warning message on the Clear SSN’s and EIN’s dialog box, 
click OK.

3 On the second warning message on the Clear SSN’s and EIN’s dialog 
box, click OK.

4 On the Complete dialog box, click OK.

The following diagram shows the first warning message on the Clear SSN’s 
and EIN’s dialog box.

The following diagram shows the second warning message on the Clear 
SSN’s and EIN’s dialog box. 

The following diagram shows the Complete dialog box.

Setting up the server and client personal computers
This section explains how to set up server and client personal computers for 
an incident. Remember these key points when running I-Suite in fire camp:

• Remove all DNS and WINS addresses from the Advanced TCP/IP 
settings.

• Verify that the personal computer has Internet Explorer version 5.5 or 
higher before installing I-Suite. Otherwise, you must uninstall I-Suite, 
upgrade Internet Explorer, and then reinstall I-Suite.
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• If McAffee virus protection is running, stop it before installing I-Suite.
• For Forest Service A31 laptops, ignore the .dll error messages during the 

installation. These errors do not affect performance.
• Use an empty database whenever you start a new incident. Keep an empty 

database available for your next incident.
• Backup the incident database many times during the day, especially after 

significant data entry. Save it to another location other than the server 
machine, such as a compact disc, zip disk, or thumb drive at least once 
daily.

• To avoid a hanging connection when you shut down IRSS, or when 
running a backup or compact and repair, map to the snap server IP address 
instead of a drive letter. 

To stop the MS SQLServer on a client machine - for Windows 
2000

Stop the MS SQLServer on your client machines to enhance server 
performance.

1 On the Windows taskbar, right-click the MS SQLServer icon, and then 
point to MS SQLServer - Stop.

2 On the SQL Server Service Manager dialog box, click Yes.

The following diagram shows the SQL Server Service Manager dialog box.

Managing your incident databases
This section explains how to use the AdminTool to create, attach, and detach 
incident databases to your I-Suite applications. This section also explains how 
to backup and restore an incident database, and outlines two methods for 
accessing the database from MS Access.

To access the administrative tool
1 On your desktop, double-click the AdminTool icon.
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2 On the Logon dialog box in the Server box, type the name of the Server, 
in the format [computername]\ISUITE.

The server name consists of your personal computer’s full computer 
name and the folder name \isuite. For example a valid computer name is 
pc9962\isuite. 
To locate the full computer name for your personal computer, right-click 
My Computer on your Desktop, and then click the Network 
Identification tab.

3 In the Password box, type the admin tool password, and then click OK.

The following diagram shows the Login dialog box.

The following diagram shows the I-Suite Administration Tool screen.

To create an incident database

Use your team’s naming standards to name your incident database.

1 On the I-Suite Administration Tool screen on the Action menu, click 
Copy database.
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2 On the Copy Database dialog box, click the Master Data File Source of 
Database drop-down arrow, and then click to select 
C:\isuite\database\isuite.mdf.

3 In the Name of the Copy box, type the Incident Name, and then click 
OK.

The File Path of New Database box displays the complete file location of 
the new incident database.

The following diagram shows the Copy Database dialog box.

To attach the incident database
1 On the I-Suite Administration Tool screen on the Action menu, click 

Attach database.

2 On the Attach Database dialog box, click the MDF File of Database to 
attach drop-down arrow, click to select C:\isuite\database\[incident 
name].mdf, and then click OK.

The following diagram shows the Attach Database dialog box.
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To detach the incident database

Before you can copy, move, or rename an incident database, you must first 
detach it.

1 On the I-Suite Administration Tool screen under Database, click to 
select the database name you want to detach.

2 On the Action menu, click Detach Database.

To access the attached incident database from a client machine
1 Double-click the I-Suite application of your choice.

2 On the dialog box that appears, click the Server drop-down arrow, and 
then click to select the Server of your choice.

If the server name does not display as a choice, type the name of the 
server in the Server box.

3 Click the Database drop-down arrow, click to select the Database of 
your choice, and then click OK.

If the incident database name does not display as a choice, type the 
name of the incident database in the Database box.

The following diagram shows the IRSS Server and Database Selection dialog 
box.

To backup the incident database

To recover a backup incident database, you must know the logon password.

You do not need to log off or close applications during this process.

1 On the I-Suite Administration Tool screen on the Action menu, click 
Backup database.
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2 On the Backup Database dialog box, click the Database drop-down 
arrow, and then click to select the database name of your choice.

The backup name is automatically created in the Name box, in the format 
[filename]_date_time.

3 Click the Backup to drop-down arrow, click to select the file location of 
your choice, and then click OK.

The following diagram shows the Backup Database dialog box.

To restore the backup database

Restoring the backup database overlays your current incident database with 
the backup database. Before starting this process, create a copy of the 
current incident database.

1 On the I-Suite Administration Tool screen on the Action menu, click 
Restore database.

2 On the Restore Database dialog box, click the Restore as database 
drop-down arrow, and then click to select the database of your choice.

3 Click the Restore from drop-down arrow, click to select the file location 
of the backup database, and then click OK.
September 22, 2004 15



I-Suite Administrator’s Guide
The following diagram shows the Restore Database dialog box.

Accessing the database from MS Access
This section explains two methods for accessing an I-Suite database from MS 
Access.

To access a database from MS Access - preferred method

This method allows you to create queries and reports in the same manner as 
if you were directly in MS Access, but also allows you to perform limited 
editing of the database tables.

1 Start Windows Explorer, and then navigate to c:\isuite\database.

2 Double-click ISuiteMSDE.adp.

3 On the Login dialog box, click Cancel.

4 On the File menu, click Connection.

5 On the Data Link Properties dialog box under 1. Select or enter a 
server name, click the drop-down arrow or type the server name.

For example, type ISUITE\ISUITE.

6 Under Enter information to log on to the server, click Use a specific 
user name and password, and then type ctspctso in the User name box.

7 In the Password box, type the AdminTool password.

8 Click to select 3. Select the database on the server, and then click the 
drop-down arrow or type the database name.

9 Click the Test Connection button.

10 On the Data Link Properties dialog box, click OK.

You can now display all tables in the database window. Queries are linked as 
tables and display on the tables window, not the queries window.
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The following diagram shows the Login dialog box.

The following dialog shows the Connection option selected on the File menu.

The following diagram shows the Data Link Properties dialog box.
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To access a database from MS Access - use with caution
1 Start Windows Explorer, and then navigate to c:\isuite\database.

2 Right-click ISuiteMSDE.dsn, click Open, and then click to select 
Notepad on the Open With... dialog box.

3 In Notepad, change the following information

- DATABASE=your database name
- SERVER=the name of your server with \isuite
- WSID=your computer name.

4 When finished, click Save on the File menu, and then close Notepad.

5 Start MS Access, and then create a new blank database.

6 On the File menu, point to Get External Data, and then click Link 
Tables.

7 On the LINK dialog box, click the Files of type drop-down arrow, and 
then click to select ODBC Database().

8 On the Select Data Source dialog box, click the File Data Source tab, 
click the Look in drop-down arrow, click to select 
c:\isuite\database\ISuiteMSDE.dsn, and then click OK.

9 On the SQL Server Login dialog box, type ctspctso in the Login ID, 
type the AdminTool password in the Password box, and then click OK.

10 On the Link Tables dialog box, click the Select All button, and then click 
OK.

Yo may also click to select only those tables you want to access, and then 
click OK.

11 For each table that displays on the Select Unique Record Identifier 
dialog box, double-click the first field on the top in the list.

You can now display all tables in the database window. Queries are linked as 
tables and display on the tables window, not the queries window.

The following diagram shows the ISuiteMSDE.dsn database as displayed in 
Notepad.
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The following diagram shows the Microsoft Access dialog box where you can 
create a new database.

The following diagram shows the Link Tables option selected under Get 
External Data on the File menu.
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The following diagram shows the options under the Files of type drop-down 
arrow.

The following diagram shows the Select Data Source dialog box.
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The following diagram shows the SQL Server Login dialog box.

The following diagram shows the Link Tables dialog box where you can 
select the table(s) of your choice.

The following diagram shows the Link Tables dialog box where you select the 
unique record identifiers. 
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The following diagram shows the database window in Microsoft Access that 
displays all tables.

Exporting files to the data repository
This section explains how create and then export I-Suite data files to the data 
repository. At each team transition and at the end of an incident, upload all  
I-Suite database files to the data repository.

Save repository files in your isuite/Repository folder on the C: drive of your 
personal computer.

You must know your team’s DMS username and password to access the 
repository site. Contact your Incident Commander or the I-Suite helpdesk for 
more information.

To create a data repository file
1 On the I-Suite Administration Tool screen on the Action menu, click 

Create Repository file.

2 On the Create Repository File dialog box under Managed As, click to 
select one of the following

- Incident
- Complex.

3 Under Incidents, click to select one or more incident name check boxes 
to export that incident data to the repository.

4 Under Source File, click to select the database file of your choice.

5 On the End of Incident dialog box, click Yes or No, as appropriate.
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6 On the Repository Files Created dialog box, click OK.

The following diagram shows the Create Repository File dialog box.

The following diagram shows the End of Incident dialog box.

The following diagram shows the Repository Files Created dialog box. 

To upload the data repository file
1 Start your Internet browser.

2 In the Address bar, type https://isuitetest.nwcg.gov/ and then press 
ENTER.

3 On the first Security Alert dialog box, click OK.

4 On the second Security Alert dialog box, click Yes.

5 On the Enter Network Password dialog box, type your team’s DMS 
User Name and DMS Password, and then click OK.
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6 On the ISUITE Upload Form dialog box, click the Browse button for 
File 1, navigate to, and then click to select the data repository file of 
your choice.

Remember, the default folder location to save data repository files is 
C:\isuite\Repository.

7 Repeat step #6 for every data repository file of your choice.

You can upload up to three data repository files at a time.

8 Click the Upload button.

The following diagram shows the second Security Alert dialog box.

The following diagram shows the second Security Alert dialog box.
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The following diagram shows the Enter Network Password dialog box.

The following diagram shows the ISUITE Upload Form dialog box.
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The following diagram shows the Choose file dialog box that shows the 
default folder location for your repository files.

Importing ROSS data files
This section explains how to download a ROSS data file and then import the 
data file into the I-Suite database. Remember these key points when importing 
ROSS data into an I-Suite database:

• ROSS data files are updated every two hours.
• ROSS data can be imported into an I-Suite database as many times as needed.
• Some ROSS data fields allow more characters than are allowed in the 

corresponding I-Suite data fields. If the data imported from ROSS 
exceeds the corresponding I-Suite data field limit, you will be prompted 
to input data with less characters. The I-Suite data fields affected are:
- Incident Name: limit 20 characters
- Incident Number: limit 13 characters
- Agency: limit 4 characters
- KindCode: limit 4 characters
- HomeUnitCode: limit 6 characters
- Resource Name: limit 53 characters

Important Note: The IRSS Add/Edit screen only allows the first 20 
characters to be displayed and saved. When you save a ROSS 
imported resource in IRSS, you must rename the resource to 20 or fewer 
characters.

• Contracted overhead resources are not identified during import. You must 
change the agency code to PVT when these resources check in.
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The following diagram shows the Data Length Change screen.

You must know your DMS username and password to access the ROSS data file site. 
Contact your Incident Commander or the I-Suite helpdesk for more information.

To download a ROSS data file
1 Start your Internet browser.

2 In the Address bar, type https://datadraw.ross.nwcg.gov/, and then 
press ENTER.

3 On the Security Alert dialog box, click OK.

4 On the Enter Network Password dialog box, type your DMS User 
Name and DMS Password, and then click OK.

5 On the Index of / screen, click on the Isuite/ link.

6 Navigate to your incident file by incident number – Incident Number, date 
and time, file extension .txt.  
(e.g. UT-CCD-000043_20040813_085929.txt)

7 Right click on file name, and then click Save Target As.

8 On the Save As dialog box, navigate to the desired folder on your local 
computer and then click Save.

9 On the Download Complete dialog box, click Close.

To access the administrative tool
1 On the computer being used as the server, open the AdminTool module.

2 On the Logon dialog box in the Server box, type the name of the Server, 
in the format [computername]\ISUITE.

The server name consists of your personal computer’s full computer name 
and the folder name \isuite. For example a valid computer name is 
pc9962\isuite.  
To locate the full computer name for your personal computer, right-click My 
Computer on your Desktop, and then click the Network Identification tab.

3 In the Password box, type the admin tool password, and then click OK.
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To import a ROSS data file into an I-Suite database
1 On the I-Suite Administration Tool screen under Databases, click on 

the database to which you will be importing the ROSS data file.

The following diagram shows the I-Suite Administration Tool screen.

2 In the I-Suite Administration Tool screen on the Action menu, click 
Import Data.

The following diagram shows the Action menu.

3 On the ROSS Import screen, type or browse to select the Import File 
Name (ROSS data file) to import, and then click OK.

4 Click Load Data.
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The following diagram shows the ROSS Import screen.

ROSS data is first displayed on a grid. User chooses which ROSS data to add 
to the I-Suite grid. User also compares ROSS data with I-Suite data and 
matches data when appropriate. All ROSS data moved onto the I-Suite grid is 
then imported (saved) into I-Suite when the user clicks Next.

ROSS Import Buttons:

• Selector – selects/highlights the row to the right of the button
• >> (add all) – moves ALL data in the ROSS grid to the I-Suite grid
• > (add selected) – moves SELECTED data in the ROSS grid to the I-Suite 

grid
• < (remove selected) – moves SELECTED data that has been added to the 

I-Suite grid back to the ROSS grid
• << (remove all) – moves ALL data that has been added to the I-Suite grid 

back to the ROSS grid
• Match – matches the selected ROSS and I-Suite incidents or resources
• Unmatch - unmatches the selected ROSS and I-Suite incidents or 

resources
• Restart Step – restarts the current step without importing data from the 

current step into I-Suite
• Next – imports (saves) into I-Suite all added/changed data currently in the 

I-Suite grid
The remove buttons only remove data from the I-Suite grid that hasn’t already 
been imported (saved) into the I-Suite database. Data previously entered or 
imported into the I-Suite database cannot be removed using the ROSS Import 
function.
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The following diagram shows the ROSS Import screen buttons.

There are two basic scenarios for importing a ROSS data file into an I-Suite 
database:
• Importing incident data into a blank I-Suite database or adding an incident 

to an I-Suite database that contains other incidents.
• Importing incident data into an I-Suite database that already contains 

manually entered data and/or previously imported ROSS data for that 
incident.

Instructions for each scenario are listed below.

To import an incident into a blank database
1 To add a ROSS incident to a blank I-Suite database, on the Add Incident 

screen, click the >> button to move the ROSS Incident to the I-Suite 
Incidents grid, and then click Next. 

The following diagram shows the Add Incident screen.

To import an incident into a database that contains other 
incidents
1 To add a ROSS incident to an I-Suite database that contains other 

incidents, on the Add Incident screen, click the >> button to move the 
ROSS Incident to the I-Suite Incidents grid, and then click Next. 
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The following diagram shows the Match/Add Incident screen.

To match a ROSS incident to an I-Suite incident
1 To match a ROSS incident to an I-Suite incident, click the Selector button 

for the ROSS incident and for the I-Suite incident, click Match, and then 
click Next. 

The following diagram shows the Match/Add Incident screen.

The system matches resources in the ROSS data file with resources in the 
I-Suite database using ROSS IDs. One or all of the following steps will be 
used depending on resource matches:
• Previous Matches – shows previously matched ROSS and I-Suite 

resources
• Validate Matches 1 – shows ROSS and I-Suite resources matched by 

request number and name
• Validate Matches 2 – shows ROSS and I-Suite resources matched by 

request number
• Manually Match/Add – shows ROSS resources that have not be matched 

to I-Suite resources; ROSS resources can be manually matched or added 
to I-Suite resources

Instructions for each step are listed below.
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To import ROSS Resources into a blank I-Suite database
1 On the Add Resources screen, to add all resources from the ROSS 

Resources grid to the I-Suite Resources grid, click the >> button; or to 
add individual resources, click the Selector for each ROSS resource, and 
then click the > button.

The following diagram shows the Add Resources screen.

The following diagram shows the Add Resources screen with individual 
ROSS resources selected.
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2 After all desired ROSS resources have been added to the I-Suite 
Resources grid, click Next to import the ROSS resources into the I-Suite 
database.

To import ROSS resources into an I-Suite database that already 
contains data either manually entered or previously imported 
from ROSS 
1 On the Previous Matches screen, compare the ROSS Resources to the 

I-Suite Resources. If matched resources that should not be matched are 
found, click the Selector button for the I-Suite resource, and then click 
Unmatch; or to edit I-Suite resources, type directly into the I-Suite grid. 

2 When you are finished editing I-Suite resources, click Next.

The following diagram shows the Previous Matches screen.

To validate resources matched by request number and name 
1 On the Validate Matches 1 screen, compare ROSS Resources that have 

been matched to I-Suite Resources by request number and name. 

2 If matched resources that should not have been matched are found, click 
the Selector button for the I-Suite resource, and then click Unmatch; or 
to edit I-Suite resources, type directly into the I-Suite grid.

3 When you are finished editing the I-Suite resources, click Next.
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To validate resources matched by request number 
1 On the Validate Matches 2 screen, compare ROSS Resources that have 

been matched to I-Suite Resources by request number.

2 If matched resources that should not have been matched are found, click 
the Selector button for the I-Suite resource, and then click Unmatch; or 
to edit I-Suite resources, type directly into the I-Suite grid.

3 When you are finished editing the I-Suite resources, click Next.

To manually match/add resources 
1 On the Manually Match/Add Resources screen, to manually match a 

ROSS resource to an I-Suite resource, click the Selector button for the 
ROSS resource and for the I-Suite resource, and then click Match; or to 
edit I-Suite resources, type directly into the I-Suite grid.

The following diagram shows the Manually Match/Add screen with 
manually matched resources.

2 On the Manually Match/Add Resources screen, to add all resources 
from the ROSS Resources grid to the I-Suite Resources grid, click the >> 
button; or to add individual ROSS resources to the I-Suite Resources grid, 
click the Selector button for each ROSS resource, and then click the > 
button.

An “X” will appear in the ROSS Resources grid next to each ROSS resource 
that has been manually matched to an I-Suite resource.

3 When you are finished editing the I-Suite resources, click Next.
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The following diagram shows the Manually Match/Add screen with a 
resource ready to be added manually.

4 When the ROSS Import process is finished, the ROSS Import complete 
screen will appear, click OK.

The following diagram shows the ROSS Import complete screen.
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Incident Action Plan User’s Guide
The Incident Action Plan (IAP) is part of the I-Suite group of software 
programs. IAP, along with the I-Suite database, allows you to produce the 
Incident Action Plan for an incident. Using IAP, you can produce the 
following Incident Command System (ICS) forms:

• ICS-202 Incident Objectives
• ICS-203 Organization Assignment List
• ICS-204 Division Assignment List
• ICS-205 Incident Radio Communications Plan
• ICS-206 Medical Plan
• ICS-220 Air Operations Summary.

You can also produce the Master Frequency List, which lists radio frequencies 
from the ICS-205 Incident Radio Communications Plan.

Topics in this guide include the following:

• About this guide
• Getting Started
• Setting up your IAP
• Understanding form navigation basics
• Creating new forms for your IAP.
For information about installing IAP, please refer to the “I-Suite Administrator’s 
Guide,” which is available for download on http://isuite.nwcg.gov.

About this guide
This Incident Action Plan User’s Guide is organized into sections, based on 
the types of tasks you will commonly perform. At the beginning of each 
section you will find an overview of the topics explained. Where appropriate, 
diagrams are shown immediately following each task. Topics in this section 
include:

• Before you begin
• Conventions.

Before you begin
Before using IAP, you must be feel confident that:

• You are familiar with your personal computer and function keys and 
understand personal computer concepts.

• You are familiar with Windows 2000, Windows XP, or Windows NT and 
can log on and log off.
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Conventions
The following conventions are used within this guide:

• Button names, option labels, screen names, tab names, and text box 
names appear in bold, in the same case as on your keyboard or screen. For 
example, the fist step in a procedure might instruct you to

1 On the Tools menu, click Master Frequency.

• Topics of special interest or hints that will help you perform a specific 
task show a line before and after the text. The text appears in italic type. 
For example, the following note appears in the section, “Setting up your 
IAP.”

Until you mark it as “final,” forms are automatically marked “draft” at the 
top and bottom of each page.

Getting Started
This section explains the basic concepts and information you need to begin 
using IAP. Topics in this section include:

• Terms and concepts
• Logging on and logging off
• Getting help
• Understanding the stand-alone and integrated environments.

Terms and concepts
This section outlines some of the screens, toolbars, and menus that you will be 
using in IAP. If you aren’t already familiar with IAP or have forgotten a few 
things since training, review these terms and concepts before proceeding with 
the remaining sections in this guide.

The following diagram shows the IAP toolbar and a brief explanation of the 
toolbar buttons.
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Logging on and logging off
This section explains how to log on and log off of IAP. 

To log on to IAP
1 From your Desktop, double-click the IAP icon or click Programs from 

the Start menu, point to I-Suite, and then click IAP.

If you have trouble logging on to IAP, please refer to the “Handling installation 
problems,” in the “I-Suite Administrator’s Guide,” which is available for 
download on http://isuite@nwcg.gov.

To log off IAP
• On the File menu, click Exit.

Getting help
This section explains how to access and locate help information. There are 
three basic ways to obtain help information for ITS:

• Access the I-Suite website. This site contains a wide array of I-Suite 
information, including software downloads, updates, and user 
documentation.

• Contact the I-Suite Helpdesk. If you are unable to answer your question 
using the I-Suite website, contact the I-Suite Helpdesk at (866) 224-7677.

• Review this Incident Action Plan User’s Guide. This guide is available 
in Acrobat format. To locate topics of interest, click to select the 
Bookmark of your choice. Bookmarks are listed along the left-hand side 
of the Acrobat document. When you click the Bookmark, you will 
advance to that topic within the document.

To display help information within IAP
• On the IAP menubar, click Help, and then click Support.

The following diagram shows the ISuite Support dialog box. 
September 9, 2004 3



Incident Action Plan User’s Guide Incident Action Plan User’s Guide
To locate help information on the I-Suite website
1 Start your Internet browser.

2 In the Address box, type http://isuite.nwcg.gov, and then press ENTER.

3 On the Welcome to I-Suite webpage, click the IAP application icon.

4 On the IAP webpage, click to select the topic of your choice.

The following diagram shows the IAP application icon on the Welcome to  
I-Suite webpage.

The following diagram shows the IAP webpage and a list of available topics.

To contact the I-Suite Helpdesk

The I-Suite Helpdesk is available 24-hours per day, seven days per week.

• Call (866) 224-7677, or email helpdesk@dms.nwcg.gov.

To obtain a copy of this Incident Action Plan User’s Guide
1 Start your Internet browser.

2 In the Address box, type http://isuite.nwcg.gov, and then press ENTER.
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3 On the Welcome to I-Suite webpage, click the IAP application icon.

4 On the IAP webpage, click to select IAP User’s Guide.

5 In Acrobat Reader, save the file to your personal computer in a folder 
location of your choice.

Setting up your IAP
This section explains how to create your IAP database and define the shift 
names and times.

To create an IAP database
1 On your Desktop, double-click the IAP icon.

2 On the IAP Server and Database Selection dialog box, click the Server 
drop-down arrow, and then click to select the Server Name of your 
choice.

3 Click the Database drop-down arrow, and then click to select the 
Database Name of your choice.

The following diagram shows the IAP Server and Database Selection dialog 
box.

To define shift names and times

You must define shift names and times before you can create IAP forms. You 
can define as many color-coded shifts as you need, so that you won’t confuse 
day shift forms with night shift forms.

1 Log on to IAP.

2 On the Shifts menu, click Define Shifts.

3 On the Incident Action Plan - Define Shifts dialog box, complete the 
following

- in the Shift box, type the name of the Shift
- in the Shift Start Time box, type the starting time of the shift, in the 

format 0000
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- in the Shift End Time box, type the ending time of the shift, in the 
format 0000

- under Shift Shade, click to select a shade to help identify the shift.

4 To save the new shift, click the Enter button.

5 When finished creating all shifts, click the Close button.

The following diagram shows the Incident Action Plan - Define Shifts dialog 
box.

Understanding form navigation basics
Remember the following key points when creating a new IAP form:

• IAP automatically enters the Incident Name, Date, and Time.
• The Date and Time Prepared boxes display the current date and time.
• The Operational Period box displays the current date and day.
• If preparing a form for a different date other than the current date, you can 

manually edit the Operational Period box.
• You must save a form after editing. IAP does not automatically save your 

forms. If you close a form without first saving it, IAP displays a prompt.
• For the most part, you can manually edit or override almost every entry in 

a form.

To create a new form
• On the File menu, click New Form or click the New Form icon on the 

IAP toolbar, and then click to select the form of your choice.
6 September 9, 2004



Incident Action Plan User’s Guide Incident Action Plan User’s Guide
The following diagram shows the New Form icon and the drop-down menu of 
available forms.

To show multiple page numbers on a form
1 Using the scroll bar, scroll to the bottom of the new form of your choice.

2 In the Page ___ of ___ boxes, type to replace the page numbers of your 
choice.

For example, for a two-page form, type Page 1 of 2 on the first page, and 
then type Page 2 of 2 on the second page of the form

The following diagram shows the bottom portion of a form.The arrows point 
to the boxes where you can type page numbers.

To resize a text box on a form

The up and down arrows are located on the right-hand side of text boxes on a 
form.

• To resize a text box, click the Up arrow or Down arrow.
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The following diagram shows some up and down arrows on a portion of a 204 
form.

To format text on a form
• Click to highlight the text of your choice, and then click the text format 

icon of your choice.

The following diagram shows the location of the text format icons on the IAP 
toolbar.

To finalize a form

Until you mark it as “final,” forms are automatically marked “draft” at the top 
and bottom of each page.

• On the Tools menu, click Mark Final, or click the Padlock icon.

The following diagram shows the a portion of a 205. The arrow points to the 
location of where the form is marked “Final.”

To edit a finalized form

Once you mark a form as “final,” you must first unlock it before you can edit it.

• On the Tools menu, click Mark Draft, or click the Padlock icon.
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To display the tree view of forms

You can open more than one form at a time and click to switch between 
forms.

• Perform one of the following
- on the View menu, click Form
- from the IAP toolbar, click the Display by Form icon
- on the View menu, point to Individual Form, and then click to select 

the form of your choice.

To display the tree view of plans
• Perform one of the following

- on the View menu, click Plan
- from the IAP toolbar, click the Display by Plan icon.

To copy any form

You can create new forms by copying forms from previous operational 
periods.

1 From the Tree View, click to highlight the form of your choice, and then 
click the Copy Form icon.

2 On the Copy [form name] dialog box, click to select the Form you wish 
to copy, and then click OK.

The following diagram shows the Copy [form name] dialog box.

To copy the last form created

You can copy the last form you created, not the last form edited.

• On the IAP toolbar, click the Copy Last Form icon.
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To change the order entry for first name and last name

This option allows you to toggle between entering First Name Last Name or 
entering Last Name, First Name.

Before creating forms in IAP, determine the order in which you wish to enter 
first names and last names. Once you begin entering names, previously 
entered names are not retroactively changed.

1 On the Tools menu, click First Name Last Name.

2 To toggle back to the previous setting, click Last Name, First Name on 
the Tools menu.

To enable the exporting of IAP forms to HTML

Performing this task allows you to post a form on a website.

• On the File menu, click HTML Export.

Creating new forms for your IAP
This section explains how to complete the following forms:

• Master Frequency List
• ICS-202 Incident Objectives
• ICS-203 Organization Assignment List
• ICS-204 Division Assignment List
• ICS-205 Incident Radio Communications Plan
• ICS-206 Medical Plan
• ICS-220 Air Operations Summary.

Topics in this section include:

• Working with the Master Frequency List (MFL)
• Creating ICS forms.

Working with the Master Frequency List (MFL)
This section explains how to create the database of frequencies to be used on a 
specific incident.

You must add every frequency you need for the incident to the MFL.

To enter frequencies into the MFL
1 On the Tools menu, click Master Frequency.

2 Click the System drop-down arrow, and then click to select the System of 
your choice.
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3 Complete the remaining boxes in the row

- Group
- Channel
- RFunction
- TX
- Tone
- Assignment
- Remarks.

4 When finished, click to select the check box in the Show column for that 
new Frequency, and then click the Propagate Changes button.

The following diagram shows the Master Frequency List.

To delete a frequency on the MFL

This process only deletes the frequency you select, not the entire MFL.

1 On the Master Frequency List, click the Show column to select the 
Frequency you want to delete.

2 Perform one of the following

- click the Delete Form icon
- on your keyboard, press DELETE.
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The following diagram shows a selected frequency and the Delete icon on the 
Master Frequency List.

To refresh data on the MFL
• Click the Refresh Data icon.

Creating ICS forms
This section explains how to complete the ICS forms you can create in IAP.

To create an ICS 202 Incident Objectives
1 On the File menu, point to New Form, and then click New Form 202 - 

Objectives.

2 In the 4. Operational Period box, click the drop-down arrow, and then 
click to select the Shift of your choice.

3 Complete the following information

- 5. General Control Objectives for the incident (include alternatives)
- 6. Weather Forecast for Period
- 7. General Safety Message.
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4 Under Attachments, click to select all that apply

- Organization List - ICS 203
- Div. Assignment Lists - ICS 203
- Medical Plan - ICS 206
- Air Operations Summary - ICS 220
- Incident Map
- Safety Message
- Traffic Plan
- Weather Forecast.

5 To add an additional attachment, click to select a check box next to a 
blank line, and then type the appropriate attachment next to that check 
box.

6 In the 9. Prepared by (Planning Section Chief) box, type the Planning 
Section Chief Name.

7 In the 10. Approved by (Incident Commander) box, type the Incident 
Commander Name.

8 When finished, click the Save icon.

The following diagram show a blank ICS 202 form.
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To create an ICS 203 Organization Assignment List

The ICS 203 identifies which positions are filled and by whom. People 
qualified for each position mnemonic are identified in the I-Suite database. 
However, if a name does not display in the drop-down list, you may manually 
type in that name. Keep in mind that some position boxes display more than 
one position mnemonic

1 On the File menu, point to New Form, and then click New Form 203 - 
Organization.

2 For each position, click the drop-down arrow, and then click to select the 
Person of your choice.

3 Under 6. Agency Representative, type the Agency for each agency 
representative.

4 In the Prepared by box, type the Resource Unit Leader Name, and then 
click the Save icon.

The following diagram shows a blank ICS 203 form.

To customize your mnemonics (kindcode) filter
1 On the Tools menu, click Form 203 Template.

2 For each section, click in the appropriate box, and then type additional 
Mnemonics as needed, separated by a semi-colon.

3 To save your additions, click the Save button.
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The following diagram shows a sample ICS 203 template.

To create an ICS 204 Division Assignment List
1 On the File menu, point to New Form, and then click New Form 204 - 

Division Assignments.

2 In the 1. Branch box, type the Branch Name, and then press TAB.

3 In the 2. Division/Group box, type the Division/Group name, and then 
press TAB.

4 Under Operations Personnel, click the drop-down arrow for each 
Position, and then click to select the Person of your choice.

5 Under 5. Resources Assigned this Period, click to select the option of 
your choice

- All, to display all resources
- Crew, to limit the drop-down list to display only hand crews
- Engine, to limit the drop-down list to display only engines
- Equipment, to limit the drop-down list to display dozers, water 

tenders, tractor plows, and other heavy equipment
- Line Overhead, to limit the drop-down list to display individual line 

overhead such as Strike Team Leaders and Field Observers.
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6 Complete the following boxes for each resource, as appropriate

You can complete the drop off and pick up locations and times for the first 
resource, and then click the Auto-Fill buttons to fill-in the remaining 
locations and times for all other resources. Edit the remaining drop off and 
pick up locations and times as appropriate.

- Strike Team/Task Force/Resource Designator
- Leader
- Number of Persons
- Trans Needed
- Drop Off PT./Time
- Pick Up PT./Time.

7 Complete the following boxes as appropriate

- 7. Control Operations
- 8. Special Instructions.

8 Under 9. Division/Group Communications Summary, complete the 
following boxes as appropriate for each Function

This section allows you to import frequencies from the ICS 205 Radio 
Communications Plan, if one exists for that operational period. If the 
Frequency - RX drop-down list does not contain any frequencies, an ICS 
205 has not yet been created for that operational period. To display 
frequencies added to the ICS 205 since the last time you started IAP, click 
the Refresh Data icon.

- Frequency - RX
- Frequency - TX
- Tone
- System
- Channel
- System
- Channel.

9 In the Prepared By box, type the Resource Unit Leader Name, and then 
press TAB.

10 In the Approved By box, type the Planning Section Chief Name, and 
then click the Save icon.
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The following diagram shows a blank ICS 204 form.

To customize your mnemonics (kindcode) filter
1 On the Tools menu, click Form 204 Template.

2 Under Operations Personnel, click in the appropriate box, and then type 
additional Mnemonics as needed, separated by a semi-colon.

3 To save your additions, click the Save button.

The following diagram shows a sample ICS 204 template.
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To edit the 204 template

You can change the order of the resource, kind code, and resource name 
fields on the 204 template. This change affects all newly created ICS-204s, 
but does not affect ones already created.

1 On the Tools menu, click Form 204 Template.

2 Click one or more of the following buttons, in the order of your choice, to 
customize the 204

- Add Resource
- Add Kind Code
- Add Resource Name.

3 To save your changes to the 204 template, click the Save icon.

To manipulate rows on the 204 form

You can cut, copy, paste, and delete rows on the 204 form.

1 To cut a row, click to select the row of your choice, right-click in the left-
most column of that row, and then click Cut.

2 To copy a row, click to select the row of your choice, right-click in the 
left-most column of that row, and then click Copy.

3 To paste the cut or copied row, click to select the target row of your 
choice, right-click in the left-most column of that target row, and then 
click Paste.

The following diagram shows a sample row of the 204 and the cut/copy/paste 
options available when you right-click the mouse.

To spell check the 204 form
• On the Tools menu, click Spell Check.
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To complete the ICS 205 Incident Radio Communications Plan

The Communications Leader completes the ICS 205. All frequencies on the 
ICS 204 are also on the approved ICS 205 for that operational period.

1 On the File menu, point to New Form, and then click New Form 205 - 
Communications.

2 For each frequency, click the Radio Type/Cache drop-down arrow, and 
then click to select the Frequency of your choice.

Once you select the frequency, the remaining data from the MFL auto-fills 
on the form.

3 Click the Verify Frequencies button.

The Verify Frequencies button verifies the following:

- All frequencies on the ICS 204 and ICS 205 are approved 
frequencies on the MFL.

- All frequencies for that operational shift are assigned on at least one 
of the ICS 204s for that operational period.

- Any frequency on an ICS 204 is also on the approved ICS 204 for that 
operational period.

If there are any discrepancies between the ICS 204, ICS 205, and the 
MFL, IAP displays a notification message.

The following diagram shows a blank ICS 205 form.
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To create an ICS 206 Medical Plan

The ICS 206 is a narrative, fill-in form.

1 On the File menu, point to New Form, and then click New Form 206 - 
Medical.

2 Complete the following sections as appropriate

- Incident Medical Aid Station
- Ambulance Services
- Incident Ambulances.

3 In the Paramedics column, click to select the Yes or No check boxes, as 
appropriate, to designate the available Paramedics for each type of 
medical service.

4 Complete the Hospitals section, and then click to select the Yes or No 
check boxes, as appropriate, to designate if a Helipad and/or Burn 
Center is available.

5 In the Medical Emergency Procedures box, type a description of the 
medical emergency procedures, as appropriate.

6 Complete the following boxes

- Prepared by (Medical Unit Leader)
- Reviewed by (Safety Officer).

7 When finished, click the Save icon.

The following diagram shows a blank ICS 206 form.
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To create an ICS 220 Air Operations Summary

The ICS 220 is mostly a narrative, two-page form

1 On the File menu, point to New Form, and then click New Form 220 - 
Air Operations.

2 Complete the following sections as appropriate

- Sunrise Hour
- Sunset Hour
- 3. REMARKS
- 4. MEDEVAC AIRCRAFT
- 5. TFR
- 6. PERSONNEL
- 7. FREQUENCY
- 8. FIXED WING
- 9. HELICOPTER.

3 To advance to the next page of the form, click the Go to Page 2 button.

4 Complete section 10. TASK, MISSION, ASSIGNMENT, as 
appropriate.

The following diagram shows a blank ICS 220 form.
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CHAPTER 1                Introduction 
 

 
The Incident Cost Accounting and Reporting System (ICARS) is designed to allow you 
to easily track individual resources in a database format.  The system creates a line for 
every resource for every day.  The ICARS user can then analyze, manipulate, and create 
outputs of this information in a variety of report formats. 

 
ICARS has been integrated into the I-Suite of applications and is now capable of 
running networked with many PC’s all working from the same database.  I-Suite also 
includes the Incident Resource Status System (IRSS), Incident Time System (ITS) and 
Incident Action Plan (IAP).  All of these programs now function off the same set of 
common tables.  Thus common data only needs to be entered one time and can be used 
by all programs. 
 
The system is designed to track any and all incident resource costs that are assigned to 
that particular incident. The INCIDENT table contains basic incident information and 
the RESOURCE table is where header record information for all resources assigned to 
the incident are input.  ICARS ties the RESOURCE table to a variety of lookup tables, 
which contain acceptable entries for the fields in the RESOURCE table.  These lookup 
tables include the AGENCY, KIND, DIVISION, HOME UNIT, OBLIGATION and 
RATES tables. 
 
The system involves the daily creation of records in the DAILY and AIRDAY tables, 
for each RESOURCE table record.  At the end of the incident the combined records of 
the DAILY and AIRDAY tables will contain a line for every resource for every day.   
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What’s New With ICARS 

 
ICARS-04 Updates 
 

• Obligations 
o Update Obligation buckets to remove lines 3 Fixed Wing and 7—Misc. 
o Allow reversal of current day finalization. 
o Split AD's out of mixed crews, so only the AD personnel will be included in the 

obligation bucket for AD's. 
o Correctly identifies Rural, County and City resources to the correct STO or STL 

category based on the Home Unit. 
o Correctly identifies PVT resources based on the contracting agency. 
o Adds Cost Share category, which can be manually used to identify resources that 

should not be obligated because they are covered under a cost share agreement. 
• Projections 

o Allow updating of prior days projections to the current day. 
o Allow editing of per unit costs. 
o Add flow down of data entry in lower section. 
o Corrects error in support calculation 
o Corrects graphing error for projections over 46 days 

• Other 
o Add Business Ratio/Analysis reports 
o Add Fire characteristics to acres burned table for future use in calculating 

weighted costs per acre. 
o Add weekly/monthly rate type, which will only allow daily cost to be created 

once a week/month. 
o Fixed Incident End date in Incident table so it will stop the creation of daily 

records. 
o Added function to pick up an AD crew rate from the rates table if the crew is 

>50% AD's. 
o Corrects error in add screen. 
o Added ability to drag and drop resources into the add resources screen 

 
ICARS-03 Updates 

 
• Addition of an Obligations module used to track and report expenditures, by 

obligation categories. 
• Changes ITS updates to:  

o Interpret R&R, travel home and COP as 8 hours of work time. 
o Lock feature in ICARS will lock out ITS updates 
o ICARS will ignore deductions in ITS where commodity=Partial Pay. 
o The Assign date is equal to the hire date in ITS. 
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o Updates from ITS for crews is changed to only bring in average hours.  
The dollars will be left as the default rate from the rates table.  This 
corrects a problem where AD crew rates were not functioning correctly. 

• An Incident Start date has been added to the Incident table.  Dates prior to that 
date will not be allowed in any I-Suite applications. 

• Fixed bug where costs auto generate to incident start date. 
• The Creation of Daily records and ITS updates have been placed in the database 

as procedures, thus dramatically improving performance times. 
• Modifications to reports screen to summarize as either sort categories or other. 
• Request Number is now required. 
• You can now export a graph as a .jpg file. 
• Various new Kinds were added to the Kind table. 
• Added OAS agency, to track costs for Office of Aircraft Services. 
• Replace Access, as the database engine, with Microsoft Database Engine 

(MSDE)  
 

 
Where to Get ICARS 
 
The ICARS application is available for Downloading, as a part of the I-Suite software from the 
Internet at:  http://www.fs.fed.us/r6/fire/i-suite.  
 

 
How to get help 
 
There is a National ISuite helpdesk, which should be your first call for support 916-799-3586.  
Support for bugs, etc. can also be obtained from the websites listed above.  Other support can 
be obtained from other ICARS users.  Any comments or questions not answered by those 
sources can be directed to Jeff Park at the Region 6 Regional Office in Portland, Oregon.  
 
Phone:  503-808-2978 
Fax:  503-808-2467 
e-mail:  jgpark@fs.fed.us 
Mailing Address:  

Jeff Park 
c/o Financial Management 
333 SW First Avenue, Box 3623 
Portland, OR  97208-3623  
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CHAPTER 2            Installing and Starting ICARS 
 
This chapter contains instructions for installing and starting ICARS. Preferably, installation 
and a quick start-up test should be done prior to a call to an incident, but can be done once 
arriving at the incident. 

  
Running Setup 
 
Obtain I-Suite Final Release CD and follow the instructions on the CD or use the one step 
network install from the download site.  The advantage of the network install is that the 
installation wizard will first look to your PC, to see what files are already there.  It will only 
download files that are not already loaded on your PC. 
 

  
Set Date/Time 
 
You will want to be sure that the date and time is properly set for any PC running ICARS. You 
can change the date and time from within ICARS menu options (UTILITIES | SET SYSTEM 
DATE/TIME) or from the Window’s Control Panel.  Some computers have dead batteries; 
thus, the correct date and time are lost when the computer is turned off.  The correct date is 
critical to the proper running of the ICARS application. 
 

  
Starting ICARS  
 
At the conclusion of the install, there will be an ICARS icon placed on your desktop.  To use 
ICARS in the MSDE environment it is necessary to use the admin tools provided to attach a 
database.  Please see the Administrators Guide for these instructions. 
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CHAPTER 3   General Cost Collection and Analysis Techniques 
 
This chapter discusses what to do before leaving your home unit. It also talks about cost 
collection and analysis techniques. 

  
Prework 

  
What to bring 
 
The following equipment should be available when arriving on an incident: 
 
• IBM-compatible computer (computer rentals are readily available). 
• Printer (May not be necessary if networked to a printer). 
• Blank disks for backups and sharing information. 
• I-Suite application on a CD-ROM. 
• Surge Protector Power strip and extension cord. 
• Office supplies--paper, stapler, highlighters, pens, pencils, clipboard, folders and envelopes. 
• Calculator. 
• Boise Interagency Fire Center (BIFC) contract rates manual. 
• ICARS manual and Quick Reference Guide 
• Field Operations Guide (FOG) Handbook (Definitions). 
 

  
Computer Site Preparation 
 
1. As dust free an environment as possible to reduce computer wear and tear. 
2. Electricity availability.  An extension cord will afford you more flexibility. 
3. Since you may need to network to computers and information from personnel time, 
equipment time and IRSS, proximity to the finance unit and the IRSS unit will be necessary.   
 

   
Empty tables 
 
If you are using an I-Suite database that has been previously used it will be necessary to assure 
the data from the previous incident has been removed.  The best approach is to start with a 
clean database, which is loaded when you install the software, or is available from the web site. 
If you want to re-use a database you can simply Delete All the Incident records in the Incident 
Table. Because of the built-in relationships, deleting an Incident record will delete all records 
associated to that Incident. This essentially, empties the I-Suite database" 
 

  



 10 

Data Collection 

  
Evaluate Sources 
 
Upon arriving on a fire, one of your first tasks is to evaluate the sources of cost data you will be 
using in your cost analysis.  You must determine what sources are available and decide what 
data appears to be the most accurate. Following are some sources of data that will be used both 
to build your RESOURCE table and to use for daily updating. 
 
1. T-Cards from Resource Unit to verify resources, names and assignments. 
2. Resource Orders from Ordering Manager or Supply Unit Leader; also Expanded 

Dispatch. 
3. Check In - Has anything new come in during the last 24 hours? 
4. DEMOB - What left yesterday, today and is planned for tomorrow? 
5. ICS-209 - Previous day numbers used for overhead and total personnel for supplies. 
6. IRSS Reports - Some IRSS reports or RESOURCE.DB file can help fill ICARS gaps. 
7. I.A.P. (Incident Action Plan) - Used to verify resources on the ground; especially critical 

in a Cost Share agreement where division assignments play a part of the agreement. 
8. Equipment rental agreements and use invoices from Equipment Time for identification 

of contract resources and actual rates. 
9. Time sheets from Time Unit for actual crew hours worked. 
10. Air Cost - Summaries from Air OPS for previous day. Also used to estimate current day. 
11. Caterer - Costs from Food Unit Leader for previous day. Also used to estimate current 

day. 
12. Bus - Count from Ground Support 
13. Pickup - Count from Equipment time, Equipment Manager or Ground Support. 
14. Crew - Updates from Time Unit. 
15. Claims - From Claims (Comp/Claims normally list all injuries). 
16. Unit Logs for other misc records. 
 

  
Initial Data Entry 
 
The table called INCIDENT contains Incident information and should be updated to reflect the 
basic information about this incident. You can track multiple Incidents within a single database 
by assigning different numbers in the incident table (IE: 1,2,3). Another option is to store 
different Incident information in two separate ICARS database files.  
 
The table called RESOURCE is where all basic information on resources assigned to the 
incident will be entered.  If you are using ICARS as a stand-alone application you will have to 
enter all resources.  If using ICARS, in a networked Isuite setup, resources will be entered into 
the RESOURCE table through IRSS and ITS as explained below. 
  
If IRSS and/or ITS are being used on the Incident then you will need to work with the 
Computer Technical Specialist to get networked with the other PC’s.  Once you are networked 
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you will use the same I-Suite database, as IRSS and ITS and all your ICARS tables will be filled 
with the data entered through check in by IRSS, and Time System through ITS.  The 
IRSS/ITS data can be supplemented and verified by data from the other sources as listed above. 
 Of course you will need to enter all cost information not supplied by ITS.    You will need to 
work closely with the IRSS/ITS personnel and communicate on any changes to the common 
database.  Generally IRSS will be the owner of the resource information and any changes will 
be either entered by or communicated to the IRSS personnel.  This may vary from incident to 
incident depending on the working relationship that is built.  See Chapter 12 for a further 
discussion of I-Suite. 
  

  
General Data Input Information 

  
Level of detail 
 
When inputting information different levels of detail may be used, depending on the incident 

size, predicted length, management needs, etc. Of course if IRSS is entering the data you 
will not need, or have the option to summarize, as all individual records will be entered 
into the system through check in.  Examples of different levels of detail are: 

 
1. Summarize overhead personnel into support and direct instead of entering every person.  

Direct overhead are defined as the Incident Commander and direct staff as well as any 
individual that has direct duties on or around the fire line.  This information can be 
generated from the shift plan, T-cards, or ICS-209 

 
2. Summarize crews into hotshots, regulars and ADs as opposed to entering crews by crew 

name. 
 
3. Summarize buses into cost categories as opposed to entering every bus by name. 
 

  
Use of actual vs. estimates 
 
Included in ICARS is a standard rates table, which includes estimated rates for most resources 
that will be found on an incident. ICARS will automatically enter these rates into the DAILY 
table, when you enter a resource. 
 
Since these rates are only estimates they can be updated to actual rates at any time. If no rate is 
available in the rates table, it is best to enter estimates at the outset with the plan to update to 
an actual cost later.  This is usually the case with costs such as aircraft and caterers.  The 
current day's cost will be entered as a projection based on the prior day's cost (or other 
information, if available) and then updated with the actual cost when it becomes available.  Such 
updates are accomplished by editing the DAILY and AIRDAILY records for a particular resource. 
When entering actual costs, you can use the Locked field to flag that entry as an actual cost and 
locking edit access to that particular Daily record. 
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Strike Teams 
 
A strike team will be entered in IRSS as a Parent record (the strike team name) with various 
children records (individual crews or engines).  The parent record will show in ICARS, but you 
will not be able to add costs to it.  The costs will show with the individual children records.  
This process allows strike teams to be built and dismantled.  All the daily records will be 
maintained with the strike team element.  
 

  
Quantities and Units 
 
The Quantity and Units fields in the DAILY table are also important for calculating a resource's 
daily costs. A resource's daily cost is calculated by multiplying the resource's unit cost, 
quantity, and units together to determine the total cost of the resource.  The Units field can be 
handled various ways.  You can use a standard number of hours like 14, assuming that on 
average everyone is working a 14 hour day or you can enter the actual hours or you can enter a 
1 if the rate you are using is a daily not hourly rate.  It is preferable to enter hourly rates 
because this allows a direct comparison of resource cost (daily costs are not always based on the 
same number of hours so comparisons where daily costs are used, may be misleading). Some 
examples of quantities to use are as follows: 
 
Crew Strike Team = Quantity of 2 
Engine Strike Team = Quantity of 5 

 
Backing Up 
 
By default, as you enter data into ICARS it is automatically saved into the database.  It is 
always wise to make a copy of the database and that is what we refer to as "Backing Up".   
Backing up is usually handled by the CTSP on the incident.  If you are running stand alone 
refer to the Administrator Guide for instructions on backing up. 
 

  
Cost Share Apportionment 
 
Cost share apportionment capabilities are built into ICARS. Cost sharing is provided for 
incidents where there is more than one jurisdictional agency involved and costs are to be shared 
between agencies. The Cost apportionment section functions through the assignment of 
resources to divisions, with those divisions potentially having unique percentage breakdowns 
per division, per day.  The DIVISION table is where you set up divisions and shifts and cost 
sharing percentages by agency.  For example the day shift on division A would beA1 
(A=division, 1=day shift).  Once a division is set up you may assign resources to that division in 
the DAILY table.  Only resources with the division and shift fields filled in, in the DAILY table, 
will be included in the cost share. 
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About Cost Sharing an Incident 
 
The information developed in the Cost Share reports can be used in two ways depending on the 
agencies involved and the cost share agreement for the incident: 
 
1. To develop a percentage split between agencies, which will then be applied, at a later date, 

against the actual expenditures as determined by agency financial statements. 
 
2. To develop each agency’s dollar share of the incident cost so billings can be produced 

immediately by the appropriate agency.   
 
If you are using ICARS to determine the actual dollar responsibility of each agency then you 
must also deal with how support costs will be allocated.  Support costs will usually be allocated 
based on the direct cost percentages.  This can be accomplished by adding a division code of S1 
to all support resources in the DAILY table (if some support resources will not be shared leave 
the division field blank on those resources) or creating separate allocation lines with S1 in the 
division field (see below).  Follow this by adding division S1 to the Division table for all days.  
You can then enter into the division table the direct cost split by agency from report R1 for 
each day.  This will create some extra complexity in the daily process because you don't know 
the direct cost split for the current day until you have completed steps 1-3 below for that day.  
Thus to do this you must complete steps 1-3 below first, then update the division table with the 
S1 percents for the current day and then complete step 3 again and step 4. 
 
An alternative to putting an S1 in for each resource is to determine the support costs each day 
that will be allocated and enter two allocation lines into the DAILY table with the kind ALL.  
The first line would be a minus number with the division field blank.  The second entry would 
be a positive number with a S1 in the division field.  These entries will not affect the total cost 
but will allow you to show support dollars in the cost share module. 
 
When using ICARS to determine each Agencies actual dollar responsibility you will also want 
to know how much each agency spent, so you can determine who owes whom.  Under menu 
option Reports is 1) cost summary by agency 2) cost detail by agency report, which will give 
you the amount spent by each agency. 

  
Daily Steps for Cost Apportionment 
 
The daily steps when doing cost apportionment include the following: 
 
1. Finish normal daily processing and updating of the Resource, Daily and AirDay Table, 

including the assignment of divisions to the resource that are involved in the Cost 
Apportionment for the particular incident. 

2. Edit the Division table to enter the current day percentages by division. 
3. Print "Cost Share Summary" report CAT R1. 
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4. Print detail reports: 
Cost Share By Shift and Kind  (CAT R2) and  
Cost Share Resource Worksheet (CAT R3). 

 
Alternative Cost Sharing Approaches 
 
1. Variations to the basic structure above can be made, by being flexible, with the division 

assignments.  For example if the determined method of cost sharing were to identify 
specific resources that are the responsibility of each agency without regard to what 
division they are working on a modified approach would be to designate a division for each 
agency and proceed accordingly.  For example A1 could be designated to represent Federal 
costs and division B1 to represent State costs.  Under this scenario you would assign a 
status of A1 or B1 to all resources identified, regardless of where they actually worked. 

 
2. Since only those resources with the status field filled out will be included in Cost 

apportionment reports, another modification is to only include a status entry for specific 
resources.  For example on a Predominantly Federal fire you might have six engines and 
one hand crew supporting the State portion of the fire. You could chose to identify those 
resources with an A1 in the status field and leave the status on all other resources blank.  
You would then fill out the Status table showing 100% State for A1.  This would just pull 
in the resources with state responsibility and the cost share reports would determine the 
state portion of the fire based on those resources alone. 
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CHAPTER 4      ICARS File Menu 
 
This chapter deals with all File menu options from within ICARS. The ICARS menu is broken 
down into different modules of the program (i.e.) Editing, Reporting, Graphing, Projecting, etc. 
Similar to any Windows application you may use your mouse to click on a menu item or use a 
common keyboard combination of the “ALT” key and the underlined letter of the menu option 
(ie) Alt-F to activate the File menu. This manual will now describe each menu option and its 
function. Below is an image of the ICARS main menu. 
 
IMAGE 4-1  ICARS Main Menu 

Under the File menu is where all basic 
Open, Printer Setup, and Exit 
Functions are located. When you start 
ICARS for the first time it opens a 
default database called ISuite.mdf.  
Using the file menu options you can 
Open or Reopen an existing database 
or create a new incident using the 

ISuite.mdf.  Each menu option is discussed below. 
 

NEW INCIDENT  
 
The NEW INCIDENT menu option is used for adding a new incident to an existing ICARS 
database. You may have many different databases, each potentially storing a single or multiple 
incident. By default, the ISuite.mdf file is the default database. 
IMAGE 4-2 ICARS Incident Screen  

 
If you open a database without an incident ICARS will take you to this screen immediately.  
Because the ICARS application uses a relational database, you must first create a new incident 
before adding any resource. If you wish to remove an incident, you may delete the incident from 
the Incident table. Because of its relationships with the other tables all resource records and 
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their accompanying daily records will be deleted. 
 
The image above shows the Incident Screen, where you can ADD, DELETE or MODIFY 
Incidents. To add a new incident, simply press the “NEW” button and fill out the fields below 
the grid. Once you have filled out all the fields, press “SAVE” to save that incident’s 
information. You may have multiple incidents within any ICARS database. Press “Exit” to close 
the incident Screen.  See Menu option Edit | Incident for greater detail of the fields. 
 

 
OPEN DATABASE 

IMAGE 4-3  Open Database Screen 
The OPEN 
menu option 
will prompt 
the user with 
a dialogue 
box that will 
display 
current 
databases 
(*.mdf) that 
have been 
attached 
through the 
Admin Tool.  
You must the 
select the appropriate server, which may be your PC or another PC, operating as a server, and 
database.  For further instructions on attaching databases see the I-Suite Administrators Guide.  

 
OPTIONS 
  
IMAGE 4-6  ICARS Options Screen 
By choosing Options, you may customize 
the colors of all the grids in ICARS. ICARS 
grids are commonly referred to as "Even" 
and "Odd" rows. You can change colors for 
the row backgrounds, font foregrounds, and 
grid columns. These new settings are saved 
automatically and are used until they are 
changed again. 
 
After first installing ICARS, a default set of 
colors for the grids and column headers will 
be installed. You may change colors at 
anytime. These color settings are 
independent of any Windows color settings 
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you have set previous to changing ICARS colors. 
 

 
PRINT SETUP 
         IMAGE 4-7  ICARS Printer Setup Screen 

The Print Setup menu 
option simply calls up a 
Window's Printer Setup.  
This will differ depending 
on the version of Windows 
you are using.  
 
 
 
 
 
 
 
 
 
 

 

EXIT 
  
The EXIT menu option exits the ICARS application. This is always the preferred method of 
exiting any Windows application. 
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CHAPTER 5                 ICARS Edit Menu 
 

IMAGE 5-1  ICARS Edit Main Menu 
This chapter deals with all Edit menu options from within ICARS. From 
the Edit Menu, you can edit all ICARS tables necessary to run the 
application. The ICARS application is based on a relational database and 
one table has relationships to other tables and so on and so on.  For 
instance: The Incident table is the master table; you must have an Incident 
in the Incident table before entering Resources in the Resource table. 
Taking this a little further, you must have a resource in the resource table 
before you can create daily records for that resource. One table works off 
the other. 
 

 
RESOURCES 
IMAGE 5-2  ICARS Resource Input Screen With Display Daily Turned On 

The Resource/Daily screen is the primary ICARS screen. The Resource screen contains all the 
Resource header information for each resource (i.e.) Crews, Engine, Dozers, Aircrafts, Toilets, 
Caterers, etc. The Daily records, can be displayed by toggling on and off the “Display Daily” 
check box at the bottom of the Resource Screen. This is where daily entries for that particular 
resource are kept. The relationship between a single Resource and its charges to the incident is 
a one-to-many relationship (i.e.) for a single resource there may be one or many Daily records, 
more commonly, one for each day the resource is charging to the incident.  
 
Required fields for a Resource record are: Incident Number, Req #, Kind, and Assign Date. 
Daily records are auto created and can be edited.  Daily’s Cost field is calculated and can only 
be changed by adjusting the Quantity, Unit Cost, and Units. 
 
A user may rearrange the order or column width of any and all fields in the Resource and Daily 
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tables and those settings will be saved.  
 
Buttons, and their function, found at the bottom of the screen are: 

 
 
Enable Flow down – When checked the flow down features of the daily table will function.       
      When unchecked all flow down in the daily table will stop. 
Add – Add a resource record.  Will bring up the add resource screen which can be filled out and 
saved as a new resource.  Resources in the resources table can be dragged and dropped into the 
input screen, and then edited for quick creation of like resources. 
IMAGE 5-3  ICARS Data Input Screen 

 
Copy – Copy a resource record.  Will bring up the add resource screen, pre-filled with the 
information of the resource record currently highlighted.  Changes can be made to the record 
and the record can be saved as a new resource.   
Delete – Delete a daily or resource record. 
Refresh/Update – Use to update the 
database.  Select the type of update you 
want in the dropdown box and then 
click on the Run button.  The choices of 
update types are: 
 Refresh Only – Refresh the database to reflect any changes made by I-Suite partners. 
 Create Daily Only – Daily records are created from the check in through release dates. 
 Apply ITS Only – Updates daily records with postings from the Incident Time System. 
 Refresh/Create Daily/Update ITS – Will do all of the above. 
Sort/Filter – To sort and filter based on multiple criteria.  See detail  in Chapter 11. 
Lock\Unlock – Lock or unlock all daily records for a resource. 
Print Grids – Print the Resource or Daily screen as seen. 
Incident Filter – Filters on all incidents or only the incident you select. 
Resource Filter – Filters based on the first letter of the Request # field (E=Equipment, 
A=Aircraft, C=Crews, O=Overhead, S=Supplies, or just filters out Overhead) 
Not Released Filter – Filters based on only currently assigned (not demobed) resources. 
Search – The search routine will search for an entry in the column selected.  
Rate Area – If you have set up a custom rate area, you can choose to activate it here. 
Daily Sum – When checked the total cost will display for the resource selected. 
Flow Down – Can be unchecked to turn off the flow down feature in the Daily table. 
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Below is a brief description of each field found in the Resource table. 
 
Incident: This value is a lookup value to the Incident table. Only values that pre-exist in the 
Incident table are valid here. Note: You will not be able to add resource records unless you have 
already added an incident record to the Incident table. This field is a pull-down box that allows 
you to either pick from the list of valid Incident numbers or simply type in it in. The Incident 
field is a required field. 
 
REQ Num: This value is the Request Number. This number is found on the Resource Order 
Forms and is used on various other incident related documents to identify the specific resource. 
This field required and so if you are not sure, at the time of entering the resource, what the 
number is, just enter the identifier A=Aircraft, C=Crew, E=Equipment, O=Overhead and 
S=Supplies with a zero for the number.  The actual number can be entered later. 
 
Name: This value is the name that you wish to use to identify that particular resource. (ie) 
Engine 2395 or Redmond Hotshots, or Duncan Toilets. Consistency is important when you are 
naming the resources. This will facilitate using the SORT function. For example, Engine 555 
vs Eng 8. Be consistent. Note: Since the kind of the resource you are entering is typically in the 
kind field, you do not need to include the kind in the name.  
 
Kind: This value is a required field and plays a very critical role in ICARS. Each resource must 
be assigned a Resource Kind (ie) ENG3 = Engine Type-3, TLT = Toilets, HC1 = Hand Crew 
Type-1. The Kind selected will affect where the resource groups on the reports and what 
default rate is picked up from the Rates table. 
 
Agency: This value is the Agency this resource belongs to (ie) USFS, BIA, NPS, or PVT. All 
contract equipment should use the PVT agency value. This value could potentially be very 
important in a cost apportionment scenario. Though this field is not required the Agency value 
helps to determine the default Unit Cost for a particular Resource. Every ICARS user is 
strongly encouraged to assign an Agency to each Resource.  
 
Contracting Agency: This field is optional.  When used, it will track the agency that is actually 
responsible for payment of the resource.  Always use in cost apportionment situations.  This field 
uses the Agency lookup table.  It will be filled with FED, STATE, COUNTY, RURAL, BLM, 
BIA, NPS, FWS, DOD, FS.  
 
Unit: This field is optional and can be left blank.  Similar to Agency, is a more specific value for 
which a resource belongs to. (i.e.) If the Agency was USFS, the Unit might be a particular 
Forest: DES for Deschutes NF. The main use of the Unit field in ICARS is to track local 
resources.  There is a field in the Unit lookup table where you can identify which units are local. 
 Reports can then be run identifying local resources. 
 
Obligations:  Obligations can now be tracked and reported through ICARS.  This field will be 
auto filled with values from the Obligation table.  These values are based on the Request #, 
Agency, Kind, Incident State, Contracting Agency and AD identifier.  A new obligation module 
is present on the menu, to extract certain obligation categories into obligation reports that can 
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be reported to the incident unit. 
 
Assign Date: This field is optional if a check in date is entered.  Otherwise this is a required 
field and plays a critical role in ICARS. The assign date for a particular resource is the date the 
resource first started charging to the incident and determines how many days of cost 
information is created in the Daily table.  This date overrides the check in date and allows for 
the creation of cost information before a resource checks in. 
 
Check In Date: The Check In date is a field used by IRSS and can’t be changed in ICARS.  If a 
check in date is not entered, you must enter an assign date. 
 
REL Date: This value is a release date for a particular Resource. This also plays a critical role 
in ICARS. The release date is used similar to the assign date, and there can never be charges in 
the daily table prior to the assign or check in date or after the release date. If a release date is 
prior to the current date, ICARS will not insert daily records for that resource for that day. 
When resources are released, it is critical that a release date is entered. 
 
Status: Display for information only.  This record is entered and used by IRSS to track the 
status of a resource.  C = Checked In A = Assigned, D = Demobed, P = Pending Demob. 
 
S/T:  Strike Team identifier.  A strike team parent record will show as P-xxx.  All component 
records will show as C-xxx.  Daily costs will be created for the components but not the parent 
record, since the parent is not a real record but just a placeholder in the database for IRSS and 
IAP to use for assignments of the strike team. 
 
Description: This value is used to better describe a particular resource or add relevant 
information.  

 
DAILY 
 
The Daily table is where the detail records for each resource are kept. A detail or Daily record 
stores information about a single day's activity and its cost relation to the incident.  
 
When initially placing Resources in the Resource table, ICARS will create daily records from 
the check-in or assign date to the current date. This automatic Daily record is generated only 
as an estimate and is based on a lookup from the Rates table based on the Agency and Kind that 
you have entered.    If you know the actual rate for a resource you may replace the estimate, 
generated by ICARS with the actual rate for this particular Resource.  If ITS is inputting actual 
time, clicking the Apply ITS button will enter Actual time and/or costs.  There is a cost unit 
field which will show a E for the original estimate, a U for user updated or an A for actual costs 
from ITS. 
 
Built into ICARS is an automatic flow down function, which allows a user to change the Daily 
table’s Quantity, Unit Cost, Units, Rate Type or Division and that information will change 
(flow down) to all the daily records below it, that are not locked.  The flow down can be turned 
off using the checkbox on the resource table screen. 
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Below is a brief description of each field found in the Daily table. 
 
Daily Date: This value is a required field. This value is the date for this particular resource’s 
charges for that day. 
 
Quantity: This value is a required field. This field indicates the number of items assigned to the 
resource. For example, a strike team is a quantity of five. 
 
Unit Cost: This value is a required field. This value is the dollar amount that is associated with 
Quantity and Units and represents the unit cost of the resource. 
 
Units: This value is a required field. This value is commonly associated to the Rate Type. For 
example, the units will equal "1" if a Daily Rate Type is used or possibly 14 if an hourly rate 
type is used. 
 
Rate Type: This value is a required field. An example of values might be Hourly, Daily, 
Guaranteed, Gallon, etc. 
 
Cost: This value is a calculated field. The calculation is derived from three fields: Quantity 
multiplied by Unit Cost multiplied by Units. When Quantity, Units, or Unit Cost fields are 
changed, the Cost field is automatically re-calculated, after leaving the record. 
 
Cost Level (CL): Will show an E for the original estimate, a U for user updated or an A for 
actual costs from ITS. 
 
Division: This value is the division the resource is assigned to for that day. The Division field 
can be either blank or can be filled in with a valid Division, which is stored in the Division 
Table. The lookup table for this field will only display Divisions, for that particular day of the 
daily record you are editing (i.e.) If you are editing a Daily record for 7/11/98, the division 
pull-down will only show the division assignments for 7/11/98. 
 
Shift: This value represents the shift that a particular resource is being worked. “D” for Day or 
“N” for night. This will allow you the option of sorting for cost based on day versus night. 
 
Underutilized: This field is a check box that’s toggles on or off. On is represented with a check 
mark in the box. This field is used for reporting potential resources that might not be currently 
used. 
 
Locked: This field is a check box that’s toggles on or off. On is represented with a check mark 
in the box. When the locked field is checked, the entries in the record can’t be changed by the 
user or the ITS update process.  This is often used when you have entered the actual amount 
for a resource and don’t want it to be changed. If this field is not locked the Flow Down method 
can and will change all daily records below the changed value for Quantity, Unit Cost, Units, 
and Rate Type. 
 



 23

Accounting Code:  This value is used to reflect the accounting code that the incident is being 
charged to.  The accounting code may be changed on a daily basis and is limited to entries in 
the Accounting Code lookup table. 

 
AIRDAILY 
 
See Aircraft Analysis in Chapter  12 

 
DIVISIONS 
 

IMAGE 5-4  ICARS Division Input Screen 
The Division table is 
where division 
information is stored 
for an incident. This 
is a critical piece 
when on a cost 
apportionment 
incident. The 
division table is 
where you enter the 
percentage break 
down of a particular 
division by Federal, 
State, and Other 
responsible parties. 
The combined three 
columns (Fed %, 
State %, and Other %) must add up to 100%. The Fed %, State % and Other % fields represent 
percentage of their cost obligations to that division for that specific date. For example, if 
Division A for June 1 has a 60-40 split, this is shown as 60 % Fed and 40% State.  
 
Using Division assignments on an incident is totally optional, unless required for cost 
apportionment. The values in this table are used as lookup values to the Daily Table. The 
values that a user will see from the Daily table are only the divisions for the particular day that 
the resource is charging to the incident. Similar to Daily records, divisions will automatically be 
duplicated each day if there are divisions for the prior day. The records themselves will be 
copied and use the current computers date as their date. If the percentages are different for that 
next day, the ICARS user will be required to change the percentages for that particular day. If 
there are no division records for the prior day the replication of the division records will not 
occur and will require the user to insert them. There is a copy at the bottom of the division 
screen, where you can copy one division record and then go back in and change the date and 
potentially the percentages. 
 
Below is a brief description of each field found in the Division Table. 
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Incident: This value is a required field. It is a lookup to the Incident table. 
 
Division: This value is a required field. Normally this value would be a “A”, “B” or a “1”, “2” 
type value. This value would be the letters or numbers that the Incident is calling these 
divisions  
 
Shift: This value will be a “D” for day or a “N” for night.  If costs are not being apportioned by 
shift a “D” may still be used. 
 
Date: This value is a required field. This value is the date associated with the cost 
apportionment percentages. 
 
Fed %: This field is a required field. This field represents the Federal percentage of their cost 
obligations to that division for that specific date. 
 
State %: This field is a required field. This field represents the State percentage of their cost 
obligations to that division for that specific date. 
 
Other %: This field is a required field. This field represents the Other percentage of their cost 
obligations to that division for that specific date. Other represents any other agency or group 
that is not either Federal or State (ie) County, City, etc. ICARS has the capability to divide the 
cost obligations into a maximum of three entities. 
 
Description: This field is an area where you could place additional information about that 
division. 

 
ACRES BURNED 
IMAGE 5-5  ICARS Acres Burned Screen 

The acres 
burned is 
tied to the 
Net Value 
Change 
“NVC” 
module 
where you 
can 
calculate 
the dollar 
loss for 
various 
types of 
predefined 
resources. 

Similar to the division table, you would insert new acres burned records for each day on the 
incident (just the new acres…not the total). Then in the NVC FIL(Fire Intensity Level) table 
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you can assign the cost per acre for each type of resource for each FIL.  
 
As a future enhancement the acres burned now also includes fields to track fire characteristics.  
These will eventually be used to calculate the cost per a weighted acres, with the weighting 
being based on the potential and risk of the fire. 
 

 
INCIDENTS 
 
The Incident table contains all 
the basic information for the 
incident including the incident 
number, name, location, and 
Start & end date.  
Below are brief descriptions of 
each field found in the Incident 
table. 
 
Number: This should be the    
actual # assigned to the fire.     
                          

                                    IMAGE 5-6  ICARS Incident Input Screen 
Name: This will be the Common name of the incident (ie) “Canyon Fire” 
 
Location: Usually represents a city but can be a more specific location. 
 
State:  Must be the two letter state code.  This is critical to the obligations reporting. 
 
Start Date: All Dates entered in I-Suite will verify against this date.  This will stop keypunch, 
etc. errors where check in and ITS posting dates are prior to the start date. 
 
End Date: The End Date is used for stopping ICARS from creating daily records, if opened 
after the end of an incident.  No daily records can be created after the Incident End Date.  
 

 
RATES 
 
Standard rates are included for single resources such as crews, engines, overhead, fallers, 
pickups, and fuel tenders. The RATES tables main function is to determine a default rate for a 
resource entered into the Resource table. There are numerous types of rates for a number of 
different groups. When you choose Rates from the Edit menu you will see that there are three 
different tables to edit. Those are Rates, Rate Type, and Rate Group. All three tables are tied 
together. Below is a brief description of each of the Rates 
tables  
 



 26 

 
Rate Area 

IMAGE 5-8a  ICARS Rate Area Input Screen 
The Rate Area table contains a default rate identifier and specific rate areas set up by the user.  
After setting up a rate area in this table you then make that rate are active and utilize that rate 
area in the rates table to set up specific rates for that area.  In the Resources screen you can 
then specify to use your new rate area as the first rate to pick up.  If you do not set up rates for 
a certain Kind, the default rates will then be used. 
 

 
Rate Type 
IMAGE 5-7  ICARS Rate Types Input Screen 
 

The Rate Type table stores 
information about the different 
types of rates that are available  
in the Rate Type pull down 
combo box in the Daily table.  
Rate types for Weekly and 
Monthly rates have been added.  
These rate types only allow the 
creation of daily records every 
week or month.  So if you know 
resource is only paid weekly or 
monthly use these rate types.  
Otherwise ICARS will try to 
create a cost for every day, which 
would be incorrect.  
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Rate Group 
                                                                          
IMAGE 5-7a  ICARS Rate Group Input Screen 
 
The Rate Group field is used in the Rates 
Table to allow different rates for the same kind 
of resource, but for different agencies (Fed, 
State, Contract, etc). 
 
 
 
 
 
 

 
Rates 
The Rates Table stores rate information about each Kind of resource within ICARS. These 
rates may be negotiated prior to Fire Season or simply rough estimates so that ICARS has 
something to use as a default rate for any kind of resource that is used on an incident. All Daily 
rates for any resource may be over-written by changing the rate inside the Daily table for a 
particular resource.  If you want to set up a specific Rate Area, first enter the new Rate Area in 
the Rate Area table, and then select that rate area from the box in the upper left corner of the 
Rates screen.  Rates can be entered in the grid and then saved by clicking on Apply. 
 
IMAGE 5-9  Rates Table Input Screen 
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KINDS OF RESOUCES 
 
The Kind table is a lookup table containing a two to four letter abbreviation for all acceptable 
kinds.   Every resource added to the resource table requires a Kind to be assigned. The Kind 
table should contain all the Kinds you will need.  However, there may be times when you will 
need to add a new Kind to the Kind table.  The best way to add a resource, is to find an existing 
resource that is similar to the one you want to add.  Click on this resources which will populate 
the edit fields at the bottom of the screen.  Then change the KIND and any other information 
that is difference.  Then click SAVE AS, which will save the KIND with the new name that you 
gave it.  You can also just choose NEW from the KIND screen and enter all the fields from 
scratch.  If you do add new KINDS be aware of all the fields in the Kind table as they play a 
critical role in the Reporting and Graphing of ICARS data. Minor changes in the Kind table can 
significantly change the way ICARS data is reported and graphed.  The KIND table also 
includes fields used by IRSS, which you do not see in ICARS, so if you are adding kinds 
coordinate with your IRSS partners, so they can assure that their fields are also filled in.   
 
IMAGE 5-10  Kind Table Input Screen 



 29

  
Below are brief descriptions of each field found in the Kind table. 
 
Kind Code: This value is the Kind Code that is used in the Resource Table. Before adding a 
Kind to the Kind table you should be sure and see that no other Kind in the Kind table will suit 
the need. 
 
Description: This value is a more descriptive word to the Kind Code. 
 
Quantity: Is the value that is used as the default Quantity for a particular Kind that is inserted 
into the resource table. Quantity is the number of that Kind.  
 
Units: Is the value that is used as the default Units for a particular Kind that is inserted into 
the resource table. Units correlate closely to Rate Type. A “Daily” Rate Type would most likely 
have a Unit value of 1 (one day), where a “Hourly” Rate Type might have a Unit value of 12 or 
14. 
 
RateType: Is the value that is used as the default Rate Type for a particular Kind that is 
inserted into the resource table. Rate Type correlates closely to Units. A “Daily” Rate Type 
would most likely have a Unit value of 1 (one day), where a “Hourly” Rate Type might have a 
Unit value of 12 or 14. 
 
Direct: The Direct Check box is a toggle for a Direct Cost or an In-Direct Cost. Examples of a 
Direct cost would be an engine directly on the fire line. An example of an In-direct cost might 
be Showers that support the Incident in a In-direct means. 
 
Aircraft: This Aircraft check box is a toggle to determine if the Kind is an aircraft or not. It is 
used for reporting purposes throughout ICARS. Examples of aircrafts would be air tankers, 
helicopters, lead planes, etc. 
 
Daily Form: This value is used to determine what kind of Daily form to use. If you notice, the 
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Daily form is much different for an air tanker than it is a dozer. On the same note, you’ll notice 
a helicopter is different from a lead plane. The majority of the Kind of resource on an incident 
will fall under the “O” category of “All Other”. Helicopters and Aircraft have their own daily 
form and that is primarily when you will see different Daily Form codes used. 
 
Like Kind:  This value is used to group very similar kinds together for reporting on the daily 
and weekly cost summaries. For instance ENG, ENG1, ENG2, and ENG3 are all engines, just 
different types. There are times when we wish to know just how many engines, irrelevant to 
the type of engine they are.  Following are the current Like Kind groupings that are set up. 
 
Group Code Kind Like Description 
C CREWS 
D DOZERS 
E ENGINES 
H HELICOPTERS 
T TRACTOR/PLOWS 
W WATER TENDERS 
OD LINE PERSONNEL 
OS CAMP PERSONNEL 
VE MISC. VEHICLES 
F MISC. FACILITIES 
EQ MISC. EQUIPMENT 
H1 HEAVY HELI 
H2 MEDIUM HELI 
H3 LIGHT HELI 
H4 OTHER HELI 
CC CAMP CREW 
SUP SUPPLIES 
MC MILITARY CREW 
LO LOWBOY-TRANSP. 
MI MISC. SUPPORT 
FW FIXED WING AIR 
AT AIRTANKER 
RET RETARDENT 
BUS BUSSES 
CAT CATERER 
SHW SHOWER 
TLT TOILETS 
RES RESCUE MEDICAL 
TRA MOB/DEMOB 
TRC TRASH COLLECTOR 
 
Kind Group: This value further breaks down the cost group from within the Direct or Support 
Cost Sections.  Under the Direct section there are four groups, those are: “A” (Air), “C” (Crews), 
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“E” (Equipment), “L” (Overhead-Line).  For the Support section there are three groups, those 
are: “M” (Camp Support), “O” (Overhead-Support), “S” (Supplies). 
 
Graph Group: This value determines where the cost of this particular kind falls into place, in  
the graphs. All the graphs for ICARS are broken up into six groups, those are: “A” (Air), “C” 
(Crews), “E” (Equipment), “M” (Camp Support), “O” (Overhead), and “S” (Supplies). 
 
Function Group: This value is used in a few ICARS reports for breaking down costs into the 
I.C.S. functions, those are: “F” (Finance), “L” (Logistics), “O” (Operations), “P” (Plans), “M” 
(Other-Support Costs) 
 
Cost Group A: This value is used in the cost apportionment reports to break down costs into 
“A” (Aircraft), “E” (Equipment) and “O” (Support-Overhead). 
 
Cost Group B: This value is used in the cost specific apportionment reports to break down 
costs in greater detail than the COST APP group. Categories are “A” (Fixed Wing and 
Retardant), “C” (Crews), “E” (Engines), “H” (Helicopters), “Q” (Other Equipment), and “S” 
(Support - Overhead). 
 
Report Z1: In ICARS, there has been an additional fields left blank for each kind. This will 
allow you to group ICARS kinds into any grouping you wish for reporting purposes. 
 

 
AGENCIES 

 
Agency                         
              
The Agency table stores the 
information about every 
agency used by ICARS. For 
each Agency listed there is 
an abbreviation and 
description If you wish to 
group all Federal Agencies, 
you may choose FED. At 
any time, you may add an 
agency to the AGENCY 
table.  
Below are brief descriptions 
of each field found in the 
Agency table. 
 
Agency: This value is the 
Agency the resource                 IMAGE 5-11  ICARS Agency Table Screen   
belongs to (ie) FS, BIA, NPS, or PVT. All contract equipment should use the “PVT” Agency 
value. The values in the Agency field are the values seen when looking up an Agency from the 
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Resource Table. 
  

Agency Group: This value is Federal, State, or Other. 
 
Rate Group: This value of the Rate grouping that particular Agency falls under. (IE) Federal, 
State, County, Contract, etc.  Used for determining the default rate in the Rates Table. 
 
Contracting:  A “Y” in this field allows you to use that agency in the Resource table to identify 
the agency that has contracted and will pay for the resource. 
 
Description: This value is a description of the Agency 

 
Agency Groups 
Agency group table is strictly a look-up table and only has 6 values in it. (Federal, State, 
County, City, Private and Other) 
 

 
HOME UNIT 

IMAGE 5-12  Home Unit Table  
The values found in this table are "sub" 
agency codes. With the example of the 
Forest Service these values would be 
Forests.  The Local box can be checked to 
identify a local resource, which when used 
in the Resource table will allow the 
tracking and reporting of local resources. 
 

 
NVC  
This section of ICARS will estimate Net 
Value Change (NVC) which is derived 
from the number of acres burned, the Fire 
Intensity Level (FIL) of the acres burned and the NVC categories affected.  This area involves 
three tables, NVC categories, NVC values by FIL and acres burned.  Acres burned has been 
defined, so below are NVC categories and NVC by FIL. 
 

 
NVC Categories                                                       

IMAGE 5-13  NVC Categories Input Screen 
The values in this table are predefined upon 
installing ICARS. These are the categories that are 
often affected by Fire related incidents. Examples 
are Timber, Wildlife, Water Usage, etc. 
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NVC Values by FIL 
The values in this table represent the Cost per Acre for 
each NVC Category for each Fire Intensity Level 
(FIL). Normally as the FIL increases, the cost per acre 
increases. By default, the Cost Per Acres field has been 
left blank, as this value differs greatly from one area to 
the next. You will have to obtain these values from the 
area the incident is on. The reports for this section of 
ICARS will only report categories that have a Cost per 
Acre value in that field. 
                                                                 
                        
                                                                                          
     
 
 

IMAGE 5-14 NVC FIL Input Screen 
 

 
Narrative 
The Narrative file is a text document where you can create and print text documents for Unit 
Logs or other documentation purposes. 
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CHAPTER 6                        Reports 
 
This chapter discusses the different menu items or reports located under the Reports main 
menu. The Reports in ICARS are built with Crystal Reports.  There is one main menu for the 
reports.  This chapter will first review the report categories and report filters and formats. 
 

  
Available Reports 
 
There are a variety of Available reports in the reports menu as displayed in the left column of 
the screen print above.  When you select a report category the report options for that report 
will display to the right. 

 
Sort Categories 
The first set of reports is displayed by selecting the Category Sort Categories.  These reports 
are all split out by specific categories.  After you select the sort category, you can then select 
the Incident, Date Range, Specific Report and whether you want to see all occurrences, or just  
selected ones.   

IMAGE 6-1 Report Main Menu 

 
Accounting 
Reports split out by Accounting Code. 
 
Agency 
Reports split out by specific Agencies. 
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Contracting Agency 
Like the Agency report but, allows for the tracking of who pays the resource, regardless of who 
it belongs to.  
 
Division 
Using the division reports allows the user to expand the use of the division field.  It can now, 
not only be used to track costs by an actual division, but also be used as a cost center-tracking 
tool, where each division represents a cost center.   For example if you had a quick response 
base, where resources would go from incident to incident and you want to track the costs to 
each accounting code.  In this scenario each division would represent an accounting code. 
 
Home Unit 
Includes an additional feature to select a check box for local resources.  This will then display in 
your reports only the Home Units that you have selected as local in the Home Unit table (you 
did this by going to EDIT—HOME UNIT and editing the local field).  
 
Incident   
Includes an additional feature to select kind of resources you want to display in the report.  For 
example you can select Engines and then run the Weekly detail report.  This will give you a 
listing of all the engines.  The most typically run reports are the Daily and Weekly Summaries 
under Incident reports.   
 
Obligation   
The obligation module should be used for basic obligation reports.  This section may be used 
for more detail report to be used for analysis and documentation.   
 
Section   
Splits the reports out by the Incident Team sections of Operations, Logistics and Finance.   

 
Other Categories 
 
In the Other category are all other reports that are not based on a 
sorting category as described below. 
 
Acres/NVC 
Three levels of reports, from a summary level to a detail by resource 
level, to display the Net Value Change information as described in 
Chapter 5. 
 
Aircraft 
This report is used for reporting cumulative air costs for a particular incident.  It will display 
all the data entered into the AirDaily table. 
 
Cost Share 
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The Cost Apportionment reports are a series of reports that are used to show the break down 
of the incident's costs by agency involved. There are currently four reports, commonly referred 
to as CAT-1, CAT-2, CAT-3, and CAT-4 reports. CAT-1 starts our very broad and CAT-4 is 
down to the single resource per day detail. These reports are building blocks to each other. 
CAT-3 supports CAT-2, which supports CAT-1.  
 
Lookup Tables 
Ability to print all lookup tables as described in Chapter 5.  When becoming familiar with the 
data in ICARS, it is sometimes useful to print out these lookup tables as a resource. 
 
Resource Kind 
This report shows all Kinds currently on the Incident sorted by Cost. It is very useful during 
demob to identify the release of costlier resource first.  It will also display local resources as 
identified in the Home Unit table.  See the Home Unit table for a description of how to 
designate local resources. 
 
UnderUtilized 
For tracking of resources that are underutilized.  Based on the check box in the Daily table. 

 
Standard Reports Options 

 
Weekly Summary & Weekly Summary-Multi Incident 

 
This report is one of the more common reports used in ICARS and provides supporting data for 
the Cost by Date graph.  The multi incident option will show a section for each Incident. 
 
IMAGE 6-3  ICARS Weekly Summary Report 
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Daily Summary and Daily Summary-Multi Incident  
This is ICARS most popular or used report. This report is used on a daily basis to get an 
estimated cost of resource on the incident for the current day and cumulatively.  
 
IMAGE 6-4  ICARS Daily Summary Report  

 
Weekly Detail and Weekly Detail-O/H Personnel  
The same format as the Weekly Summary, except shows detail to the level of each resource.  
There are two reports in this format.  The Weekly Detail does not include line and support 
overhead personnel.  There is a separate report just for these personnel. 

 
Cumulative Cost Detail & Cumulative Cost Detail-O/H Personnel  
Lists each resource with all detail.  This will print all Resource and daily detail. 
This report is normally going to be one of ICARS longer reports. This is sometimes printed at 
the end of an incident to have hardcopy of all the resource and their costs for every. 
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IMAGE 6-5  ICARS Cumulative Cost Detail Report 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Category Total 
Across the top are the categories 
depending on the category of 
report you are running (ie: 
agencies, divisions, etc).  On the 
side are the cost categories. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Specialized Report Options 
 

 
Analysis Reports 
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There are several reports which will present analytical cost information.  These can be accessed 
through the reports screen by selecting “Other Categories” and then “Analysis” as shown in the 
image below.  Follows are descriptions of the reports and their usage. 
 
IMAGE 6-6  ICARS Analysis Reports Menu 

 
 
Resource Cost report.--There are two report options as follows: 
 
 Average Cost by Kind Exceeding Standard—This report displays the average cost of 
all major kinds of resources, like Engine, Type 3 and Dozer, Type 1, compared to a standard 
rate table. 
 
 Individual Costs by Resource Exceed Max Rate—This report displays individual 
resources that exceed the maximum rate contained in a standard rate table. 
 
Accountability Report—This report displays a number of ratios and comparable costs.  An 
example of the report follows the description and uses of the contents below: 
 
 Percentages breakdown of resources—The Upper section of the report shows how 
the fire breaks out cost wise with percentages for each type of resource (Aircraft, Crews and 
Direct Equipment)  and for total Support and Direct costs. 
 



 40 

 Support cost per person—The middle section of the report displays the support costs 
per person.  These costs are broken down into the support cost categories.   
 
  Ratio of support costs to direct costs—This is an indicator of the level of support 
costs.  The standard is set at 47% meaning that support costs and direct costs are typically 
about equal.  As support costs rise above this level it is an indicator that support costs are to 
high and should be evaluated for cost savings. 
 Ratio of support personnel to direct personnel--The standard is set at 35% meaning 
that approximately 1 out of every 3 persons on a fire are considered support personnel.  As the 
percentage increases it may indicate that the fire is overstaffed with support personnel. 
 
 Total Support Cost Per Direct Person—This cost can be used when sharing costs 
with other cooperators like the State Fire Marshal protecting structures, that are being 
supported out of the fire camp.  This support cost includes all support services and equipment 
as well as all support personnel (Incident Team Members, etc)  
 
 Cost Per Acre—This report will only display cost per acre if the acres burned are 
entered into the acres burned table, which is found under the Edit tab on the main menu.  A 
weighted average cost per acre burned is being discussed, but until that is developed, keep in 
mind that the cost per acre is not always a relevant comparable, due to factors such as urban 
interface and timber type and values at risk. 
 
IMAGE 6-7  ICARS Aircraft Cumulative Summary Report 
 

 

 
 
 
Exception Report—The exception report aids the Cost Unit Leader in determining if there 
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are costs in the database that are not accurate.  The user can determine which options to 
include in the report by clicking on the options button on shown on the reporting screen below. 
 If the user clicks all the options, then the resulting report will include all options.  The options 
can be used as follows: 
 
 Resource Status is D, But no Release Date Entered—Costs will continue to accrue 
on a resource until it has a release date.  But if a resource status is D, it indicates that the 
resource was release, but a release date was never entered.  Check these resources out with 
plans and/or time to determine if they have been release and have plans either change the 
status or remove enter a release date. 
 
 Resources With No Actual Time Posted—Most resources will have time posted to 
them in ITS.  This will include all personnel and contracts.  This report will display all 
resources with no actual time posted and tell you how many days of unposted time there are.  
This can be an indicator of duplicate resources or resources that never checked in.  In both 
these cases the resources are accruing costs and should be deleted from the database.  Some 
resources will never have actual time posted, like supplies, caterer, etc. 
 
 Resource Daily Cost Exceeds $x,xxx—This report will show resources with costs 
over a user defined limit.  The default is $10,000 but that limit can be changed.  The purpose of 
this report is to analyze high value cost items.  This could identify errors in your data, where 
maybe you have a daily cost with an hourly rate, but it can also identify items that may be 
worth more analysis, due to the expense of the item. 
 
 Resource with Actual time posting but x or more days of unposted time—
Sometimes resources will leave the incident, but either they never check out or the release date 
never gets entered.  This report will display those resources that we know have checked in, 
because there is actual time posted, but have multiple days with no posting along with the 
number of unposted days.  The user can define how many days of non-posting it takes to get on 
the report.  This report may also be of use to the time unit for identifying resources that are not 
turning in their time.   
 
There is an additional feature on the main ICARS menu under Utilities and Tools to remove all 
estimates from time postings.  This feature will change all estimates to zero.  Of course when 
you re-run the create daily routine estimates will again flow down to all days following the last 
actual posting.  However this is a good tool to remove estimates in the middle of a person or 
contracts time as those estimates will not be re-generated with create daily.  So for instance a 
resource might have actual posted time from 6/1 to 6/5.   But then leaves the incident and has 
no time posted from 6/6 to 6/10.  The resource comes back and has time from 6/11 on.  
Currently ICARS will include estimates for 6/6 to 6/10 based on whatever time was posted on 
6/5.  You can manually change the hours for those days to 0, or you could run this routine 
which would do it for you. 
 
 
 
IMAGE 6-8  ICARS Aircraft Cumulative Summary Report 
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Aircraft Cumulative Detail 
 
IMAGE 6-9  ICARS Aircraft Cumulative Summary Report 
 

 
 

 
Resource Kind By Cost 
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IMAGE 6-10  ICARS Resource Kind By Cost Report 

 
 

Cost Share Summary (CAT-1) 
This report is broken down by the Cost Apportionment Type (Aircraft, Crews & Equipment, 
and Support & Overhead) and then by Day and Shift 
 
IMAGE 6-11  ICARS Cost Share Summary Report (CAT-1) 

 
 

Cost Share By Shift and Kind (CAT-2)  
This report supports the numbers found in the CAT-1 report.  This report is once again 
grouped by Cost Apportionment Type, Day and Shift, and then by Kind Type. 
 
IMAGE 6-12  ICARS Cost Share By Shift and Kind (CAT-2) 
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Cost Resource Worksheet (CAT-3)  
This report supports the numbers found in the Cost Share or CAT-2 report.  This report is 
once again grouped by Cost Apportionment Type, Day and Shift, Kind Type, and then by 
individual resources. 
 
IMAGE 6-13  ICARS Cost Share Resource Worksheet Report (CAT-3) 

 
Cost Share Detail Report (CAT-4)  
This report is the last of the Cost Apportionment reports within ICARS. This report reports 
the Cost share amounts at their lowest level. This report is slightly different from the first 
three CAT reports, in that it is not grouped by any of the fields. This report is simply sorted by 
Kind Code and then by Day.  This one doesn't support the CAT-3 report like the other CAT 
reports have, though it is the same data, just presented differently. 
 
IMAGE 6-14  ICARS Cost Share Resource Worksheet Report (CAT-4) 
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Other Reports (Currently disabled) 
 
Another feature within the Reports section is the ability to run additional reports that might 
have been added since the release of the ICARS application. This feature is executed from the 
"Other Reports" option in conjunction with "Utilities | Edit Graph/Report Query.  You must 
first add the new report through the 
Utilities menu before you can run the 
report from the Other Report Menu 
option.  Because ICARS allows you to 
rename, save as, and run multiple 
ICARS databases, running ad-hoc 
ICARS reports requires you tell 
ICARS the query name and the SQL 
statement that you wish to have run.  
The query you are entering is the 
query the new Crystal Report needs 
in order to run. Press "New" enter 
the query name and the SQL 
statement for that query and press 
"Save" 

IMAGE 6-15  ICARS Edit Graph / Report Query Screen 
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CHAPTER 7                     Graphs 
 
There are a variety of graphical presentations that are pre-designed including Pie, Area and 
Stacked Bar graphs.  The two most common graphs are the Total Cost and the Cost to date.  
These graphs are typically run on a daily basis.  There are also graphs when tracking costs by 
division to display the splits between divisions.  Aircraft graphs are discussed under the 
Aircraft Analysis, Chapter 11.  
 

 
Graph Setup and Printing 

IMAGE 7-1  Graph Main Menu 
This chapter deals with the different menu choices located 
under the Graph menu of ICARS. The graph section of 
ICARS uses a third-party graph control, so the limitations 
to ICARS graphs are the limitations of this third-party 
control.  
 
After selecting a graph you can customize the graph prior 
to printing.  There are several ways to do this.  The easiest 
is to select the options button at the bottom of the screen to adjust the fonts and labels.  
IMAGE 7-2 Graph Print Options 

 
 
 
 
 
 
 
 

 
Then select the print button at the bottom of the 
screen, where you can set the rest of the print layout. 

IMAGE 7-3 Graph Print 
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IMAGE 7-4  Graph Control Button Bar 

If you wish to do more complex editing of the graph, anytime a graph is presented to the 
screen, you will see the graph control button bar across the top. From there you can modify 
many aspects of your graph.  The question mark button will activate the graph control helps 
file, where you can get detailed information about each tab and option on the graph control. 

 
IMAGE 7-5 Graph Control Properties 
The options now available in ICARS 
graphs are quite extensive. You can 
get to the graph control by selecting 
any of the buttons on the button bar.  
 
The graph control (seen to the left) has 
many tabs with options to many to 
name here.  Some of the main tabs are: 
"System", "Titles", "Fonts", "Style", 
"Background", "Markers" and “Data”. 
 
One nice feature is the graph template. 
You may make customized settings for 
a particular graph and then use those 
each time that graph is used. Again, 
using these new features may take 
some time in learning all of its 
functionality. 
 
Please use the Graphics Control Help 
file for further information about the 
graphics control and it’s features. 
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CHAPTER 8                  Projections 
 

IMAGE 8-1  Projection Main Menu 
Selecting the Projection menu option will bring up the three-grid 
projection module screen seen below in Image 8-2.  This section is for 
projecting costs for future dates of the incident. There are actually 
two methods of accomplishing this. One is by using this projection module and the other is to 
set your computers system date ahead and let the daily records be created and then edit those 
daily records to reflect what is predicted for those future days.  
IMAGE 8-2  Projection Screen 
 

 
 

 
Setting Up the Projection 
 
To create a projection, go to the first of the three grids and select an Incident value from the 
Incident Field Combo-box. Only current Incidents will be available to choose from. The 
program will then enter a Start Date for the projection to begin of the next day.  This is 
because today's costs are already accounted for in the Resource and Daily tables, so usually you 
want your projection to begin the next day. The third field is the number of days you wish to 
project out. In the last field of the top grid, you can name the projection. You may create an 
unlimited number of projections.  After you have successfully entered in information into the 
upper grid you should see the second and third grids fill up with information.  
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The second grid works from the first grid and will have the sum of all "Direct" Kind types that 
are currently on the Incident today, their quantity, average cost, the total cost, and the total 
number of people on the incident for those direct resources. The values found in the second grid 
are values that are generated when the projection in the header record is first created.  The 
average cost field can be edited, if you feel that the average cost created by the program is not 
accurate for future days. 
 
Similar to the second grid, the third grid works off the record that is highlighted in the second 
grid. The third grid is where users change the quantity of resources for that resource kind for 
future days. The fields found in the third grid are:  Date, Quantity, and People. Of those three 
fields only the quantity field can be edited. As the quantity number increases or decreases, so 
should the number for people. These two fields have a direct correlation.  
A flow down feature has been added to the quantity field so as you change the quantity for a 
given day, all future days will change to that same quantity.  This should save significant time 
when editing projections for many days. 

 
Reports & Graphs  

IMAGE 8-2  Projection Screen 
A variety of Graphs and Reports that mimic the other basic 
reports in ICARS are available for projections. 
 
 
 
 
 
 

 
Support Cost Calculation 
 
Support costs are generated in a pre-determined method and users have very little control over 
projected support costs. If you need greater control over projected support costs, it is 
recommended that you do projections the second method which is to set your computer's 
system date to a date in the future and then adjust the Daily table to reflect what future 
resources will be charging to the incident. 
 
The algorithm that is used to generate support costs for a particular projection is to: 
1. Sum up all "In-direct" costs for the current day.  That number is used as a maximum 

number or 100% of the support cost pie. 
2. All the people are then added up for all the "Direct" resources.  
3. A per person support cost is then generated by the amount in number 1 divided by the 

amount from number 2. This will be a support cost dollar amount per direct person on the 
incident. 

4. The total support cost for any particular day is derived by the number of people still left on 
the incident multiplied by the amount in number 3 (per person cost).  

 
As the number of direct resources decreases, so will the number of people. When the number of 
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people decreases the amount of support costs will also decrease in direct proportion to the 
number of direct resource people still left on the incident. 
 
You will not see any support costs in the 3 tiered projection grid. The only place you will see 
the support costs for a projection will be in the projection reports.  

 
Updating Projections 
 
Once a projection is completed you can now come back to that projected days or weeks later 
and update the projections with new information.  There is a button at the bottom of the 

projection screen.      When this button is clicked the 
following actions will automatically take place.  You will be asked to update the projection 
days, meaning how many days you want to project?  Then the program will automatically 
change the start date of the projection to tomorrow, cut off all days prior to tomorrow and 
project out for as many days as you tell it.  For days that you previously projected, the 
quantities that you entered in the projection will remain.  So lets say you did a projection for 
6/1 to 6/10 and indicated that you had 5 dozers from 6/1 to 6/5 and 2 dozers from 6/6 to 
6/10.  If on 6/3 you updated the projection, and said you wanted it to go 10 days, the 
projection would now show 5 dozers from 6/4 to 6/5, 2 dozers from 6/6 to 6/13. 
 
You can come back and update a projection as many times as you want, or if your assumptions 
totally change, you can just start over with a totally new projection at any time. 
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CHAPTER 9                   Obligations 
 

 
Obligation Basics 
 
The obligations module in ICARS, which is accessed from the main menu, is set up to track 
obligations and creates reports that can be sent to the home unit for daily obligation reporting. 
 The basis of the module is the auto filling of the obligation field in the Resources table.  This 
takes no direct input from the user as the values automatically populate this field based on the 
Request #, Agency, Kind, Incident State, Contracting Agency and AD identifier (FedCode in 
ITS).  The values entered by the application can be overwritten by the user, however when any 
of the above information is changed in I-Suite.  The application is designed to re-evaluate the 
obligation field to determine if it needs to be changed, and then change it accordingly. 
 
As data is changed that affects the obligation category or the accounting code, the obligation 
module is designed to track those changes.  Daily there is a change amount tracked, which is 
the daily change.  If a resource category or the accounting code used for the resource, changes, 
the change amount will adjust up or down to reflect this. 
 
Since the obligation field auto populates, it is critical that the fields mentioned above are 
accurate.  If they are not, the obligation field may be populated incorrectly.  Thus verify for 
each resource being tracked that the following information is correct: 
 

1. The Agency field is accurately entered based on who will pay the resource 
a. Paid by a Forest Service EERA Agency=PVT.   
b. Paid by a state government     Agency=two letter state identifier. 
c. Paid by a govt agency-exc. EERA’s Agency= The Govt agency 
d. Aircraft paid by OAS   Agency=OAS 
e. National Weather Service Personnel Agency=NWS 

2. AD Crews paid by other federal or state agencies must show an agency of the federal 
agency or state.  Only show the agency as FS if the Forest Service will process the AD 
payment at the EFF Payment Center. 

3. Time is being posted to ITS on a current basis (within 72 hours of the completion of a 
shift). 

4. Accurate Check In and Release dates are being entered and Release dates are entered 
within 24 hours of the resource demobilization.  

5. The incident state is accurately entered in the Incident table as the two letter state 
identifier (i.e. OR, WA, CA) 

6. Local Aircraft and National contracts have the correct Obligation category identified. 
7. For state resources, that will be paid by the state, confirm that accurate rates are being 

used. 
8. The Kind field is accurately entered. 
9. There is an accounting code for each daily record. 
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Obligation Categories 
 
Extract data is captured into 8 categories, by accounting code.  The eight categories are: 

1. CONT—EERA’s  and National Contracts-(Excluding Aircraft) 
2. HELI—Helicopters (Local and National)—exclude OAS 
3. AD—Casual Hires 
4. STL—State Costs from the Incident State 
5. STO—State Costs from Other States 
6. OAS—Office of Aircraft Services (OAS) aircraft. 
7. NWS—National Weather Service Personnel 
 

Additional obligation categories that are not included in the extract are as follows: 
1. FW—Fixed Wing Aircraft (Local and National)—exclude OAS 
2. FS—All Forest service not identified elsewhere 
3. FED—All other federal agencies 
4. CACHS—All Cache supplies 
 

The application determines obligation categories using the following sequence of if statements.  
The obligation resulting categories are highlighted.  This is provided for enquiring minds 
only. 
 
If Agency =OAS     OAS 
If Agency-NWS NWS 
Else IF Agency=CITY, RUR or CNTY 
 Then If Home unit first two characters = Incident Incident State    STL 
 Then If Home unit first two characters not equal Incident Incident State STO 
Else If  Agency RateGroup=FED  

Then If Agency=FS 
Then If Kind=CACHE    CACHE 
Then If Persons FedCode=AD 

Then If ContratorPost Amt =0    AD   
Else   ADMIX   

Else    FED 
Else If Agency RateGroup=ST  
 Then IF Agency=Incident IncidentState    STL 
 Else   STO 
Else If Agency=PVT 
 Then If ContractingAgency=Incident IncidentState   STL 

Then If  RequestCat=A  
Then if Kind=HEL1, HEL2, HEL3, HEL4, HELU    HELI  
Else     FW (**retardant excluded from this number) 

Then If Persons FedCode=AD   ADMIX  (split in the extract routine) 
Else     CONT 

Else Leave blank 
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Daily Extract 
 
IMAGE 9-1  Obligation Extract Screen 

 
Daily there is an extract that can be run to capture and summarize obligation data.  The extract  
can be run multiple times in a day.  However each day, before transmitting the information you 
must run the finalize process.  This is accomplished by clicking the Finalize button.  The result 
of this is to post a sequential number in the Finalized field and close obligation postings for that 
day.  Any future changes to the obligations will be reflected in the next days extract.  Once you 
have run the finalize process for a day, the Finalize button will be immobilized until the next 
day, thus preventing you from running the finalize process more than once a day.   
 
It is possible, for the current day only, to Re-Extract the data and finalize again.  This should 
only be done if there are significant errors, and the obligation extract has not yet been 
submitted to the Incident Unit (Forest) for input into the accounting system.  It is critical that 
the data for each sequential obligation number in the database matches what is sent to the 
incident Unit (Forest).  To do this, if you highlight the current day extract, you will notice that 
the Run Extract button changes to Reextract.  Clicking it will remove the finalized sequential 
number and allow you to finalize again.  
 

 
Obligation Extract Reports 
 
Once the extract is run there are three reports that can be viewed and printed.   The report you 
will see, will be for the extract line that you have highlighted in the Obligation Extract grid. 
The first is a summary report, for submission to the home unit.  The second is a detail report by 
specific vendor and the third is the Report Detail All, which will provide all the individual daily 
detail reports in one report file.  The detail reports should either be provided to the home unit 
daily or at the end of the incident for audit support.  If running at the end of the incident use 
the Report Detail All, instead of running the daily reports individually, as this will produce the 
same data.   
 
The summary and detail reports are displayed below.   
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IMAGE 9-2  Obligation Summary Report 

IMAGE 9-3  Obligation Detail Report 
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Chapter 10   Utilities 
 
IMAGE 10-1  Utilities Main Menu 

This chapter deals with the different menu items located under the 
Utilities main menu. Under this menu, you'll find extra ICARS 
"utilities", such as setting the computer's system clock and locking 
daily records. 
 
 
 

  
Set System Date and Time 

 
IMAGE 10-2  Date / Time 
Property Screen 
The ICARS application relies 
heavily on the computers 
system date. It is important that 
you know what your computers 
date is and how to change it. 
There are other means of 
getting to this same Date / 
Time Properties window in 
Windows 95, but we chose to 
add a menu option for ICARS 
users to run it from within 
ICARS. From this window you 
can select a new date and time 
for your computer. 
 
 
 

 
LockDaily Records 

IMAGE 10-3 Daily Record Locking Screen 
There are times when you may wish to "freeze" ICARS Daily 
records for a particular period of time. This new feature in ICARS 
allows a user to do this very easily. Locking or unlocking daily 
records are as easy as picking a start date and an end date.  
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Database Tools 

 
SQL Query  
   
Using the SQL Query language you can use select statements to view the actual data in tables.  
Editing of tables is disabled from this tool.  To view the data in a table enter a select statement 
into the sql query box like the following: 
 
Select * from resources 
 
IMAGE 10-4 SQL Query Screen 
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CHAPTER 11            SORTING & FILTERING 
 

Sorting 
 

Sort Description 
 

The sort function allows the user to display the data in descending or ascending order.  
The user sets the order of display by selecting column headings in a specific order.  The 
Sort tab includes a Columns lists, a Sort lists, and several buttons, that will be identified 
in this section. 
 
IMAGE 11-1 Sort Screen 
 
 

 
 

 
 
 
 
 
 
 

Figure 1 – Sort Tab View 

 

 

 

 

 

 
Sort Tab Basics 

Lists in the Sort tab 
Within the Sort tab are two lists labeled Columns & Sort.   The Columns list contains the 
heading of each column on the grid.  The Sort list contains the ordered heading titles 
transferred from the Columns list. 

 
Moving the cursor inside a list 

To move the cursor inside the Columns or Sort box, use the       button to move the 
cursor up-wards or the       button to move the cursor down-wards.   
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Moving a selected heading within a list 

To move a heading within a list, select the heading and hold the Ctrl key while moving 
the cursor.  The heading will move with the cursor movement.  At the desired position 
let go of the Ctrl key and the heading will no longer move with the cursor. 

 
Choosing Ascending or Descending order 

Both buttons transfer the selected heading from the Columns lists to the Sort list but the 
way the information is listed varies according to the selected button.   To choose 
ascending order, select the Asc button.  To choose descending order, select the Desc 
button.  

 
Ascended headings will be listed from first to last alphabetically (A-Z).  The information 
within each heading may also be listed from first to last alphabetically or numerically 
smallest to largest, when there is no conflict with the heading order.   

 
Descended headings will be listed from last to first alphabetically.  The information 
within each heading may also be listed from last to first alphabetically or numerically 
largest to smallest, when there is no conflict with the heading order.   

 
Moving a heading from the Sort list to the Columns list 

To move a heading from the Sort list to the Columns list, select a heading from the Sort 
list.  Select the        button.  The selected heading will appear in the Columns list. 

 
Sorting headings 

Select the desired heading in the Columns list and choose ascending or 
descending order. The selected heading will appear in the Sort list. Multiple 
headings can be selected by repeating above steps.  Select the OK button at the 
bottom of the dialog box and the data will be displayed sort order chosen. 

 
 

Filter 
 

Filter Description 
The filter function allows the user to display data according to specified criteria.  The 
user specifies the criteria by using one or more of the filtering options. The Filter tab 
includes a Column dropdown list, a Filter Type dropdown list, two Specifications boxes, 
and a Filter Display box.   The Filter tab also includes several buttons that will be 
identified in this section,  
See Figure 11-2. 
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IMAGE 11-2 Filter Tab Screen 

 

 
 

Filter Tab Basics 
 
Choosing a column 

The first dropdown list at the top right of the Filter tab is the Column list.  When the 
drop arrow at the right of the box is selected, all the available column titles appear.  
While still holding the mouse button, move the cursor to the desired column title.  
Release the mouse button to select the desired column title.  This column will now be 
the primary column in the filter.  The column titles may vary with each display grid 
selected and filter. 

 
Choosing a filter type 

The second dropdown list box at the top of the Filter tab lists the filter types when the 
drop arrow at the right of the box is selected.  While still holding the mouse button, 
move the cursor to the desired filter type.  Release the mouse button to select the filter 
type.  The filter type options are: =, >, >=, <, <=, <>, LIKE, and BETWEEN.  The 
selected filter type will now be the primary method of filtering.  The filter types will 
remain the same with every display gird but may change with each filter. For specific 
filter type information, see Figure 3.   
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SPECIFIC FILTER TYPE INFORMATION 
 

SYMBOL HOW SYMBOL WORKS 
SPECIAL 
INFORMATION 

= Signifies the filter results will be 
an exact match to the 
specification. Case sensitive. 

Can be used with words 
or numbers 

> Signifies the filter results will be 
greater than the specification 

Use only with numbers 

>= Signifies the filter results will be 
greater than or equal to the 
specification 

Use only with numbers 

< Signifies the filter results will be 
less than the specification 

Use only with numbers 

<= Signifies the filter results will be 
less than or equal to the 
specification 

Use only with numbers 

<> Signifies the filter results will 
exclude only the specification 

Use only with numbers 

LIKE Signifies the filter results will be 
similar to the specification 

Can be used with words, 
numbers or % (wilcard) 

BETWEEN Signifies the filter results will be 
between two specifications 

Use only with numbers 

Figure 3 
 
 
Choosing filter specifications  

The two parallel boxes towards the left of the Filter tab are for the Filter Specifications. 
 The specific filter information is inputted into these boxes.  This information may be 
words, numbers, or a combination of both.  To input this information, select the top box 
and type the specifications in the box.  The second box may only be used with the 
BETWEEN filter type.   

 
Viewing the Filter 

The large box in the middle of the Filter tab shows the current Filters to be applied to 
the display grid.  All the current filters will be applied to the data. 
 

 
Filtering Information 

Creating a Filter 
By selecting the Add Filter, the And into Filter, and/or the Or Into Filter button, the 
information input into the Column, Filter Type, and Filter Specifications boxes is displayed 
in the Filter Display box.  Select the OK button to apply the filter to the data.   
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Using the Add Filter 

The Add Filter button should be chosen when adding the first filter to the Filter Display box 
but can be used for any and all additional filters. 

Using the And Into Filter 
The And Into Filter button can be used for any filter after the first filter is added.  The 
“And” signifies that in addition to the first filter specification, this filter specification 
must be met as well.  This filter will only show data that meets both specifications. 

 
Using the Or Into Filter 

The Or Into Filter button can be used for any filter after the first filter is added.  The 
“Or” signifies that this filter specification can be substituted for the first filter 
specification.  The filter will show all the data that fits either filter specifications. 

 
Grouping Multiple Filters 

The Add[ and Add] buttons allow brackets to be placed around a group of filter 
specifications within the Filter Display box.  Placing brackets around a group will 
separate that group from any other filter specifications. 

 
Examples 
[Kind] =  ‘DOZ’ 
AND  [Rate Type]  = ‘DAY’ 
 
Select only the data where the Kind Code is equal to DOZ and the Rate Type Code is equal to 
DAY 
 
[Kind] Like  ‘DOZ%’ 
 
Select only the data where the Kind Code starts with DOZ  

 
Clearing, Deleting and Saving 

 
Clearing information 

To clear the sort information, select the Clear Sort button at the bottom of the dialog box.  
New information can be sorted now.   This button will clear the information even if the Filter 
tab is selected. To clear the filter specifications, select the Clear Filter button at the bottom of 
the dialog box.  New information can be filtered now.   This button will clear the information 
even if the Sort tab is selected. 
 
Cancel  

To cancel the sort or filter modifications select the Cancel button at the bottom of the dialog 
box.  The sort/filter screen will disappear and the original screen where the sort/filer button 
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was selected with no changes to the data displayed. 
 
Saving information 

To save and apply the current sort/filter select the Ok button at the bottom of the dialog box.  
The display grid on the original screen where the sort/filter button was selected will not be 
refreshed with the selected sort and filters applied.   
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CHAPTER 12            AIRCRAFT ANALYSIS 
 
The aircraft analysis function in ICARS allows you to compare different types of aircraft.  You 
can look at the aircraft summarized by kind or by individual aircraft.  The analysis tool is based 
on graphical presentation.  The following types of graphical presentations can be used: 
 

1. Cost per gallon of retardant/water dropped. 
2. Total Gallons dropped and gallons dropped per hour.  
3. Total flight hours and flight cost. 

 
Aircraft analysis involves the following functions: 

 
1. You must be receiving the daily aircraft information sheets from air operations.  If you 

are not receiving this information it should be available if requested.   When you get the 
air information review it for reasonableness and completeness.  Enter each individual 
aircraft into the Resource table. 

2. Fill out the AirDaily table as described below.   
3. Run the graphs which are provided under the GRAPH item on the main menu. The 

AIRDAILY table is like the DAILY table except it is used for Aircraft records.  There 
are two views of the AIRDAILY table.  One is for entering daily information on 
Airtankers and the other for Helicopters.  The information you enter into these tables 
determines what the aircraft graphs display so there are some specific ways you need to 
enter the data in these tables.    

 
Some analysis tips to be aware of: 
 

1. For the analysis to be useful and accurate it is sometimes necessary so split helicopter 
flight hours and costs between water/retardant drops and other assignments.  This is 
only necessary if the helicopter is doing a mix of activities. 

2. There are typically mobilization and demobilization costs associated with ferrying 
(flight time) an aircraft to the fire.  These costs can be ignored, included in the first day 
of costs or allocated based on the expected days that the aircraft will be assigned.  How 
you deal with these costs will affect the outcome of your analysis.  If you are doing a 
post analysis, after the fact, or need additional aircraft and are trying to decide what 
type of aircraft you are going to order then I would allocate the costs.  If you are doing 
a use analysis to see which type of aircraft is the most cost effective, once it is there, I 
would exclude the ferry costs because they are really irrelevant to a day to day decision. 
                     

 
 
 
 
 
 
 
IMAGE 12-1a  ICARS Resource Input Screen for Helicopter with Display Daily On 
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IMAGE 12-1a  ICARS Resource Input Screen for Airtanker with Display Daily On 

 
 
The fields in the helicopter and airtanker view of AIRDAILY are: 
 
Incident, Division and Shift:  The use of these fields is consistent with the DAILY table. 
 
Retardant $:  If you are dropping retardant you can show the cost here. 
 
Water/Ret Flt $ and Water/Ret Hrs: Use these fields to enter Flight dollars and 
hours associated with dropping water or retardant.  For helicopters, if the helicopter is also 
doing other things like moving equipment or people.  Then the flight costs and hours for those 
activities should be included in the other fields (see next field). 
 
Other Flt $ and Other Hrs: For use with helicopters only.  Use these fields for flight 
dollars and hours associated with activities other than dropping water or retardant.  If an 
aircraft is dropping water/retardant as well as other activities, it will be necessary to have air 
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ops split the time between the activities.  If air ops can’t do this then treat all the flight time and 
hours as other.  This is because the analysis graphs will include all aircraft $ and hours shown.  
If you do not have accurate dollars and hours you do not want to include these aircraft in your 
analysis.  In the above example, for helicopters the first day was split between activities, 
whereas the second day was all water and the third day was all passengers and cargo. 
 
Total $ and Total Hrs: Calculated fields. 
 
Num Trips, Num Passengers and Num Lbs Cargo:  These fields, for helicopters 
only, are not used in the air graphs but do show on the air report.  They are mainly 
informational. 
 
Gal Water and Gal Ret:  Enter the actual gallons dropped.  If the aircraft was involved in 
multiple activities and you were unable to get a split from air ops on how much time was spent 
dropping water/ret then leave the gallons fields blank.  Only lines with gallons on them will be 
included in the aircraft analysis graphs, so leaving the gallons blank will have the effect of 
removing that line from the analysis. 
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Chapter 13                    I-SUITE 
 
ICARS is distributed as a part of the I-Suite of applications.  Most Computer Technical 
Specialists should be able to set up incident networks that will allow ICARS users to be 
networked into the I-Suite application. I-Suite includes the Incident Resource Status System 
(IRSS), Incident Action Plan (IAP) and the Incident Time System (ITS).  What does this mean to 
you? 

 
Data Sharing 
 
When ICARS is being used in a network environment with I-Suite you will need to 
clearly establish working guidelines with the other users of the database.  These guidelines will 
include:  
  1.  How to update the data,  
  2.  Who is authorized to make what changes,  
  3.  When will backups occur.    
  

Data & Data Standards 
 
Data entered into I-Suite will come for the most part from the check in sheets.  Most resources 
will be entered so you will have a line for every overhead person, pickup, bus, etc.  While this 
does simplify your data entry, you will have a database that looks different than you might build 
yourself.  You may have 400 lines of overhead personnel instead of two summarized lines for 
Support and Direct overhead.   
 
To reflect total costs in ICARS the data that comes in from IRSS will have to be supplemented.  
All resources will initially either reflect the estimated costs from the Rates table or will show a 
zero costs.  Where the costs are zero, like for all aircraft, you will have to get and enter a cost.  
Where an estimate is being shown, you will have to assess the reasonableness of that estimate 
and change it if necessary, to an actual cost or a better estimate.   IRSS will bring in all direct 
firefighting resources and all personnel, but may not include the following resources or cost 
areas: 
 

1. Mobilization/Demobilization travel costs. 
2. Supplies, both from the cache and buying team. 
3. Some support equipment and services trash collection, caterer, telephones, cell phones, 

copier, land use, etc. 
4. Some, or all, Aircraft. 
5. Off incident costs, like expanded dispatch and buying team personnel. 
6. Actual costs for all contract equipment. 
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Data Manipulation 
 
There are a variety of data standards to be aware of when changing data.  Samples of these are 
listed below. 
 

1. Before deleting a record, make sure that it is ok with all users.  One application may 
have additional information attached to that record like manifests, or daily cost records. 

2. A new feature, added in 2002, is the handling of strike teams.   A strike team will be 
entered in IRSS as a Parent record (the strike team name) with various children 
records(individual crews or engines).  The parent record will show in ICARS, but you 
will not be able to add costs to it.  The costs will show with the individual children 
records.  This process allows strike teams to be built and dismantled.  All the daily 
records will be maintained with the strike team element.  

3. Adding Kinds to the kind table.  Make sure all ICARS fields are completed if someone 
else adds the Kind and make sure to notify other partners if you are adding the kind. 

4. Check in and Release dates.  If resources are mobilizing prior to the check in date 
either include additional costs in the cost of mobilization or move the check in date back 
to the order date.  Use the same methodology for demobilization. 

5. Make sure that when release dates are entered, that the resource actually demobs, 
because costs will stop accruing based on the release date. 

6. If the Agency, Kind and Check in Date fields are not filled out, no daily costs will be 
created for resources. 

7. Changing the check in date will delete ICARS daily cost records if changed to a more 
current date.  Thus if a resource checks in, is released, and then comes back…either 
check it in twice, or leave the original check in date.  DO NOT just change the check in 
date on the original record, as you will lose all costs generated between the first and 
second check in.   
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APPENDIX A 
 

ICARS Individual Table Structures 
 
Table: AccountingCodes  
 
Columns 
 Name Type      Size 
 AccountingID Number (Long) 4 
 IncidentID Number (Long) 4 
 AccountingCode Text 20 
 AgencyCode Text 4 
  
Table: Acres  
 
Columns 
 Name Type      Size 
 AcresID Number (Long) 4 
 IncidentID Number (Long) 4 
 AcresDate Date/Time 8 
 NVCID Number (Long) 4 
 Acres Number (Double) 8 
 Fuel Type    
 Potential    
 Haines Index    
 Res Value 
 
Table: L_Agency  
 
Columns 
 Name Type      Size 
 AgencyCode Text 4 
 AgencyGroupID Number (Long) 4 
 RateGroupID Number (Long) 4 
 Agency Desc Text 35 
 Contracting Y/N 1  

 
Table: L_AgencyGroup  
 
Columns 
 Name Type      Size 
 AgencyGroupID Number (Long) 4 
 AgencyGroupCode Text 1 
 Description Text 40 

Table: AirDay  
 
Columns 
 Name Type      Size 
 AirDayID Number (Long) 4 
 ResourceID Number (Long) 4 
 DivisionID Number (Long) 4 
 ShiftID Number (Long) 4 
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 AirDate Date/Time 8 
 DolTotal Number (Long) 4 
 DolRet Number (Long) 4 
 DolWater Number (Long) 4 
 DolOther Number (Long) 4 
 HrsTotal Number (Single) 4 
 HrsWater Number (Single) 4 
 HrsOther Number (Single) 4 
 NumTrips Number (Long) 4 
 NumPasg Number (Long) 4 
 NumLbsCargo Number (Double) 8 
 GalRet Number (Long) 4 
 Loads Number (Long) 4 
 GalWater Number (Long) 4  
 
Table: L_Cost 
Columns 
 Name Type      Size 

 CostID Int   4
 Item nvarchar   50
 StandardValue money   8
 MaxValue money   8
 CostType nvarchar   20
 FireType nvarchar   20
 StandardDeviation money   8  
 
Table: Daily  
 
Columns 
 Name Type      Size 
 DailyID Number (Long) 4 
 ResourceID Number (Long) 4 
 DailyDate Date/Time 8 
 Quantity Number (Single) 4 
 UnitCost Number (Single) 4 
 Units Number (Single) 4 
 CostUpdateLevel Text 1 
 DivisionID Number (Long) 4 
 ShiftID Number (Long) 4 
 RateTypeID Number (Long) 4 
 UnderUtilized Number (Integer) 2 
 Locked Number (Single) 4 
 AccountingID Number(Long) 4  
  
Table: L_DailyForm  
 
Columns 
 Name Type      Size 
 DailyFormID Number (Long) 4 
 DailyFormCode Text 1 
 Description Text 20 

 
Table: Division  
 
Columns 
 Name Type      Size 
 DivisionID Number (Long) 4 
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 IncidentID Number (Long) 4 
 DivisionCode Text 1 
 ShiftID Number (Long) 4 
 DivisionDate Date/Time 8 
 FedPct Number (Integer) 2 
 StatePct Number (Integer) 2 
 OtherPct Number (Integer) 2 
 Description Text 25 
 

 

 

 
Table: Incidents  
 
Columns 
 Name Type      Size 
 IncidentID Number (Long) 4 
 IncidentNumber Text 13 
 IncidentName Text 20 
 IncidentLocation Text 15 
 Incident State Text 2                 
                 StartDate Date/Time 8  
 EndDate Date/Time 8 
  
Table: L_Kind  
 
Columns 
 Name Type      Size 
 KindCode Text 4 
 Direct Number (Integer) 2 
 DailyFormID Number (Long) 4 
 Aircraft Number (Integer) 2 
 Quantity Number (Single) 4 
 Units Number (Single) 4 
 RateTypeID Number (Long) 4 
 People Number (Long) 4 
 KindLike Number (Long) 4 
 KindGroup Number (Long) 4 
 GraphGroup Number (Long) 4 
 CAT1A Number (Long) 4 
 CAT1B Number (Long) 4 
 RptZ1 Text 5 
 KindDescription Text 25 

 
Table: L_KindGroupRpt  
 
Columns 
 Name Type      Size 
 KindLUID Number (Long) 4 
 KindRptGroup Text 20 
 GroupCode Text 3 
 KDescription Text 50 
 
Table: NextNumber  
 
Columns 



 71

 Name Type      Size 
 TableName Text 40 
 FieldName Text 25 
 Description Text 150 
  
Table: NVC  
 
Columns 
 Name Type      Size 
 NVCID Number (Long) 4 
 NVCTypeID Number (Long) 4 
 FIL Number (Integer) 2 
 NVCPerAcre Number (Single) 4 
Table: L_NVCType  
 
Columns 
 Name Type      Size 
 NVCTypeID Number (Long) 4 
 NVCTypeCode Number (Integer) 2 
 Description Text 25 
Table:  L_Oblig  
 
Columns 
 Name Type      Size 
 ObligCode Text 5 
 ObligDesc Text  40 
 SumReport Bit 1 
 RCLineNumber Text 5 
 BOC Text 4 

 Table: Projection  
 
Columns 
 Name Type      Size 
 ProjectionId Number (Long) 4 
 ProjectionGroupID Number (Long) 4 
 ProjectionDate Date/Time 8 
 KindCode Number (Long) 4 
 Quantity Number (Single) 4 
 AverageCost Number (Single) 4 
 People Number (Long) 4 
 ProjectionType Text 1 
  
Table: ProjectionGroup  
 
Columns 
 Name Type      Size 
 ProjectionGroupId Number (Long) 4 
 IncidentId Number (Long) 4 
 StartDate Date/Time 8 
 Days Number (Integer) 2 
 Description Text 30 

 
 Table: L_RateArea  
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Columns 
 Name Type      Size 
 ContAgencyGroup Text 4 
 Description Text 35 
 Status Text 4 
 
Table: L_RateGroup  
 
Columns 
 Name Type      Size 
 AreaID Number (Long) 4 
 Description Text 30 
 Status Text 4 
  
Table: L_Rates  
 
Columns 
 Name Type      Size 
 RateID Number (Long) 4 
 KindID Number (Long) 4 
 RateTypeID Number (Long) 4 
 AreaID Number (Long) 1 
 RateGroupID Number (Long) 4 
 UnitCost Number (Single) 4 
 Comment Text 50 
 UpdatedDate Date/Time 8  
 
Table: L_RateType   
 
Columns 
 Name Type      Size 
 RateTypeID Number (Long) 4 
 RateTypeCode Text 4 
 Description Text 30 
 Monetary Number (Integer) 2 
 
Table: Resource  
 
Columns 
 Name Type      Size 
 ResourceID Number (Long) 4 
 IncidentID Number (Long) 4 
 RequestNum Text 6 
 Name Text 20 
 AgencyCode Number (Long) 4 
 ContAgencyCode Number (Long) 4 
 HomeUnitCode Number (Long) 4 
 KindCode Number (Long) 4 
 ObligCode Text 5  
 AssignDate Date/Time 8 
 CheckinDate Date/Time 8 
 ReleaseDate Date/Time 8 
 Status Text 2 
 Description Text 255 
 AccountingID Number(long)  
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Table: L_Shift  
 
Columns 
 Name Type      Size 
 ShiftID Number (Long) 4 
 ShiftCode Text 1 
 Description Text 50 
 
Table: L_HomeUnit  
 
 Columns 
 Name Type      Size 
 HomeUnitCode Text 8 
 AgencyCode Number (Long) 4 
 HomeUnitDesc Text 35 
 Local Y/N 1 
 
 



Incident Resource Status System User’s Guide
The Incident Resource Status System (IRSS) is part of the I-Suite group of 
software programs. IRSS is an automated resource tracking system that 
allows you to collect and manage incident resource information. IRSS 
minimizes the time and effort you need to enter and track these resources by 
reducing the paperwork and potential for data entry errors.

IRSS provides a standardized way to check-in resources when they arrive at 
an incident. In the integrated environment, the information entered in IRSS is 
then shared with the other I-Suite programs, including:

• Incident Time Reporting System (ICARS). For tracking incident 
resource costs assigned to an incident.

• Incident Time System (ITS). For collecting and tracking incident 
resource time.

• Incident Action Plan (IAP).For producing Incident Action Plans.

Topics in this guide include the following:

• About this guide
• Getting Started
• Adding and editing an incident name and number
• Adding, editing, and deleting resources
• Working with databases, T-card labels, and Checkout Forms
• Working with Index Lists and table views
• Running and printing reports.
For information about installing IRSS, please refer to the “I-Suite 
Administrator’s Guide,” which is available for download on  
http://isuite@nwcg.gov.

About this guide
This Incident Resource Status System User’s Guide is organized into sections, 
based on the types of tasks you will commonly perform. At the beginning of 
each section you will find an overview of the topics explained. Where 
appropriate, diagrams are shown immediately following each task. Topics in 
this section include:

• Before you begin
• Conventions.

Before you begin
Before using IRSS, you must be feel confident that:

• You are familiar with your personal computer and function keys and 
understand personal computer concepts.

• You are familiar with Windows 2000, Windows XP, or Windows NT and 
can log on and log off.
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Conventions
The following conventions are used within this guide:

1 Button names, option labels, screen names, tab names, and text box 
names appear in bold, in the same case as on your keyboard or screen. For 
example, the second step might instruct you to

2 On the Tools menu, click Options.

• Topics of special interest or hints that will help you perform a specific 
task show a line before and after the text. The text appears in italic type. 
For example, the following note appears in the “Working with tables” 
section.

The percent sign (%) is a “wildcard” that allows you to perform searches 
without specifying the entire filter criteria. You can use one or more 
wildcards in any combination to locate records that match your search.

Getting Started
This section explains the basic concepts and information you need to begin 
using IRSS. Topics in this section include:

• Terms and concepts
• Security
• Logging on and logging off
• Getting help
• Understanding the stand-alone and integrated environments
• Working with tables.

Terms and concepts
This section outlines some of the screens, toolbars, and menus that you will be 
using in IRSS. If you aren’t already familiar with ROSS or have forgotten a 
few things since training, review these terms and concepts before proceeding 
with the remaining sections in this guide.

The IRSS toolbar identifies thirteen buttons that allow you to perform 
common tasks, including:

• Print. Print the current screen, form, or report.

• Edit Resource. Edit an existing record in form view.

• Add Resource. Open a blank form to add a new record.

• Demob Resource. Navigate through selected records in form view. 
Changes the status code to D for “demob” and positions the cursor on the 
Release Date field.
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• Delete Resource. Delete the selected records form the database. Prompts 
you to verify that you want to complete the delete action.

Do not delete records without first conferring with the Finance and Cost 
groups!

• Reassign Resource. Changes the status of the selected records to R for 
“reassigned.” Creates a second record and duplicates all fields except 
Incident Order Number, Request Number, and Kind/Position. Allows you 
to track resources over time with multiple assignments. The record retains 
the original Order Request Number, no matter how many times you 
reassign it.

• Add/Edit Incident. Add records to or edit records in the Incident table.

• Run Reports. Open the report module and run existing reports.

• Design Reports. Create new custom and advanced reports.

• Print Barcode. Print a barcode label for the selected record(s).

• Print T-Card Labels. Print a T-card label for the selected record(s).

• Print Checkout Form. Print a checkout form for the selected record(s).

• Refresh Data. Refresh the Table View screen.

The following diagram shows the IRSS toolbar and the toolbar buttons.
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The following buttons that display along the left-hand side of your screen 
identify the types of resources you can view:

Aircraft. Display only those resources with the “A” 
request category.

Crews. Display only those resources with the “C” 
request category.

Equipment. Display only those resources with the 
“E” request category.

Overhead. Display only those resources with the “O” 
request category.

All Resources. Display all resource categories.

All Personnel. Display an alphabetical list of all 
personnel on an incident, including names of crew 
members and personnel with equipment and aircraft 
records that have been rostered.
All Vehicles. Display a list of all vehicles that have 
been rostered and the resource they are attached to.
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The following diagram shows screen elements and screen terminology used 
throughout this guide.

Logging on and logging off
This section explains how to log on and log off of IRSS.

To log on to IRSS
1 From your Desktop, double-click the IRSS icon or click Programs from 

the Start menu, point to I-Suite, and then click IRSS.

If you have trouble logging on to IRSS, please refer to the “Handling 
installation problems,” in the “I-Suite Administrator’s Guide,” which is available 
for download on http://isuite@nwcg.gov.

To log off IRSS
• On the File menu, click Exit.
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Getting help
This section explains how to access and locate help information. There are 
three basic ways to obtain help information for IRSS:

• Access the I-Suite website. This site contains a wide array of I-Suite 
information, including software downloads, updates, and user 
documentation.

• Contact the I-Suite Helpdesk. If you are unable to answer your question 
using the I-Suite website, contact the I-Suite Helpdesk at (866) 224-7677.

• Review this Incident Time System User’s Guide. This guide is 
available in Acrobat format. To locate topics of interest, click to select the 
Bookmark of your choice. Bookmarks are listed along the left-hand side 
of the Acrobat document. When you click the Bookmark, you will 
advance to that topic within the document.

To display help information within IRSS
• On the Help menu, click Support.

The following diagram shows the I-Suite Support dialog box.

To locate help information on the I-Suite website
1 Start your Internet browser.

2 In the Address box, type http://isuite.nwcg.gov, and then press ENTER.

3 On the Welcome to I-Suite webpage, click the IRSS application icon.

4 On the IRSS webpage, click to select the topic of your choice.

To obtain a copy of this Incident Resource Status System User’s 
Guide
1 Start your Internet browser.

2 In the Address box, type http://isuite@nwcg.gov, and then press ENTER.
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3 On the Welcome to I-Suite webpage, click the IRSS application icon.

4 On the IRSS webpage, click to select IRSS User’s Guide.

5 In Acrobat Reader, save the file to your personal computer in a folder 
location of your choice.

Understanding the stand-alone and integrated environments
This section explains the difference between working in the stand-alone 
environment or the integrated environment. While you may only be using 
IRSS for your work, it is important to understand how the information you 
enter in IRSS affects other I-Suite programs.

As a team working in the integrated environment, establish guidelines and 
standard operating procedures (SOPs) that will accommodate all functional 
groups.

• Integrated environment. Using IRSS, enter resources, crews, and 
operators. This data is then shared between the Resource Planning and 
Finance groups. Maintain data standards. Changes, additions, and/or 
deletions to data affect all functional groups.

• Stand-alone environment. While data from IRSS populates other I-Suite 
programs, data ownership issues are eliminated.

Working with tables
In IRSS, resource information display in tables. Using the filtering function in 
IRSS, you can locate and display specific records or subsets of records based 
on your own criteria.

You can filter resource information by three different levels:

• Incident level. Display records associated with one incident at a time.
• Resource type level. Display records based on the resource type: 

Aircraft, Crews, Equipment, Overhead, or all records.
• Selected fields level. Display records by specific field and filter criteria.

To display all resources associated with one incident at a time
1 Click the All Resources button.

2 On the Tools menu, click Options.

3 On the Options dialog box under Manage Multiple Incidents, click As 
One.
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The following diagram shows the Options dialog box. 

The following diagram shows all resources with incidents managed as one.

To display all resources separately
1 Click the All Resources button.

2 On the Tools menu, click Options.

3 On the Options dialog box under Manage Multiple Incidents, click 
Separately.
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The following diagram shows all resources with incidents managed 
separately.

To display records based on the resource type
1 Click the resource type button of your choice

- to display aircraft, click the Aircraft button
- to display crews, click the Crews button
- to display equipment, click the Equipment button
- to display overhead, click the Overhead button.

2 On the Tools menu, click Options.

3 On the Options dialog box under Manage Multiple Incidents, perform 
one of the following

- to manage incidents as one, click As One
- to manage incidents separately, click Separately.
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The following diagram shows crew resources with incidents managed as one.

The following diagram shows crew resources with incidents managed 
separately.

To display records by specific field using a wildcard

The percent sign (%) is a “wildcard” that allows you to perform searches 
without specifying the entire filter criteria. You can use one or more wildcards 
in any combination to locate records that match your search.
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1 Click the resource type button of your choice

- to display aircraft, click the Aircraft button
- to display crews, click the Crews button
- to display equipment, click the Equipment button
- to display overhead, click the Overhead button
- to display all resources, click the All Resources button
- to display all personnel, click the All Personnel button.

2 On the filter bar, click in the box above the column title of your choice.

3 In that box, type the filter criteria of your choice and then click the Filter 
button.

For example: 
- type MA% to search for records beginning with the letters “MA” 
- type %MA to search for records ending with the letters “MA” 
- type %MA% to search for records containing any instance of the letters 

 “MA.”

The following diagram shows a sample wildcard search for personnel records 
with last names containing the letters “MA.”

To deactivate the Filter button, clear the filter criteria from the filter bar, and 
then click the Filter button again. The table will redisplay in its original form.
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Adding and editing an incident name and number
This section explains how to add an incident name and number.

To add an incident name and number
1 On the IRSS menu bar, click the Add/Edit Incident button.

2 On the Incidents dialog box, click in the first available blank row, in the 
cell to the right of the ∗

3 In the Incident Name box, type the name of the new Incident, and then 
press TAB.

4 In the Incident Number box, type the Incident Number, and then click 
the Save button.

The following diagram shows the Incidents dialog box.The arrow points to 
the first blank row where you can begin to add an incident.

To edit an incident name and number
1 On the IRSS toolbar, click the Add/Edit Incident button.

2 To change the Incident Name, click to highlight the Incident Name of 
your choice, and then type to replace the Incident Name.

3 To change the Incident Number, click to highlight the Incident Number 
of your choice, and then type to replace the Incident Number.

4 To save your changes, click the Save button.
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Adding, editing, and deleting resources
This section explains how to add and edit resources, demobilize resources, 
and delete resources. Remember these key points when working with resource 
information:

• Data is organized and presented according to the ICS-211 form.
• Before saving a resource, you must complete the following required fields

- Request Number
- Resource Name
- Configuration
- Kind/Posiiton
- Status.

• Before rostering members or adding additional qualifications, you must 
complete the mandatory fields and save the resource.

• It is better to edit an existing resource than to delete one and then add it 
back to the incident database.

• When you choose a type of resource, the data entry screen options may 
change. Be sure to look over the data entry screen.

• Once you demobilize a resource you can no longer post time to it.
• You can delete resources and/or rostered members of a resource. If there 

are any dependencies attached, IRSS displays warning messages. Be sure 
to read all these warning messages before committing to the delete 
request.

To add resources using an ICS-211 and/or optional check-in form
1 On the IRSS task bar, click the Add Resource icon.

2 On the Add Resource dialog box, complete the following information as 
required or appropriate

- Request number - Kind/Position
- Contracted - Mobilization Date
- Person - Length of Assignment
- Resource Name - Demobilization Date
- Agency - Status
- Configuration - Other (1)
- Check-in Date - Other (2)
- Check-in Time - Other (3)
- Num Personnel - Vehicle ID
- Unit ID - Release Date
- Demob City - Release Time
- Demob State - Original Order/Req Number
- Jetport - Remarks.
- Travel Method

3 Click the Save button.
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The following diagram shows the location of the Add Resource icon.

The following diagram shows the Add Resource dialog box.

Creating strike teams
This section outlines two basic examples for creating a strike team. 
Whichever method you choose, remember these key points:

• Follow the numbering structure set up by the dispatch organization that 
sent you the strike team.

• Add and designate the strike team leader last.
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The following diagram shows the basic process for creating a strike team, 
adding crews, rostering crew members, and adding a strike team leader.

To create a strike team resource - example 1
1 On the IRSS task bar, click the Add Resource icon.

2 On the Add Resource dialog box, complete the following information

- in the Request Number box, type the Request Number of the strike 
team

- click the Agency drop-down arrow, and then click to select the 
Agency of the strike team

- click the Configuration drop-down arrow, and then click to select  
S/T

- complete the Check-in Date and Check-in Time.
- in the Num Personnel box, type the total number of strike team 

members 

3 Complete the following information as required or appropriate

- Unit ID
- Demob City
- Demob State
- Jetport
- Travel Method

4 Click the Kind/Position drop-down arrow, and then click to select the 
strike team type.
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5 Complete the following information as required or appropriate

- Mobilization Date
- Lenght of Assignment (Days)
- Status
- My food
- Pet Names
- Menu Options
- Vehicle ID
- Release Date
- Release Time.

The following diagram shows a sample Add Resource dialog box for adding a 
strike team. Here, a Type 3 Engine Strike Team is created.

To add a crew to the strike team
6 Click the Add S/T, T/F Component button.

7 On the irss dialog box, click the Yes button.
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8 On the Add Strike Team, Task Force Component dialog box, complete 
the following information 

- in the Resource Name box, type the name of the crew
- click the Agency drop-down arrow, and then click to select the 

Agency of the strike team
- click the Configuration drop-down arrow, and then click to select C
- complete the Check-in Date and Check-in Time.
- in the Num Personnel box, type the total number of crew team 

members 

9 Complete the following information as required or appropriate

- Unit ID
- Demob City
- Demob State
- Jetport
- Travel Method

10 Click the Kind/Position drop-down arrow, and then click to select the 
crew type for the strike team.

11 Complete the following information as required or appropriate

- Mobilization Date
- Lenght of Assignment (Days)
- Status
- My food
- Pet Names
- Menu Options
- Vehicle ID
- Release Date
- Release Time.

The following diagram shows the irss dialog box.
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The following diagram shows a completed Add Strike Team, Task Force 
Component dialog box. Here, a Type 3 engine crew of 4 members is being 
added. 

To roster crew team members on the strike team
12 Click the Roster button.

13 On the irss dialog box, click the Yes button.

14 In the Roster section of the Add Strike Team, Task Force Component 
screen, complete the following boxes, pressing TAB after each entry

- Request Num
- Leader
- Last name
- First Name
- Kind
- Status.

After adding the last crew member, be sure to press TAB to advance the 
cursor to the next available blank row. Otherwise, you will not save that 
last entry!

15 When finished rostering that crew, click the Add S/T, T/F Component 
button.
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16 Add additional crews and crew members to the strike team as appropriate.

The following diagram shows the irss dialog box for saving the crew before 
rostering members. 

The following diagram shows a completed Roster for a strike team crew. 
Here, a Type 3 engine crew of 4 members is added.

To add the strike team leader
17 On the Add Strike Team, Task Force Component dialog box, complete 

the following information 

- click to select the Person check box
- in the Last Name box, type the Last Name of the strike team leader
- in the First Name box, type the First Name of the strike team leader
- click the Agency drop-down arrow, and then click to select the 

Agency of the strike team
- click the Configuration drop-down arrow, and then click to select C
- complete the Check-in Date and Check-in Time.
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18 Complete the following information as required or appropriate

- Unit ID
- Demob City
- Demob State
- Jetport
- Travel Method

19 Click the Kind/Position drop-down arrow, and then click to select STEN 
to designate the strike team leader.

20 Complete the following information as required or appropriate

- Mobilization Date
- Lenght of Assignment (Days)
- Status
- My food
- Pet Names
- Menu Options
- Vehicle ID
- Release Date
- Release Time.

21 When finished adding all strike team crews, crew members, and the strike 
team leader, click the Save button.

22 On the irss dialog box, click Yes.
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The following diagram shows the strike team leader being added to the strike 
team. 

The following diagram shows the irss dialog box. Here, you can click Yes to 
finished or click No to continue adding additional strike team components. 

To create a strike team resource - example 2
1 On the IRSS task bar, click the Add Resource icon.

2 Complete the Add Resource dialog box as appropriate, and then click the 
Save button.

3 On the Edit menu, click Strike Teams/Task Forces.

4 On the Edit Strike Team/Task Forces dialog box, click the Select a 
Strike Team or Task Force drop-down arrow, and then click to select the 
Strike Team you created in step 2.
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5 Under Resource List, click the Equipment button, click the Kind drop-
down arrow, and then click to select the Equipment for that Strike Team.

6 Click to select the Equipment of your choice, and then click the Add 
Component button.

7 Click the Overhead button, click the Kind drop-down arrow, and then 
click to select the Overhead of your choice for that Strike Team.

8 Click to select the Overhead of your choice, and then click the Add 
Component button.

9 When finished adding all components for the strike team, click the Close 
button.

The following diagram shows the Edit Strike Team/Task Forces dialog box.

To edit a resource
1 Click to highlight a resource of your choice.

2 On the IRSS task bar, click the Edit Resource icon.

3 On the Edit Resource dialog box, edit the data as appropriate.

4 When finished making your changes, click the Save button.
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The following diagram shows the location of the Edit Resource icon.

The following diagram shows the Edit Resource dialog box.

To add qualifications to a resource
1 Click to highlight a resource of your choice.

2 On the IRSS task bar, click the Edit Resource icon.

3 On the Edit Resources dialog box under Other Quals, click the box, and 
then click the drop-down arrow to select the Code/Description of your 
choice.

4 To designate the qualification as trainee acceptable, click the Trainee 
check box.
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5 Edit the remaining data as appropriate.

6 Click the Save button.

The following diagram shows the Other Quals drop-down arrow on the Edit 
Resources dialog box.

To demobilize a resource
1 Click to highlight a resource of your choice.

2 On the IRSS task bar, click the Edit Resource icon.

3 Click the Status drop-down arrow, and then click to select D to demob the 
resource.

4 Complete the following information

- Release Date
- Release Time.

5 Click the Save button.
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The following diagram shows the Edit Resource dialog box. The arrows point 
to the Status, Release Date, and Release Time boxes.

To delete a resource
1 Click to highlight a resource of your choice.

2 On the IRSS menu bar, click the Delete Records button.

3 On the Delete Resources dialog box, click the Proceed button.

4 On the ISuite Warning dialog box, click Yes to confirm or click No to 
cancel.

The following diagram shows the location of the Delete Records button on the 
IRSS menu bar.
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The following diagram shows the Delete Resources dialog box.

The following diagram shows the ISuite Warning dialog box.

Working with databases, T-card labels, and Checkout 
Forms

The IRSS File menu allows you to perform the following functions:

• Open and close a specific IRSS database. You can have only one 
database open at a time. When you open a database, the previous one is 
automatically closed. 

• Select a printer and printer options.
• Print a T-Card label. T-Card labels identify individual resource 

information. These labels are put on T-Cards, which replaces the hand-
written header information.

• Print a Checkout Form. The Checkout Form keeps track of an 
individual resource that demobs from an incident before actual demob has 
started for the incident. This allows you to print out one checkout form 
without running the checkout form report.

To open another IRSS database

If the database you want to open does not appear on the IRSS Server and 
Database Selection dialog box, you must use the AdminTool. For more 
information see, “Managing your incident databases,” in the “I-Suite 
Administrator’s Guide.”

1 On the File menu, click Open Database.

2 On the IRSS Server and Database Selection dialog box, click the server 
drop-down arrow, and then click to select the Server of your choice.
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3 Click the Database drop-down arrow, click to select the Database of 
your choice, and then click the OK button.

The following diagram shows the IRSS Server and Database Selection dialog 
box.

To close the current database
• On the File menu, click Close Database.

To print T-Card labels
• On the IRSS task bar, click the Print T-Card Labels icon.

The following diagram shows the location of the Print T-Card Labels icon.

To print a Checkout Form
1 On the IRSS task bar, click the Print Checkout Form icon.

The following diagram shows the location of the Print Checkout Form icon.

Working with Index Lists and table views
The Tools menu allows you to modify Index Lists and customize the layout of 
your IRSS windows and screens.

Modifying Index lists can negatively impact other I-Suite programs and 
adversely affect your reports. Change an index list only after you have 
followed appropriate agency channels and have obtained proper approval.
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To add a new code to an Index List
1 On the Tools menu, click Index Lists.

2 On the Index Lists dialog box under Select Index List, click to select the 
Index List of your choice.

3 Scroll to the bottom of the table, and then click in the first available blank 
row, in the cell to the right of the .

4 Type the new data as appropriate for that Index List.

5 To save your entries, press TAB to advance the cursor to the next available 
blank row.

You must advance the cursor to the next available blank row or your entry 
will not be saved!

6 When finished, click the Close button.

The following diagram shows the Index Lists dialog box. In this example, the 
Index List for agency is selected 
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The following diagram shows the Index List for Status. The arrow points to 
the first available blank row.

Working with the Options dialog box
The Options dialog box lists five tabs that allow you to set parameters and 
define what is available to you in many IRSS screens. These tabs include:

• General. Change Other Column Titles, change the Table View to display 
only a certain set of records, add additional Kinds for QuickStats.

• Labels. Print barcode and T-card labe.s
• Active Fields. Display new field names on your screen.
• Field Sizes.Change the size of fields on your screen.
• Checkout Form. Customize the Checkout Form.

To change Other Column Titles

Changing Other Column Titles will reflect on the Add Resource/Edit Resource 
forms. Column titles in the table view, Report Design field names, and report 
titles are not affected and remain as “Other 1,” “Other 2,” and “Other 3.”

For more information about changing report titles, see “Working with Custom 
reports,” in the section, “Running and printing reports,” later in this IRSS 
User’s Guide.

1 On the Tools menu, click Options.

2 On the General tab under Other Column Titles, type to replace the 
existing text in the following boxes with the Titles of your choice

- Other 1
- Other 2
- Other 3.
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3 When finished, click the Apply button and then click the OK button.

The following diagram shows the General tab on the Options dialog box.

To change the Table View

Use caution when changing your default table view columns.

1 On the Tools menu, click Options.

2 On the General tab under Default Table View Columns, click to select 
the box of your choice, and then click the drop-down arrow to select the 
Title of your choice for the following boxes

- Column 1
- Column 2
- Column 3
- Column 4
- Column 5
- Column 6
- Column 7.

3 When finished, click the Apply button and then click the OK button.
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The following diagram shows the General tab on the Options dialog box. The 
arrow points to the Default Table View Columns.

To add additional Kinds for Quick Stats
1 On the Tools menu, click Options.

2 On the General tab under Additional Kinds used for QuickStats, click 
to select the first box, and then click the drop-down arrow to select the 
Kind of your choice.

3 Add additional Kinds as appropriate.

4 When finished, click the Apply button and then click the OK button.

The following diagram shows the General tab on the Options dialog box. The 
arrow points to the Additional Kinds used for QuickStats columns.
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To change field sizes
1 On the Tools menu, click Options.

2 On the Options dialog box, click the Field Sizes tab.

3 On the Field Sizes tab under Field Sizes to be used for Custom Reports 
click the Field Size box for the corresponding Field Name that you want 
to change, and then type to replace the existing Field Size with the new 
Field Size number.

4 Change additional Field Sizes as appropriate.

5 When finished, click the Apply button and then click the OK button.

The following diagram shows the Field Sizes tab on the Options dialog box.

To display a new field name
1 On the Tools menu, click Options.

2 On the Options dialog box, click the Active Fields tab.

3 For each Field and for each resource type (A, C, E, O), click to select or 
click to clear the appropriate check boxes of your choice.

4 When finished, click the Apply button, and then click the OK button.
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The following diagram shows the Active Fields tab on the Options dialog box.

To customize a Checkout Form
1 On the Tools menu, click Options.

2 On the Options dialog box, click the Checkout Form tab, and then click 
the Customize Checkout Form button.

3 On the Checkout Form dialog box under Logistics Section, click to 
select one or more of the check boxes of your choice

- Supply Unit
- Communications Unit
- Facilities Unit
- Ground Support Unit.

4 Under Planning Section, click to select the Documentation Unit check 
box, as appropriate.

5 Under Finance Section, click to select the Time Unit check box, as 
appropriate.

6 Under Other Section, click to select the Security Unit check box, as 
appropriate, and then complete the following fields as appropriate

- To add an additional unit in the Other Section, click to select the 
check box, and then type the unit name of your choice in the text 
box.

- Complete the second check box and unit name as appropriate.
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7 When finished, click the OK button on the Checkout Form dialog box, 
click the Apply button and then click OK on the Options dialog box.

The following diagram shows the Checkout Form tab on the Options dialog 
box.

The following diagram shows the Checkout Form dialog box.
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Running and printing reports
The Reports menu allows you to run and print standard reports and to create 
custom reports. Topics in this section include:

• Understanding queries, wildcards, and date ranges
• Working with standard reports
• Working with custom reports.

Understanding queries, wildcards, and date ranges
This section briefly introduces how to efficiently create queries, use 
wildcards, and specifying a range of dates when running standard and custom 
reports. Remember these key points:

• When developing an SQL query and where clauses, type the statements 
into a word processor such as Notepad or MS Word, and then copy and 
paste it into the dialog box.

• Type your keywords in uppercase.
• Separate each condition of the where clause with a new line to give visual 

structure to the SQL statement.
• A wildcard allows you to retrieve records that include the string of 

characters you specify. In IRSS, this wildcard is the “%” (percent sign).

Working with standard reports
This section explains how to select and sort available fields to produce 
standard reports, and how to create a custom “where” clause in SQL.

To run and print a standard report
1 On the Reports menu, click Run Reports, or click the Run Reports 

icon.

2 On the Run Reports dialog box under Incident Reports, click to select 
one of the following

- Aircraft Report
- Crew Report
- Equipment Report
- Overhead Report
- 209 Resource List
- Checkout Form
- Daily Cost Estimate
- Demob Planning Report
- R&R Report
- Qualifications Report
- Section Report
- Unfilled Orders Report.
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3 For the Incident Report you selected in step 2, complete the Report 
Parameters as appropriate.

4 To preview the report, click the Preview button, and then click the Print 
Report button.

5 To print the report without previewing, click the Print button, and then 
click OK on the Print dialog box.

The following diagram shows the location of the Run Reports icon.

The following diagram shows the Run Reports dialog box.

To display all overhead resources not demobed from Nevada - an 
example
1 Click the Overhead button.

2 Under Demobs, click to select Exclude.

3 On the filter bar, click in the HomeUnitCode box, type NV%, and then 
click the Filter button.
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The following diagram shows the table view of overhead resources. The 
arrow points to the Exclude option.

The following diagram shows the resulting filtered record.

To print a filtered record

You can copy and paste the filtered record into most any word processing or 
graphics software.

1 Obtain the filtered record of your choice.

2 On your keyboard, press ALT + PRINT SCREEN.
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3 Open the word processing or graphics software package of your choice, 
and then create a new document.

4 Press CTRL +V.

5 On the File menu, click Print.

To design, save, and print a report
1 On the Reports menu, click Design Reports.

2 On the Design Reports dialog box on the Design Regular tab, type the 
name of the report in the Title box.

3 Under Fields, click to select the following Fields of your choice, in order 
in which you want to sort.

4 If appropriate, type a valid SELECT....WHERE statement in the Select 
box.

5 Under Line Spacing, click to select on of the following

- Single
- 1.5
- Double.

6 To preview the report, click the Preview button, and then click the Print 
Report icon.

7 To save your report, click the Save button.

The following diagram show the Design Reports dialog box.
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To design a regular report using a where clause - an example
1 On the Reports menu, click Design Reports.

2 On the Design Reports dialog box on the Design Regular tab, type the 
name of the report in the Title box.

3 Under Fields, click to select the following Fields, in the following order

- RequestNumber
- Name
- KindDesc
- HomeUnitCode.

4 In the Select box, type the following WHERE clause

status <> ‘0’
and homeunitcode like ‘NV%’
and reqcat = ‘0’

5 To preview the report, click the Preview button.

6 To save the report, click the Save button.

The following diagram shows the resulting Design Regular tab on the Design 
Reports dialog box.
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Working with custom reports
This section explains how to select, sort, group, and order fields using SQL 
statements to create custom reports. Remember these key points when 
working with custom reports:

• Queries. Also known as data retrievals, search the database and fetch 
information you requested in the most efficient way possible.

• SELECT. Identifies the data.
• FROM. Identifies the table.
• WHERE. Limits the data that the Select statement returns.
• BETWEEN. Spans two specific fields, such as between two dates.
• GROUP BY. Organizes data into sets.
• COUNT(*). Gives a summary value per set.

The Design Reports Help File is a valuable resource for understanding and 
creating correct SQL syntax. 

 To access the Help file for creating SQL statements
1 On the Design Reports dialog box, click the Help button.

2 When finished reviewing the information, click the Close button.

The following diagram shows the Design Report Help window.
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To create a custom where clause and between clause for an SQL 
query - an example
1 On the Reports menu, click Design Reports.

2 On the Design Reports dialog box, click the Design Advanced tab.

3 In the Title box, type the name of the report.

4 In the Select box, type the following

SELECT requestnumber, name, kinddesc
homeunitcode
FROM q_basic_rpts
WHERE status <> ‘D’
and Checkindate between ‘07/01/2004’ and ‘07/14/2004’
and homeunitcode like ‘NV%’
and reqcat = ‘0’

5 To preview the report, click the Preview button.

6 To save the report, click the Save button.

The following diagram shows the resulting Design Advanced tab on the 
Design Reports dialog box.
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To change report titles using an SQL “AS” statement - an example
1 On the Reports menu, click Design Reports.

2 On the Design Reports dialog box, click the Design Advanced tab.

3 In the Title box, type the name of the report.

4 In the Enter a complete sql statement box, type the following

SELECT 
Other1 AS ‘Spike Camp’,
Other2 AS ‘Crew Reps’ 
from Resources

The following diagram shows the resulting Design Advanced tab on the 
Design Reports dialog box.
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The Incident Time System (ITS) is part of the I-Suite group of software 
programs. ITS allows you to collect and track incident time for Federal, 
Casual (AD), and other personnel, and for Emergency Contracted Resourses. 
ITS allows you to create pay documents, the Fire Time Report (OF-288) and 
the Equipment Use Invoice (OF-286). By collecting accurate time data, you 
can generate meaningful management reports.

Topics in this guide include the following:

• About this guide
• Getting Started
• Working with incident information
• Working with personnel information
• Working with crews and members/operators
• Working with contractor and agreement data
• Working with commissary debits and additions
• Working with reports
• Performing searches for personnel or equipment
• Putting it all together.
For information about installing ITS, please refer to the “I-Suite 
Administrator’s Guide,” which is available for download on  
http://isuite.nwcg.gov.

About this guide
This Incident Time System User’s Guide is organized into sections, based on 
the types of tasks you will commonly perform. At the beginning of each 
section you will find an overview of the topics explained. Where appropriate, 
diagrams are shown immediately following each task. Topics in this section 
include:

• Before you begin
• Conventions.

Before you begin
Before using ITS, you must be feel confident that:

• You are familiar with your personal computer and function keys and 
understand personal computer concepts.

• You are familiar with Windows 2000, Windows XP, or Windows NT and 
can log on and log off.
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Conventions
The following conventions are used within this guide:

• Button names, option labels, screen names, tab names, and text box 
names appear in bold, in the same case as on your keyboard or screen. For 
example, the fist step in a procedure might instruct you to

1 On the Incident Data menu, click the Incident # drop-down arrow, 
and then click to select the Incident of your choice. 

• Topics of special interest or hints that will help you perform a specific 
task show a line before and after the text. The text appears in italic type. 
For example, the following note appears in the “Working with incident 
information” section

While working in the Manage All Incidents as One mode, you must 
select an incident for posting each resource’s time.

Getting Started
This section explains the basic concepts and information you need to begin 
using ITS. Topics in this section include:

• Terms and concepts
• Security
• Logging on and logging off
• Getting help
• Understanding the stand-alone and integrated environments.

Terms and concepts
This section outlines some of the screens, toolbars, and menus that you will be 
using in ITS. If you aren’t already familiar with ITS or have forgotten a few 
things since training, review these terms and concepts before proceeding with 
the remaining sections in this guide.

The following diagram shows the ITS toolbar and a brief explanation of the 
toolbar buttons.
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The following diagram shows the top portion of the ITS application and a 
brief explanation of the screen elements and terminology used throughout this 
guide.

Security
Be prudent when working with private information such as Social Security 
Numbers (SSNs) and IRS Federal Employer Tax ID Numbers (EINs).This 
information is to be kept confidential.

Your CTSP manages the ITS password, who can change it using the 
AdminTool that is shipped with the I-Suite software. Only under special 
circumstances, such as operating in a stand-alone environment, would you 
ever need to change your ITS password.

For more information about clearing out SSNs and EINs, see “Clearing out 
Social Security Numbers,” in the “I-Suite Administrator’s Guide. For more 
information about changing the ITS password, see “Managing security” in the 
“I-Suite Administrator’s Guide,” or contact your CTSP.
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Logging on and logging off
This section explains how to log on and log off of ITS. 

To log on to ITS
1 From your Desktop, double-click the ITS icon or click Programs from 

the Start menu, point to I-Suite, and then click ITS.

If you have trouble logging on to ITS, please refer to the “Handling installation 
problems,” in the “I-Suite Administrator’s Guide,” which is available for 
download on http://isuite@nwcg.gov.

To log off ITS
• On the ITS menubar, click Exit ITS, or click Exit on the File menu.

Getting help
This section explains how to access and locate help information. There are 
three basic ways to obtain help information for ITS:

• Access the I-Suite website. This site contains a wide array of I-Suite 
information, including software downloads, updates, and user 
documentation.

• Contact the I-Suite Helpdesk. If you are unable to answer your question 
using the I-Suite website, contact the I-Suite Helpdesk at (866) 224-7677.

• Review this Incident Time System User’s Guide. This guide is 
available in Acrobat format. To locate topics of interest, click to select the 
Bookmark of your choice. Bookmarks are listed along the left-hand side 
of the Acrobat document. When you click the Bookmark, you will 
advance to that topic within the document.

To display help information within ITS
• On the ITS menu bar, click Help, and then click Support.
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The following diagram shows the ISuite Support dialog box. 

To locate help information on the I-Suite website
1 Start your Internet browser.

2 In the Address box, type http://isuite.nwcg.gov, and then press ENTER.

3 On the Welcome to I-Suite webpage, click the ITS application icon.

4 On the ITS webpage, click to select the topic of your choice.

The following diagram shows the ITS application icon on the Welcome to  
I-Suite webpage.
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The following diagram shows the ITS webpage and a list of available topics.

To contact the I-Suite Helpdesk

The I-Suite Helpdesk is available 24-hours per day, seven days per week.

• Call (866) 224-7677, or email helpdesk@dms.nwcg.gov.

To obtain a copy of this Incident Time System User’s Guide
1 Start your Internet browser.

2 In the Address box, type http://isuite.nwcg.gov, and then press ENTER.

3 On the Welcome to I-Suite webpage, click the ITS application icon.

4 On the ITS webpage, click to select ITS User’s Guide.

5 In Acrobat Reader, save the file to your personal computer in a folder 
location of your choice.
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Understanding the stand-alone and integrated environments
This section explains the difference between working in the stand-alone 
environment or the integrated environment. While you may only be using ITS 
for your work, it is important to understand how the information you enter in 
ITS affects other I-Suite programs in the integrated environment. 

Typically, you will be working in the integrated environment.

• Integrated environment. Data ownership is shared between the 
Resource Planning and Finance groups. Resources, crews, and operators 
are already entered in IRSS. Maintaining data standards is critical.

• Stand-alone environment. All data is entered and managed by ITS users 
for timekeeping and making payments.

Since data is shared between IRSS, ICARS, and ITS, any changes you make 
within ITS affects the data within ICARS and IRSS.

Remember, what works for one incident may not work well for another!

Working with incident information
This section explains how to enter and edit incident information. Topics in 
this section include:

• Managing incident data
• Managing accounting codes.

Managing incident data
This section explains how to review, edit, and add incident data and how to 
list all resources together and manage all incidents as one.

To review and edit incident data
1 On the Incident Data menu, click Incident Add/Edit.

2 Click the Incident # drop-down arrow, click to select the Incident of 
your choice, and then click the Edit tab.

3 Modify the following information as appropriate

- Incident Name
- Incident Number
- Accounting Code
- Location
- State
- Start Date.

4 To save your changes, click the Save button.
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The following diagram shows the Edit tab on the Incident Add/Edit screen.

To create a new incident

Be sure to follow the appropriate data standards!

1 On the Incident Data menu, click Incident Add/Edit.

2 Click the Add tab.

3 In the Incident Name box, type the Incident Name.

4 In the Incident Number box, type the Incident Number, in the format 
[HOST ID] - 99999.

5 In the Accounting Code box, type the Accounting Code number.

6 In the Location box, type the Location name.

7 Click the State drop-down arrow, and then click to select the State where 
the incident is located.

8 In the Start Date box, type the incident Start Date, in the format 
MMDDYYYY.

9 To save your changes, click the Save button.

To clear your entries before saving the new incident, click the Clear button.
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The following diagram shows the Add tab on the Incident Add/Edit screen.

To manage all incidents as one

The Manage All Incidents as One check box allows you to display all 
resources together on a single list. While these resources must be reporting 
to the same ICP, they may not be from the same incident.

When working in this mode, you must select an incident to post each 
resource’s time.

• From any ITS screen, click to select the Manage All Incidents as One 
check box.

The following diagram shows the location of the Manage All Incidents as One 
check box.

Managing accounting codes
This section explains how to review, edit, and assign accounting codes to an 
incident and to resources.

To review an accounting code for an incident
1 On the Incident Data menu, click Incident Accounts.
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2 Click the Incident # drop-down arrow, and then click to select the 
Incident of your choice.

The following diagram shows the Manage Incident Accounts screen.

To edit an accounting code
1 On the Incident Data menu, click Incident Accounts.

2 Click the Incident # drop-down arrow, and then click to select the 
Incident of your choice.

3 On the Manage Incident Accounts screen, click the Edit button.

4 On the Edit Account dialog box, modify the following information as 
appropriate

- Accounting Code
- Agency Code.

5 To set this Accounting Code as the default, click to select the Set as 
Default Accounting Code for This Incident check box.

6 To save your changes, click the Save button.
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The following diagram shows the Edit Account dialog box on the Manage 
Incident Accounts screen.

To add multiple accounting codes to an incident
1 On the Incident Data menu, click Incident Accounts.

2 On the Manage Incident Accounts screen, click the Add button.

3 On the Add Account dialog box, add the following information as 
appropriate

- Accounting Code
- Agency Code.

4 To set this Accounting Code as the default, click to select the Set as 
Default Accounting Code for This Incident check box.

5 To save your changes, click the Save button.
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The following diagram shows the Add Account dialog box on the Manage 
Incident Accounts screen.

To identify the administrative office(s) for payment

Identify the administrative office during the initial startup for an incident.

1 On the Incident Data menu, click Admin Office for Payment.

2 Click the Add button.

3 On the Add Office Information dialog box, complete the following 
information

- Office Name
- Address 1
- Address 2
- City
- ST
- Zip.

4 When finished, click the Save button.
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The following diagram shows the Add Office Information dialog box on the 
Manage Administrative Offices For Payment screen.

Working with personnel information
This section explains how to edit and add personnel information. Topics in 
this section include:

• Editing and adding personnel data
• Posting personnel time.

Editing and adding personnel data
Remember these key points when working with personnel data for posting 
time and tracking payments:

• In the integrated environment, you will edit personnel data entered by 
Check-In (IRSS) personnel.You share data ownership between Resource 
Planning and Finance groups.

• In the stand-alone environment, you must enter all personnel data. You do 
not share data ownership.

• By default, all Social Security Numbers that originate from IRSS are 
“999-99-9999.” For AD employees, you must enter the exact SSN for that 
individual, or enter “999-99-9999” if the SSN is not currently available.

To edit personnel data - integrated environment
1 On the Personnel Add/Edit screen, click the Edit/Lookup tab.

2 Click the Select Personnel drop-down arrow, and then click to select the 
Person of your choice.
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3 For AD personnel, type the person’s Social Security Number in the 
Social Security Number box, in the format 123456789.

When completing the Social Security Number box, the cursor will 
automatically advance to the next field as you type.

4 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

5 Click the AD/Fed/Other drop-down arrow, and then click to select the 
the Employment Code of your choice

- AD - for casual Federal employees
- Fed - for Federal employees
- Other - for other types of employees, such as county and state.

6 To specify a contracted resource, click to select the Contracted Resource 
check box.

7 For AD personnel, complete the Payment Information tab as 
appropriate:

- Initial Employment
- Return Travel
- Point of Hire
- Area
- Class
- Current Rate.

8 On the Personnel Mailing Address tab, complete the following 
information as appropriate:

- Address 1
- Address2
- City
- ST
- Zip
- Phone
- Fax.

9 To save your changes, click the Save button.
14 September 9, 2004



Incident Time System User’s Guide Incident Time System User’s Guide
The following diagram shows the Edit/Lookup tab on the Personnel Add/Edit 
screen.

To add personnel data - stand-alone environment
1 On the Personnel Add/Edit screen, click the Add tab.

2 In the Request Number box, type the Request Number for that person, 
in the format X1234.

Valid Request Numbers include: 
A - for Aircraft 
C - for Crews 
E - for Equipment 
I - for Initial Attack 
O - for Overhead 
S - for Supplies.

3 In the Last Name box and First Name box, type the First and Last 
Name of the person.

4 For AD personnel, type the person’s Social Security Number in the 
Social Security Number box, in the format 999999999.

For resources not requiring an SSN for payment, type 999999999.
When completing the Social Security Number box, the cursor will 
automatically advance to the next field as you type.

5 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.
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6 Click the Kind/Position drop-down arrow, and then click to select the 
Kind/Position of your choice.

7 Click the Status drop-down arrow, and then click to select the current 
Status.

8 Click the AD/Fed/Other drop-down arrow, and then click to select the 
the Employment Code of your choice

- AD - for temporary Federal employees
- Fed - for full-time Federal employees
- Other - for other types of employees, such as seasonal and state.

9 To specify a contracted resource, click to select the Contracted Resource 
check box.

10 Click the Agency drop-down arrow, and then click to select the Agency 
of your choice.

11 In the Remarks box, type any appropriate Remarks.

12 On the Payment Information tab, complete the following information as 
appropriate:

- Initial Employment
- Return Travel
- Point of Hire
- Area
- Class
- Current Rate.

13 Click the Personnel Mailing Address tab, and then complete the 
following information as appropriate:

- Address 1
- Address2
- City
- ST
- Zip
- Phone
- Fax.

14 To save your changes, click the Save button.
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The following diagram shows Add tab on the Personnel Add/Edit screen.

The following diagram shows the Personnel Mailing Address tab on the 
Personnel Add/Edit screen.
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Posting personnel time
This section explains how to post time for personnel. Remember these key 
points when posting personnel time:

• Posting time is performed the same, whether working in the stand-alone 
or integrated environments.

• You can edit the Stop and Start times, Special codes, and rates directly on 
the Personnel Post Detail.

• You can not edit the Date. To change the Date you must delete and then 
repost that entry.

• The Date automatically changes for posting that extends beyond midnight 
for any given shift.

• If you post overlapping hours, you must verify the hours before you can 
proceed.

To post personnel time

Remember, you can click to select the Use Enter Key as Tab for Posting 
check box for faster, 10-key data entry!

1 Click the Post Time button.

2 On the Incident Post screen on the Personnel tab, click the Select 
Personnel drop-down arrow, and then click to select the Person of your 
choice.

3 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

4 In the Date box, type the Date, in the format MMDDYYYY.

When completing the Date box, the cursor will automatically advance to 
the next date field as you type.
To enter the current Date, type = (equal sign). To enter yesterday’s Date. 
type - (minus sign). To enter a Future Date, type + (plus sign).

5 Click the Start Time drop-down arrow, and then click to select the Start 
Time of your choice.

6 Click the Stop Time drop-down arrow, and then click to select the Stop 
Time of your choice.

7 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

8 To commit the posting, click the Commit Posting button.

Clicking the Commit Posting button saves your data.
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The following diagram shows the Incident Post screen for posting personnel 
time.

To post time when managing all incidents as one
1 On the ITS toolbar, click to select the Manage All Incidents as One 

check box.

2 On the Incident Post screen on the Personnel tab, click the Select 
Personnel drip-down arrow, and then click to select the Person of your 
choice.

3 Click the Account Code drop-down arrow, and then click to select the 
Incident/Acct Code combination of your choice.

Be sure to select the correct person, incident, and account code.

4 Complete the remaining information as appropriate

- Date
- Start Time
- Stop Time
- Special.

5 To commit the posting, click the Commit Posting button.
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The following diagram shows the Incident Post screen when managing all 
incidents as one. In this example, the Account Code drop-down arrow lists 
three different incidents.

To repost a day of time with different hours
1 On the Incident Post screen on the Personnel tab, click the Select 

Personnel drop-down arrow, and then click to select the Person of your 
choice.

2 In the Date box, type the Date in the format MMDDYYYY.

3 Click the Start Time drop-down arrow, and then click to select the Start 
Time of your choice.

4 Click the Stop Time drop-down arrow, and then click to select the Stop 
Time of your choice.

5 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

6 To commit the posting, click the Commit Posting button.

7 On the Overlapping Hours dialog box, click Yes or click Yes to All.
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The following diagram shows the Overlapping Hours dialog box.

To change the AD rate, Kind Code, and Special code - one-time 
change only
1 On the Incident Post screen on the Personnel tab, click the Select 

Personnel drop-down arrow, and then click to select the non-federal 
Person of your choice.

2 Locate the row containing the Class and Rate you want to change.

3 Click to select the Class box, and then type to replace the existing AD 
designation with the new AD designation.

For AD-5 rates, type the Rate on the ITS:AD-5 dialog box, in the format 
99.99, and then click OK.

4 To change the Kind Code, click the Kind Code drop-down arrow, and 
then click to select the Kind Code of your choice.

5 Locate the row containing the Special code you want to change.

6 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

7 To commit the posting, click the Commit Posting button.

The following diagram shows the ITS:AD-5 dialog box for entering an AD-5 
rate.
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To permanently change the AD rate and/or Kind Code for all 
future personnel postings - to change all subsequent postings
1 On the Incident Post screen on the Personnel tab, click the Select 

Personnel drop-down arrow, and then click to select the Person who has 
the AD rate you want to change.

2 On the Payment Information tab, click the Class drop-down arrow, click 
to select the AD Rate of your choice.

3 To change the Kind Code, click the Kind Code drop-down arrow, and 
then click to select the Kind Code of your choice.

4 When finished, makingclick the Save button.

To delete a row of time
1 On the Incident Post screen on the Personnel tab, click the Select 

Personnel drop-down arrow, and then click to select the Person of your 
choice.

2 Click in the cell for the row you want to delete, and then click the Delete 
button.

To post return travel time

Posting end travel time sets the number of Hours to 0 (zero) and the Special 
code to TVL.

1 On the Incident Post screen on the Personnel tab, click the Select 
Personnel drop-down arrow, and then click to select the Person of your 
choice.

2 Click to select the Check here to Post Return Travel Day check box.

3 In the Date box, type the Date, in the format MMDDYYYY.

4 Click the Start Time drop-down arrow, and then click to select the Start 
Time of your choice.

5 To commit the posting, click the Commit Posting button.

To view and/or print an OF-288 
1 On the Incident Post screen, click the Print OF288 button, or click  

OF-288 on the Reports menu.

2 On the OF-288 dialog box, perform one of the following

- to view the OF-288 by request number, click the Request Number 
drop-down arrow, and then click to select the Request Number of 
your choice.

- to view the OF-288 for a person, click the Person drop-down arrow, 
and then click to select the Person of your choice.
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3 To view the final OF-288 for a resource leaving the incident, click to 
select the Final Invoice check box.

4 To preview the OF-288, click the Preview Report button.

5 To print the OF-288, click the Print Report button.

If this is a partial payment and you want the resource’s social security number 
to print on the OF-288, you must click to select the Final Invoice check box.

The following diagram shows the OF-288, “Emergency Firefighter Time 
Report” dialog box.
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The following diagram shows a sample Emergency FireFighter Time Report 
OF-288 for an individual overhead resource, as it appears on your screen.

Working with crews and members/operators
This section explains how to view, add, edit, and print crews and crew 
members/operators, and how to demobilize (demob) a crew and/or crew 
members/operators. Topics in this section include:

• Understanding crews
• Creating and editing crews
• Posting time for crews and crew members/operators
• Reviewing an OF-288 for crews.

Understanding crews
Remember these key points when working with crews and members/
operators:

• In ITS, a crew is more than one resource sharing the same request 
number. A crew may be a hand crew, engine crew members, or a contract 
pickup with an AD driver.

• There are two levels of crew information:
- At the crew level, you can add and/or edit information about the crew.
- At the member/operater level, you can add and/or edit information 
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about the individual crew members/operators on a crew.
• You can build a crew by attaching or rostering members to a resource

- In the integrated environment, IRSS populates ITS with shared data. 
If members are being rostered in IRSS, then you will primarily need 
to edit members.  If members are not being rostered in IRSS, then you 
must add members to a crew or to a piece of equipment.

- In the stand-alone environment, you will manage all data, including 
adding and then rostering members/operators to a crew.

To view and print a crew manifest
1 Click the Crews/Operators button.

2 On the Crew/Operator Roster screen, perform one of the following

- click the Request # drop-down arrow, and then click to select the 
Request # of your choice

- click the Crew Name/Equipment UniqueID drop-down arrow, and 
then click to select the Crew Name/Equipment of your choice.

3 To view the crew manifest, click the Print Crew/Operator Manifest 
button.

The crew manifest is a good place to view the initial crew data entered 
from IRSS.

4 To print the crew manifest, click the Print icon on the Crew Roster 
Report dialog box, and then click OK on the Print dialog box.

The following diagram shows the Crew/Operator Roster screen.
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The following diagram shows a sample crew manifest on the Crew Roster 
Report dialog box.

The following diagram shows the Print dialog box that displays when printing 
a crew manifest. 

Creating and editing crews
This section explains how to add and edit crew data in the integrated and 
stand-alone environments. There are two levels of crew information:

• Crew level. Add and/or edit information about the crew.
• Member/operator level. Add and/or edit information about individual 

crew members/operators on a crew.

To edit crew information
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 Click the Edit/Lookup tab.

3 Click the Select Crew/Equipment drop-down arrow, and then click to 
select the Crew or Equipment of your choice.

4 Click the Crew/Equipment tab.
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5 On the Crew/Equipment tab, modify the following information as 
appropriate

- Request Number
- Crew Name/Equipment UniqueID
- Kind/Position
- Agency
- Status
- Account Code
- Contact Crew.

6 To save your changes, click the Save button.

The following diagram shows the Crew/Equipment tab on the Crew & 
Operators Add / Edit screen.

To edit crew members on a crew
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 Click the Edit/Lookup tab.

3 Click the Select Crew/Equipment drop-down arrow, and then click to 
select the Crew or Equipment of your choice.

4 Click the Member/Operator tab.

5 Click the Select Personnel drop-down arrow, and then click to select the 
Crew member/Operator of your choice.

6 Complete the remaining personnel data as appropriate, and then click the 
Save button.
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The following diagram shows the Member/Operator tab on the Crew & 
Operators Add / Edit screen. The arrow points to the Members to fed button.

To set all crew members/operators with unassigned employment 
types to “fed”
1 On the Crew & Operators Add/Edit screen, click the Crew/Member/

Edit tab.

2 Click the Select Crew/Equipment drop-down arrow, click to select the 
Crew of your choice, and then click the Members to fed button.

To add crew members to an existing crew

In some cases, the crew leader will already be listed on the crew. You can add 
the remaining crew members, but can only edit the crew leader.

1 On the Crew/Operator Roster screen, click the Add/Edit Crew/
Operators button.

2 On the Crew & Operators Add/Edit screen, click the Add tab, and then 
click the Member/Operator tab.

3 Click the Crew/Equipment to Add To drop-down arrow, and then click 
to select the Crew or Equipment of your choice.

4 Complete the following information as appropriate

- First Name
- Last Name
- Social Security Number
- Account Code
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- Kind/Position
- Status
- AD/Fed/Other
- Agency
- Remarks.

5 On the Payment Information tab, complete the following information as 
appropriate

- Initial Employment
- Return Travel
- Point of Hire
- Area
- Class
- Current Rate.

6 Click the Personnel Mailing Address tab, and then complete the 
following information as appropriate

- Address 1
- Address2
- City
- ST
- Zip
- Phone
- Fax.

7 Click the Save button.

The following diagram shows the Member/Operator tab on the Add tab on the 
Crew & Operators Add/Edit screen.
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To edit the leader of a crew to add crew members
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 On the Edit/Lookup tab, click the Select Crew/Equipment drop-down 
arrow, and then click to select the Crew that contains the .

3 Click the Member/Operator tab.///

To create a crew
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 On the Crew & Operators Add/Edit screen, click the Add tab.

3 On the Crew/Equipment tab, complete the following information as 
appropriate

- Request Number
- Crew Name/Equipment UniqueID
- Kind/Position
- Agency
- Status
- Account Code
- Contract Crew.

4 Click the Save button.

5 Add crew members as appropriate.

For more information about adding crew members, see the previous task, 
“To add crew members to an existing crew.”

To demob a crew
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 Click the Edit/Lookup tab.

3 Click the Select Crew/Equipment drop-down arrow, and then click to 
select the Crew or Equipment of your choice.

4 Click the Crew/Equipment tab.

5 Click the Status drop-down arrow, click to select Demobed, and then 
click the Save button.
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The following diagram shows the Edit/Lookup tab on the Crew & Operators 
Add / Edit screen. The arrow points to the “Demobed” Status for the crew.

To demob a crew member/operator
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 Click the Edit/Lookup tab.

3 Click the Select Crew/Equipment drop-down arrow, and then click to 
select the Crew or Equipment of your choice.

4 Click the Member/Operator tab.

5 Click the Select Personnel drop-down arrow, and then click to select the 
Crew member/Operator of your choice.

6 Click the Status drop-down arrow, click to select Demobed, and then 
click the Save button.
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The following diagram shows the Edit/Lookup tab on the Crew & Operators 
Add / Edit screen. The arrow points to the “Demobed” Status for the crew 
member.

Posting time for crews and crew members/operators
This section explains how to post time for crews and crew members/
operators. Remember these key points when posting time for crews and crew 
members/operators:

• Posting time is performed the same, whether working in the stand-alone 
or integrated environments.

• Do not edit the Stop and Start times, Special codes, and rates on the Crew 
Member/Operator Post Detail.

• You cannot edit the Date. To change the Date you must delete and then 
repost that entry.

• The Date automatically changes for posting that extends beyond midnight 
for any given shift.

• If you post overlapping hours, you must verify the hours before you can 
proceed.

• Post all time to a crew member before he/she is demobed. If you use the 
Select All button and select a demobed crew member, that time will not 
be posted!

• explain grid functionality, editing, deleting, copy and past, reviewing.///
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To post time crew time

Remember, you can click to select the Use Enter Key as Tab for Posting 
check box for faster, 10-key data entry!

1 Click the Post Time button.

2 On the Incident Post screen, click the Crews & Operators tab.

3 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Equipment Name of your choice.

4 Under Crew Members, click to select the Crew Member(s) of your 
choice.

To select more than one Crew Member, press and hold CTRL, and then 
click to select every Crew Member of your choice.

5 In the Date box, type the Date, in the format MMDDYYYY.

When completing the Date box, the cursor will automatically advance to 
the next date field as you type.
To enter the current Date, type = (equal sign). To enter yesterday’s Date. 
type - (minus sign).

6 Click the Start Time drop-down arrow, and then click to select the Start 
Time of your choice.

7 Click the Stop Time drop-down arrow, and then click to select the Stop 
Time of your choice.

8 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

9 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

10 To commit the posting, click the Commit Posting button.

Clicking the Commit Posting button saves your data.

11 On the Incident Time System: Post Results dialog box, click OK.
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The following diagram shows the Crews & Operators tab on the Incident Post 
Posting Crews screen.

To select all crew members/operators
• On the Incident Post screen, click the Crews & Operators tab, and then 

click the Select All button.

To cancel all selected crew members/operators
• On the Incident Post screen, click the Crews & Operators tab, and then 

click the Select None button.

To cancel all selected crew members/operators and select all 
others

The Invert Selection button makes posting crew leader and crew member 
time easier. First, post the Crew Leader’s time, click the Invert Selection 
button, and then post the crew members’ time.

• On the Incident Post screen, click the Crews & Operators tab, and then 
click the Invert Selection button.

To repost a day of time
1 On the Incident Post screen, click the Crews & Operators tab.
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2 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Unique ID of your choice.

Be sure to select the correct crew member.

3 Under Crew Members, click to select the Crew Member of your choice.

4 Locate the day and time you want to repost, and then type the same Date 
as the existing Date.

5 Complete the Start Time, and Stop Time boxes with the new 
information.

6 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

7 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

8 To commit the posting, click the Commit Posting button.

9 On the Overlapping Hours dialog box, click Yes to overwrite the 
previous post with the current one.

10 On the Incident Time System: Post Results dialog box, click OK.

To delete a row of posted time

The Delete button is located on the ITS toolbar.

1 On the Incident Post screen, click the Crews & Operators tab.

2 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Unique ID of your choice.

Be sure to select the correct crew member.

3 Under Crew Members, click to select the Crew Member of your choice.

4 Under Crew Member/Operator Post Detail, click to select the day and 
time you want to delete.

5 Click the Delete button.

6 On the ITS: Delete Posting for Crew Member(s) dialog box, click Yes.

To copy and paste posted time
1 On the Incident Post screen, click the Crews & Operators tab.

2 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Unique ID of your choice.

3 Under Crew Members, click to select the Crew Member of your choice.

4 Under Crew Member/Operator Post Detail, click to select the day and 
time you want to copy.
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5 Right-click on that row, and then point to Copy Selected Postings.

6 Under Crew Members, click to select the destination Crew Member for 
the copied row of time.

7 Right-click the destination Crew Member and then point to Paste 
Copied Posting to Selected Mbrs.

8 On the Incident Time System: Post Results dialog box, click OK.

The following diagram shows the Incident Post - Posting Crews screen. The 
arrow points to the Paste Copied Posting the Selected Mbrs option highlighted 
on the Incident Post Posting Crews screen.

To post return travel time
1 On the Incident Post screen, click the Crews & Operators tab.

2 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Unique ID of your choice.

3 Under Crew Members, click to select the Crew Member of your choice.

4 Under Crew Member/Operator Post Detail, click to select the row of 
time of your choice, and then click to select the Check here to Post 
Return Travel Day check box.

5 Complete the Date, Start Time, and Stop Time boxes.

6 To commit the posting, click the Commit Posting button.

7 On the Overlapping Hours dialog box, click Yes to overwrite the 
previous post with the current one.

8 On the Incident Time System: Post Results dialog box, click OK.
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Reviewing an OF-288 for crews
The OF-288 lists all incidents and all accounting codes for the selected 
request number, crew name, person, or all personnel.

To review an OF-288
1 On the Reports menu, click OF-288.

2 On the OF-288 dialog box, click the Crew Name drop-down arrow, and 
then click to select the Crew Name or Unique ID of your choice.

3 To view the final OF-288 for the crew leaving the incident, click to select 
the Final check box.

4 To preview the OF-288, click the Preview Report button.

5 To print the OF-288, click the Print Report button.

The following diagram shows a sample OF-288 for crews.
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Working with contractor and agreement data
This section explains how to add and edit contractor and agreement data. In 
ITS, you must add and attach contractor and agreement data to a resource to 
process payment documents. Remember these key points when working with 
contractor and agreement data:

• You only need to enter contractor and agreement data once.
• For multiple resources sharing the same contractor and agreement, pick 

the specific contractor and agreement and then attach it to the resource.
• You can assign up to six rates to each resource.
• Units of measure include Daily, Each, Hourly, and Mileage.

Topics in this section include:

• Understanding the contractor, agreement, and resource relationship
• Understanding rate types and units of measure
• Managing contractor and agreement data.

Understanding the contractor, agreement, and resource relationship
In ITS, a contract consist of three parts:

• Contractor. A business entity that has available resources.
• Agreement. One or more OF-294 - Emergency Equipment Rental 

Agreement (EERA) attached to the contractor. A contractor may have 
multiple agreements.

• Specifications. Conditions the resource must meet to fulfill the 
agreement.

The following diagram shows the relationship between the contractor, 
agreement, specifications, and resource.

Understanding rate types and units of measure
Together, rate types and units of measure allow ITS to calculate the cost of the 
contracted resource. The following list briefly explains rate types and units of 
measure:

• Primary rate. All contracted resources must have a primary rate 
designation.

• Special rate. A contracted resource may or may not have one to five 
special rate designations.
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• Units of measure. Units of measure include Daily, Each, Hourly, and 
Mileage. 

Be sure to match the correct rate with the correct unit of measure! For 
example, a contracted piece of equipment may have a primary, daily rate of 
$52.00 and a special, mileage rate of $0.32.

Managing contractor and agreement data
This section explains how to review and create contractors and agreements, 
and how to attach an agreement to the contractor.

To review the list of existing contractors

Determine if the contractor already exists before creating a new one.

1 Click the Contracts button.

2 On the Contracted Resource Add/Edit screen under Select Type, click 
to select one of the following resource Types:

- Contract Equipment
- Contract Crews
- Other Contracts.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor of your choice.

If the contractor does not appear on the drop-down list, then create one! 

The following diagram shows the Contracted Resource Add/Edit screen for 
contracted equipment.
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To create a contractor
1 On the Contracted Resource Add/Edit screen, complete the following 

information as appropriate

- Name
- EIN/SSN
- Address
- City
- ST
- Zip
- Phone.

2 Click the Save button.

Next, determine if an agreement already exists and is attached to the 
contractor. If not, create an agreement and attach it to the contractor. If 
so, edit the resource specifications and then link them to the contractor/
agreement.

The following diagram shows the Add tab on the Contracted Resource Add/
Edit screen.

To create an agreement and attach it to the contractor
1 On the Agreement tab, click the Add tab.

2 In the Agreement Number box, type the Agreement Number.

3 In the Begin Date box, type the beginning date of the agreement, in the 
format MMDDYYYY.
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4 In the Expiration Date box, type the expiration date of the agreement, in 
the format MMDDYYYY.

5 In the Point of Hire box, type the location at the time of hire.

6 Click the Administrative Office for Payment drop-down arrow, and 
then click to select the Administrative Office of your choice.

7 To attach the agreement to the contractor, click the Agreement Number 
drop-down arrow, and then click to select the Agreement Number of 
your choice.

8 Click the Save button.

The following diagram shows an example of a new agreement on the 
Contracted Resource Add/Edit screen.
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The following diagram shows the new agreement attached to the contractor.

To edit resource specifications and link it to a contractor and 
agreement

In the integrated environment, the resource is already added to the incident 
database from IRSS. In ITS, you must edit the resource specifications and 
create a new name for it, then link the resource together with the contractor 
and agreement.

1 On the Contracted Resource Add/Edit screen under Select Resource 
By, click Name or Request number.

2 Click the Unique Name or Request Number drop-down arrow, and then 
click to select the Name or Request Number of your choice for the 
Contractor/Agreement of your choice.

3 On the Resource tab on the Edit tab, type a new, unique name for the 
resource in the Unique ID box.

4 Complete the Make, Model, and Remarks boxes as appropriate.

5 Click to select the Gov’t Operator and Gov’t Supplies check boxes, as 
appropriate.

6 Complete the Hired Date and Time boxes and the Release Date and 
Time boxes, as appropriate.

7 Click to select the Withdrawn check box, as appropriate.

8 Click the Rate Type drop-down arrow, and then click to select the Rate 
Type of your choice.
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9 Click the Rate box, and then type the appropriate Rate for that Rate Type 
and Unit of Measure.

10 Press TAB twice to advance the cursor to the next Rate Type box.

11 Verify that the correct Request Number, Contractor Name, and 
Agreement Number display on the upper portion of the Contracted 
Resource Add/Edit screen.

12 Click the Save button.

13 On the Warning - Check for Correct Agreement/Contractor dialog 
box, click Yes.

The following diagram shows the Contracted Resource Add/Edit screen for 
linking a resource to the contractor and agreement.

To add an operator to a resource

If a leader was added by IRSS into the incident database, you will only need 
to edit the operator information.

1 On the Contracted Resource Add/Edit screen under Select Resource 
By, click Name or Request number.

2 Click the Unique Name or Request Number drop-down arrow, and then 
click to select the Name or Request Number of your choice for the 
Contractor/Agreement of your choice.

3 On the Resource tab on the Edit tab, click the Add Operator(s) button.
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4 On the Crews & Operators Add/Edit screen, on the Add tab on the 
Member/Operator tab, add or edit the following information as 
appropriate

- First Name
- Last Name
- Social Security number
- Account Code
- Kind/Position
- Status
- AD/Fed/Other
- Agency
- Remarks.

5 Complete the Payment Information tab as appropriate.

6 Click and then complete the Personnel Mailing Address tab as 
appropriate.

7 Click the Save button.

Add any additional contracted resources using information listed on the 
EERAs.

The following diagram shows the Member/Operator tab on the Crews & 
Operators Add/Edit screen for adding an operator to a resource.
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Posting time for contracted resources
This section explains how to post time for contracted resources. The SF-297, 
“Emergency Equipment Shift Ticket,” lists the information you need to post 
contracted resources time in ITS. 

Remember these key points when posting time for contract equipment:

• Daily rate. You can post for one date or for a range of dates.
• Hourly rate. To ensure a guarantee is posted for equipment not currently 

being used on any given day but still under hire, enter a minimum of 15 
minutes of work time and 1 mile of mileage.

• Guarantee. If applicable, the guarantee amount is shown only on the OF-
286, but will not display on the Incident Post - Posting Equipment screen.

The following table outlines how to post units of measure for contracted 
resources in ITS.

The guarantee amount is shown only on the OF-286 but does not display on 
the Incident Post-Posting Equipment screen.

To post contracted resource time

Remember, you can click to select the Use Enter Key as Tab for Posting 
check box for faster, 10-key data entry!

1 Click the Post Time button, and then click the Contract Equipment, 
Crews and Other tab.

2 Under Select Type, select the equipment type of your choice.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Perform one of the following

- click the Equipment Unique ID drop-down arrow, and then click to 
select the Equipment of your choice

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice.

5 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

To post Do this
Daily rate Complete Start Date and End Date.
Hourly rate Complete Date and Start and Stop 

times.
Mileage Complete Date and Miles.
Each Complete Date and Each.
equipment not being used on any 
given day but still under hire

Enter a minimum of 15 minutes of 
work time and 1 Mile.
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6 Under Post Options, click to select the Rate Type of your choice.

7 If one-half rate applies, click to select the 1/2 Rate check box.

8 Post the required information as appropriate for that Rate Type and Unit 
of Measure.

Remember to review the previous table for posting rates and units of 
measure.

9 To commit the posting, click the Commit Posting button.

The following diagram shows the Incident Post screen for posting contract 
equipment time.

To repost a day of time by overwriting the existing entry

When reposting contracted resource time, you can either add to the original 
posting or overwrite the existing entry.

1 Click the Post Time button, and then click the Contract Equipment, 
Crews and Other tab.

2 Under Select Type, select the equipment type of your choice.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Perform one of the following

- click the Equipment Unique ID drop-down arrow, and then click to 
select the Equipment of your choice

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice.
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5 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

6 Under Post Options, click to select the Rate Type of your choice.

7 Complete the appropriate Start Date and End Date boxes.

8 To commit the posting, click the Commit Posting button.

9 On the Already Posted dialog box, click the Overwrite button.

The following diagram shows the Already Posted dialog box.

To delete a row of posted time
1 Click the cursor in the Acct column for the row of time you want to 

delete.

2 On the ITS toobar, click the Delete button.

To review an OF-286 for contracted resources

The OF-286 is an invoice for a contracted resource on an incident, and lists 
the rates and dates the contracted resource was used.

1 On the Reports menu, click OF-286 w/ Deductions.

2 On the OF-286 dialog box, perform one of the following

- click the Contractor drop-down arrow, and then click to select the 
Contractor Name of your choice

- click the Agreement drop-down arrow, and then click to select the 
Agreement of your choice.

- click the Equipment drop-down arrow, and then click to select the 
Equipment of your choice.

3 Under Report Options, click to select one of the following

- OF-286 with Itemized Deductions
- OF-286 Only
- Itemized Deductions Only.

4 To preview the report, click the Preview Report button.
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5 To print the report, click the Print Report button.

The following diagram shows a sample OF-286 for a contracted resource.

Working with commissary debits and additions
Working with commissary debits and additions is straightforward. Once you 
select a resource, enter the date, description, and amount. Then review the 
details of the transactions on the OF-288 and OF-286.

To preview a Commissary Authorization form

You can view and/or print a Commissary Authorization form by request 
number, crew name, or person.

1 On the Reports menu, click Commissary Authorization.

2 On the Commissary Authorization dialog box, perform one of the 
following

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice

- click the Crew Name drop-down arrow, and then click to select the 
Crew Name of your choice.
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- click the Person drop-down arrow, and then click to select the Person 
of your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

The following diagram shows the Commissary Authorization dialog box.

The following diagram shows a sample Emergency FireFighter Commissary 
Authorization as it appears on your screen.
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To post deductions to a personnel resource

 Remember to press TAB to advance the cursor to the next box. Information 
you enter is auto-saved as soon as you enter a new blank line. 

1 Click the Commissary/Debits & Additions button.

2 On the Personnel tab, click the Person drop-down arrow, and then click 
to select the Person of your choice.

3 In the Activity Date column, type the Date in the format MMDDYYYY.

4 In the Commodity column, type the name of the Commodity.

Commodities include items such as socks, boots, and toiletries.

5 In the Purchase Amount column, type the Purchase Amount for those 
commodities, in the format 99.99.

6 To save the charges and advance to the next new line, press TAB.

The following diagram shows a sample Personnel Debits screen.

To post contractor deductions to a resource
1 Click the Commissary/Debits & Additions button, and then click the 

Contractor tab.

2 Under Select Type, click to select one of the following

- Contract Equipment
- Contract Crews
- Other Contracts.
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3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Click the Contract Resource drop-down arrow, and then click to select 
the Contract Resource of your choice.

5 In the Activity Date column, type the Date in the format MMDDYYYY.

6 In the Commodity column, type the name of the Commodity.

7 In the Purchase Amount column, type the Purchase Amount for those 
commodities, in the format 99.99.

8 To save the charges and advance to the next new line, press TAB.

The following diagram shows the Contractor Debits screen.

To post a contractor addition
1 Click the Commissary/Debits & Additions button, and then click the 

Contractor tab.

2 On the Contractor tab under Select Type, click to select the Type of your 
choice.

3 Click to select the Contractor Name and Contract Resource of your 
choice.

4 In the Activity Date column, type the Date in the format MMDDYYYY.

5 In the Commodity column, type the Commodity.
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6 In the Purchase Amount column, type -Purchase Amount for those 
commodities.

Typing “-” (minus sign) in front of the Purchase Amount allows you to post 
an addition to the OF-286 report.

7 To save the charges and advance to the next new line, press TAB.

Notice that the negative symbol is replaced by parentheses in the 
purchase amount column.

To review an OF-288 for resources with posted deductions and 
additions

The deductions page displays on a separate window, behind the OF-288 and 
the OF-286.

1 On the Reports menu, click OF-288.

2 On the OF-288 dialog box, click to select one of the following

- Request Number
- Crew Name
- Person.

3 To view the final OF-288 for the crew leaving the incident, click to select 
the Final check box.

4 To preview the OF-288, click the Preview Report button.

5 To review the deductions page of the OF-288, click the Minimize button 
on the OF-288 window.

6 To print the OF-288, click the Print Report button.

The following diagram shows a sample Commissary Record as it appears on 
your screen.

To review an OF-286 for resources with posted deductions and 
additions
1 On the Reports menu, click OF-286 w/ Deductions.
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2 On the OF-286 dialog box, click the Contractor drop-down arrow, and 
then click to select the Contractor Name of your choice.

3 Click the Agreement drop-down arrow, and then click to select the 
Agreement of your choice.

4 Click the Equipment drop-down arrow, and then click to select the 
Equipment of your choice.

5 Under Report Options, click to select one of the following

- OF-286 with Itemized Deductions
- OF-286 Only
- Itemized Deductions Only.

6 To preview the OF-288, click the Preview Report button.

7 To review the deductions page of the OF-286, click the Minimize button 
on the OF-286 window.

8 To print the OF-286, click the Print Report button.

The following diagram shows a sample Emergency Equipment Deductions 
and Additions report as it appears on your screen.

Working with reports
This section explains how to prepare, view, and print reports available in ITS. 
The Reports menu lists management, equipment, commissary authorization, 
crew roster, and pay document reports.

To review and print a Commissary Authorization form

You can view and/or print a Commissary Authorization form by request 
number, crew name, or person.

1 On the Reports menu, click Commissary Authorization.
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2 On the Commissary Authorization dialog box, perform one of the 
following

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice

- click the Crew Name drop-down arrow, and then click to select the 
Crew Name of your choice.

- click the Person drop-down arrow, and then click to select the Person 
of your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

To view and print a crew roster

This report lists the names of individual crew members for a crew.

1 On the Reports menu, click Crew Roster.

2 On the Crew Roster dialog box, perform one of the following

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice

- click the Crew Name drop-down arrow, and then click to select the 
Crew Name/Equipment of your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

The following diagram shows the Crew Roster dialog box.
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The following diagram shows a sample Crew Roster as it appears on your 
screen.

To prepare a Shifts in Excess of Standard Hours report

This report lists shifts that exceed standards and allows you to identify initial 
attack shifts and other shift issues that need documentation.

1 On the Reports menu, click Shifts in Excess of Standard Hrs.

2 On the Shifts in Excess of Standard Hours Report dialog box, perform 
one or more of the following as appropriate

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice

- click the Person drop-down arrow, and then click to select the Person 
of your choice.

3 Click the Start Date drop-down arrow, and then click to select the Start 
Date of your choice.

4 Click the End Date drop-down arrow, and then click to select the End 
Date of your choice.

5 In the Excess Hours box, type the minimum total number of Excess 
Hours to be reported.

6 Under Sort by, click to select one of the following

- Request #
- Person
- Total.

7 Click the Run Report button.

8 To print the report, click the Print Report icon.
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The following diagram shows the Shifts in Excess of Standard Hours Report 
dialog box.

The following diagram shows a sample Shifts in Excess of Standard Hours 
report, as it appears on your screen.
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To view the Equipment Management Report
1 On the Reports menu, click Equipment Management.

2 To print the report, click the Print Report icon.

The following diagram shows a sample Equipment Management Report as it 
appears on your screen. 

To view the Contractor Debits Report
1 On the Reports menu, click Contractor Debits.

2 On the Contractor Debits dialog box, click the Contractor drop-down 
arrow, and then click to select the Contractor of your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.
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The following diagram shows a sample Contractor Debits report as it appears 
on your screen.

To view the Payment Summary of Equipment report
1 On the Reports menu, click Payment Summary of Equipment.

2 On the Payment Summary of Equipment Usage Report dialog box, 
click the drop-down arrow, and then click to select the Contractor of 
your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

The following diagram shows the Payment Summary of Equipment Usage 
Report dialog box.
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The following diagram shows a sample Payment Summary of Equipment 
report as it appears on your screen.

To view the Summarization of Hours Worked report
1 On the Reports menu, click Summary of Hours Worked.

2 On the Summarization of Hours Report dialog box, perform one of the 
following

- to obtain information for an individual, click the Select Person drop-
down arrow, and then click to select the Person of your choice.

- to obtain information for all personnel, click Select All Personnel.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

The following diagram shows the Summarization of Hours Report dialog box.
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The following diagram show a sample Summarization of Hours Worked on 
Incident report as it appears on your screen.

Performing searches for personnel or equipment
This section explains how to perform personnel and equipment searches and 
how to sort data elements by column heading.

Personnel and equipment searches are performed in the same manner. By 
performing a search, you can:

• query on one or more data elements
• find a resource and determine whether a name is connected to the wrong 

resource.

By using the sort feature in ITS, you can organize the data elements to suit 
your reporting needs.

To perform a personnel or equipment search
1 Click the Personnel Search button or the Equipment Search button.

2 Locate the column heading that identifies the data element for your 
search.
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3 To narrow your search, click in the blank cell above the column heading 
of your choice, type the first several characters of the target data element, 
and then press TAB.

The following diagram shows the Personnel Search screen.
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The following diagram shows the Equipment Search screen.

To sort data elements by column heading
1 Click the Personnel Search button or the Equipment Search button.

2 Locate the column heading that identifies the data element you want to 
sort, and then click that column heading title.

Putting it all together
This section explains some advanced topics you can perform in ITS, including 
how to:

• manage contractor and agreement data from IRSS input
• work with the appropriate Unit of Measure (UOM) and coordinating with 

cost
• handle complicated contracts
• work with auditing functions for personnel and crew time, equipment 

time, and commissary time
• close out pay documents
• manage multiple incidents.
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Managing contractor and agreement data from IRSS input
This section explains how to work with complex contracts for resources such 
as contract crews and engines, portable toilets, and resources with multiple 
rates based on duration.

Review contracts and shift tickets to add contractor data and to post time to 
contracted resources.

The following diagram outlines the basic process for working with contractor 
and agreement data.

To determine if the contractor already exists in the I-Suite 
database
1 Click the Contracts button.

2 On the Contracted Resource Add/Edit screen under Select Type, click 
to select the Contract Resource of your choice.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor of your choice.
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The following diagram shows the Contracted Resource Add/Edit screen. The 
arrow points to the list of existing contractors in the I-Suite database.

To add a new contractor

Refer to the contract to add new contractor data. For more information about 
adding a contractor, see the previous section, “Working with contractor and 
agreement data.”

1 Click the Contracts button.

2 On the Contracted Resource Add/Edit screen, click the Add tab.

3 Complete the following information as appropriate

- Name
- EIN/SSN
- Address
- City
- ST
- Zip
- Phone.

4 Click the Save button.

For an example of the Contracted Resource Add/Edit screen, see the 
previous section, “Working with contractor and agreement data.”
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To create an agreement and attach it to a contractor

Before creating the agreement, be sure the Contractor Name is displaying on 
the Contracted Resource Add./Edit screen.

1 On the Contracted Resource Add/Edit screen, click the Contractor 
Name drop-down arrow, and then click to select the Contractor Name of 
your choice.

2 Click the Agreement tab, and then click the Add tab.

3 Complete the following information

- Agreement Number
- Begin Date
- Expiration Date
- Point of Hire
- Administrative Office for Payment.

4 To attach the agreement to the contractor, click the Agreement Number 
drop-down arrow, and then click to select the Agreement Number of 
your choice.

5 Click the Save button.

For an example of the Contracted Resource Add/Edit screen, see the 
previous section, “Working with contractor and agreement data.”
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To add resources and rates and link them to the contractor and 
agreement
1 On the Contracted Resource Add/Edit screen under Select Resource 

By, click Name or Request Number.

2 Click the Unique Name or Request Number drop-down arrow, and then 
click to select the Name or Request Number of your choice.

3 Complete the Contractor Name and Agreement Number boxes for the 
Contractor/Agreement of your choice.

4 On the Resource tab on the Edit tab, complete the following information

- in the Unique ID box, create a unique name for the resource
- complete the Make, Model, and Remarks boxes, as appropriate
- click to select the Gov’t Operator and Gov’t Supplies check boxes, 

as appropriate
- complete the Hired Date and Time boxes and the Released Date and 

Time boxes, as appropriate
- click to select the Withdrawn check box, as appropriate
- click the Rate Type drop-down arrow, and then click to select the 

Rate Type of your choice
- click the UOM drop-down arrow, and then click to select the Unit of 

Measure of your choice.
- click in the Rate box, and then type the appropriate Rate for that 

Rate Type and Unit of Measure.
- press TAB twice to advance the cursor to the next Rate Type box.

Remember to add all primary rates, and use special rates for mileage.
Be sure to press TAB to advance the cursor to the next blank row!

5 Verify that the correct Request Number, Contractor Name, and 
Agreement Number display on the upper portion of the Contracted 
Resource Add/Edit screen.

6 Click the Save button.

7 On the Warning - Check for Agreement/Contractor dialog box, click 
Yes.
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The following diagram shows the Contracted Resource Add/Edit screen. The 
arrow points to the Primary and Special Rate Types. 

The following diagram shows the Warning - Check for Agreement/Contractor 
dialog box.

Understanding rate types and Units of Measure 
Remember these key points when working with rate types and Units of 
Measure (UOM):

• All contracted resources must have a primary rate designation.
• A contracted resource may or may not have one to five special rate 

designations.
• Units of Measure include Daily, Each, Hourly, and Mileage.
• Be sure to match the correct rate type with the correct UOM.
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Posting time for contracted resources
This section explains how to post time for contracted resources using the 
appropriate primary and secondary rates, and how to print the OF-286.

To post time for contracted resources
1 Click the Post Time button, and then click the Contract Equipment, 

Crews and Other tab.

2 Under Select Type, select the equipment type of your choice.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Perform one of the following

- Click the Equipment Unique ID drop-down arrow, and then click to 
select the Equipment of your choice.

- Click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice.

5 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

6 Under Post Options, click to select the Rate Type of your choice.

7 If one-half rate applies, click to select the 1/2 Rate check box.

8 Post the required information as appropriate for that Rate Type and Unit 
of Measure.

9 To commit the posting, click the Commit Posting button.

Once you have correctly posted the time for the resources, you can print 
the OF-286.

To print the OF-286

You can also print the OF-286 by clicking the Print OF-286 button on the 
Incident Post-Posting Equipment screen.

Once you create an original invoice, you cannot edit it.

1 On the Reports menu, click OF-286 w/ Deductions.

2 On the OF-286 dialog box under Select Type, click to select the 
equipment type of your choice.

3 Click the Contractor drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Click the Agreement drop-down arrow, and then click to select the 
Agreement of your choice.

5 Click the Equipment drop-down arrow, and then click to select the 
Equipment of your choice.
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6 Click the Last Date Included on Invoice drop-down arrow, and then 
click to select the Last Date for the partial payment.

7 Under Report Options, click to select one of the following

- OF-286 with Itemized Deductions
- OF-286 Only
- Itemized Deductions Only.

8 To preview and then print the report, click the Preview/Print Report 
button, and then click the Print Report icon.

Deleting a duplicate contractor
You may find that a contractor was entered in ITS twice. This duplicate 
resource may or may not have attached resources. 

You cannot delete a contractor with attached resources and/or an agreement.

The following diagram outlines the basic process for deleting a duplicate 
contractor.

To locate duplicate contractors
1 Click the Contracts button.

2 Click the Contractor Name drop-down arrow, and then locate the 
duplicate Contractor Names.
September 9, 2004 69



Incident Time System User’s Guide Incident Time System User’s Guide
The following diagram shows the Contracted Resource Add/Edit screen. The 
arrow points to two duplicate contractors.

To rename duplicate contractors
1 On the Contracted Resource Add/Edit screen, on the Contractor tab, 

click the Edit tab.

2 Click the Contractor Name drop-down arrow, and then click to select the 
first duplicate Contractor Name you want to rename.

3 In the Name box, edit the Contractor Name, and then click the Save 
button.

For example, insert the number “1” to the end of the first duplicate 
contractor name.

4 On the Edit tab, click the Contractor Name drop-down arrow, and then 
click to select the second duplicate Contractor Name.

5 In the Name box, edit the Contractor Name, and then click the Save 
button.

For example, insert the number “2” to the end of the second duplicate 
contractor name.

To determine if the duplicate contrator has attached resources
1 Click the Equipment Search button.
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2 To sort data by Contractor Name, click the Contractor Name column 
heading.

3 Scroll to the duplicate Contractor Name(s).

If the Contractor Name is listed on the Equipment Search screen, it has 
attached resources. If one of the duplicate contractors does not appear 
on the Equipment Search screen, then it does not have attached 
resources.

The following diagram shows an example of the Equipment Search screen. 
The arrow points to the contractor, “Quality Motors, Inc” 

Quality Motors and Quality Motors, Inc are duplicate contractors. Since both 
contractors show up on the Equipment Search screen, they both have 
attached resources.

To move attached resources from one contractor to another
1 Click the Contracts button.

2 On the Contracted Resource Add/Edit screen under Select Resource 
By, click Name or Request Number, and then click to select the Name or 
Request Number to be moved.

3 Click to select the target Contractor Name and Agreement Number for 
the resource to be moved, and then click the Save button.

4 Move all remaining resources to the target Contractor Name/
Agreement Number.
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The following diagram shows the Contracted Resource Add/Edit screen. The 
resource, “E-89” is currently attached to QUALITY MOTORS2.

The following diagram shows the same resource, “E-89” moved to 
QUALITY MOTORS1.
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To delete a duplicate contractor with no attached resources

You must first delete the agreement before you can delete the contractor.

1 Click the Contracts button.

2 Click the Agreement Number drop-down arrow, click to select the 
appropriate Agreement Number, and then click the Delete button.

3 Click the Contractor Name drop-down arrow, click to select the 
Contractor Name you want to delete, and then click the Delete button.

4 To verify that you deleted the duplicate contractor, click the Refresh 
button.

The following diagram shows the agreement to be deleted from QUALITY 
MOTORS2.
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The following diagram shows the agreement deleted from QUALITY 
MOTORS2.

Working with partial payments
This section explains how to post a partial payment for a firefighter or to a 
contractor. 

Be sure to notify cost personnel about the partial payment!

To post a partial payment for a firefighter

Contact the responsible hiring agency for processing procedures if you need 
to post a partial payment for an OF-288.

To post a partial payment to a contractor

After printing the Original invoice, you can send it to the payment center for 
payment.

1 On the Reports menu, click OF-286.

2 On the OF-286 dialog box, complete the Contractor, Agreement, and 
Equipment boxes.

3 Click the Last Date Included on Invoice drop-down arrow, and then 
click to select the Last Date for the partial payment.
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4 Under Print Options, click to select Preview/Print ORIGINAL 
Invoice, and then click the Preview/Print Invoice button.

Once you create an original invoice, you cannot edit it.

5 Click the Print Report icon, and then click the OK and Yes buttons on 
the IReports dialog boxes.

To delete a previous invoice for payment to a contractor

Do not recreate an invoice if one has already been sent to the payment 
center. Use this option only if the previous invoice has not been sent to the 
payment center.

If creating the final invoice, set the release date and time, so that the 
information will be carried over to the resource edit screen for equipment.

1 On the Reports menu, click OF-286.

2 On the OF-286 dialog box, complete the Contractor, Agreement, and 
Equipment boxes.

3 Click the Delete Last Invoice For Selected Resource button.

4 On the Warning dialog box, click Yes.

The following diagram shows the OF-286 dialog box.
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The following diagram shows the Warning dialog box.
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